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Introduction to Circulation

The intention of this workflow-based reference guide is to provide information about
the Circulation module in Virtua, demonstrating the functions and features in the
subsystem and providing instructions for performing tasks relating to circulation. As
you read through the guide, it will be helpful for you to keep in mind particular
needs, policies, and workflows as they will pertain to your library. Each library has
special requirements to best meet the needs of the library staff and patrons. Virtua
has been desighed to meet those needs in a concise, intuitive way.

As an Integrated Library System, you cannot speak of any part of the system
without referencing, in some way, all parts of the ILS. Circulation, by the nature of
its functions, will touch on various parts of librarianship as they come together to
provide patrons with the resources they require. Parts of this guide will seem like
an OPAC guide, when searching for patron records, or a Cataloguing guide, when
discussing the creation of Item records. It is in understanding these connections
that the strengths of the Virtua Circulation subsystem will be most clear.

There are certain parameters and settings that must be configured in the Virtua
Profiler when preparing to use circulation functions. You will need to setup Library
Locations, Patron Types, and Item Classes prior to performing circulation
transactions. Many of the settings needed for circulation will follow from these three
main areas. The remaining settings will allow you to adjust the parameters to
match the particular requirements of your library.
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Understanding Menu & Toolbar

The Circulation drop-down menu displays the following selections: Patron, Circ
Desk, Transactions, Reserves, Agency Requests, and Circ Backup.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools Window Help
N Patr » =, L T
6@ T CloE MBE N WAE sl B e
irc Des .
Default conned  Transactions p Fary -staff Current connection: Customer Support Library - staff
Reserves L4
Agency Reguests »
Circ Backup »

Circulation Menu & Toolbar

Menu Bar Icons Function Keys Function

Circulation

Patron

New £ F7 Add a new patron
Record Open a patron record
Activity F2 Access patron activity
Account Access patron account
Circ Desk

Check In & F4 Check in an item

Check Qut %, F5 Check out an item
Renew ) F6 Renew an item
Transactions

Requests Al View requested items
Loans/Pages @ View loans and pages
Audit Trail Access the Audit Trail
Transaction Log Access the Transaction Log
Circ on the fly Create a brief bib record
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Reserves & View items on reserve

Create Ctrl+H Open the Create Reserve List

View Access Reserves

Active Items View Active Reserve Items

Scheduled Items View Scheduled Reserve
Items

Reserves Due Search for Reserves that are
Due

Note: When used with the Alt key, underlined letters denote keyboard shortcuts
For example: Alt + ¢ + p + n adds a new patron.
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OPAC Menu & Toolbar

Menu Bar Icon | Function Keys | Function
Search Opens Search window

Search by State
Author

Search by record state
Author Search

Title Fo Title Search

Subject Subject Search

Call Number Call Number Search

Patron Name F8 Patron Name search (last name
first)

Keyword F12 Keyword Search

ISBN Shift+F2 ISBN Control Number search

ISSN ISSN Control Number Search

LCCN LC Control Number Search

Patron Barcode F2 Patron Barcode Number Search

Item Barcode F3 Item/Barcode number search

ISSN Serials F10 Opens Serial Check-in window

Serial Abbreviation

Instructor Reserve search by instructor name
Course ID Reserve search by course number
Options

Change Location
OPAC Display

Change Login Location

Displays or hides Blind References,
Authority Source, and Heading
Type and provides Authority
Browse Filter options

Note: When used with the Alt key, underlined letters denote keyboard shortcuts
For example: Alt + s + a performs an author search.
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Documentation and Help

Virtua Users Guides are available in searchable .pdf format from the Tools
menu; click on the Tools menu, then select Documentation Search Engine. The
Documentation Search Engine appears on your Tools menu by default and is
functional only if the Virtua documentation has been installed via the
Documentation Installer. For details on the Documentation Search Engine, see the
section Getting Help with Virtua: Viewing and Searching the Virtua Documentation
in the Virtua Client Getting Started Primer.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options  Tools  Window Help

@O (4% ©QF MBE Occcome B D B S
Default connection: Customer Support Library - staff Notepad

0n Screen Keyboard

WaordPad
Documentation Search Engine ‘

The Help Menu links to detailed information about MARC 21, CATMARC,
SWEMARC, and UNIMARC Format.

W Virtua - Headquarters - Customer Support Library E]@
File Search Circulation Acquisiions Cataloging Options Tools  Window | Help
OO £ 2 CCE MBE N || Mzt i
MARC21 Bib Help L
Default connection: Customer Support Library - staff MARC21 Haldings Help

MARCZ21 Community Info Help
Patron MARC Help

CATMARC Help
CATMARC Leader 06 Help
UMIMARC Bib Help
UMIMARC Auth Help

Permissions Help
About. ..
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Feature specific help is available; from the window for which additional
information about a feature is wanted, using the F1 key or right mouse click will
bring forward more information regarding that portion of the window.

: a ,,__,- " "‘ .‘.,—- -‘ - -. G [ NG A .‘-.‘ » "‘- P o
File Search Cradaton Acquisiions Cataloging Options Tools Window Help

| 20| @ ot © [Gmatathigy e |
|Default connection: Cy| File Edit Bookmark Options Help ‘ V|

HepIopics| Back | P | <« [ o |
Lets you search for transactions by tem barcode.

* To see ALL transactions associated with a specific tem, type the item barcode, but do
NOT type a patron barcode, transaction reference number, or receipt number.

* To see the transactions for a particular tem AND a specific patron, transaction reference
number, or receipt number, type item barcode here, AND type the patron barcode,
transaction reference number, or receipt number.

The Window Menu tracks the order in which open Virtua windows were accessed.

I |

g Virtua - Headquarters - Customer Support Library |; |§ E

File Search Circulation Acquisiions Cataloging Options  Tools 'I.'ﬁIhlI'|HEIp

|2t @-io||s 2 ecB MBE||N = e
Close All Messages
Default connection: Customer Support Library - staff BIENSSIIE Cascade Cataloging Windows v

Tile Cataloging Windows

1 Audit Trail - Customer Support Library
2 Patron Information - O'Connell, Hannah
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Item Records

Recommended
Workflow Explanation
An item record is a record that describes a physical or
Edit Item virtual piece in your library’s collection. The item can
Records consist of a single piece, such as a book, or multiple
Obrain Bib pieces in one or more physical formats, such as a multi-
Record CD set with an accompanying printed pamphlet. The
record contains identifying information that uniquely
v describes the item.
%iecztléem While all copies share identical bibliographic information,
other types of information are unique and differ from
v copy to copy. This information is vital for generating
. spine labels, processing requests, and for the proper
Edit Item .. . .
Information functioning of Circulation.
Add Item Summary i
Records e Open and edit an Item Record
e Add a new Item Record
Obtain Bib e Relate specific item information to its
Record corresponding tab
e Add Statuses to an Item
Y e Add Notes to an Item
Add Ttem
Record Key Terms
! e Barcode Label
Add Teem e Barcode Number
Information ¢ Bibliographic Record
e Circulation Notes
e [tem
e Item Record
e Main Location
e Shelving Location
e Statistics
e Status
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Circulation Parameters

Profiler Parameters that affect item records

Some parameters such as Library names affect
selection options in dropdown menus. Others affect
how the circulation system allows item records to be
deleted.

Global Settings Parameters

Location Names: setup virtual locations (main
locations and sub-locations) to represent the physical
location of materials, usually circulation points, e.g.
Main library, Reserve room, Special Collections, etc.;
sets default values for the first item record associated
with a bibliographic or holdings record, e.g. default
item class, use Circulation Matrix, copy number
value.

Status Displays: setup special statuses for
bibliographic, holdings, or item records, e.g. missing,
damaged, lost, etc.

Circulation: System Parameters

Item Class Definition: Set up item class codes,
descriptions of item classes, and class types (regular
or reserve).

Circulation: Circulation Basic Options Parameters

Long Loan Flag: if set to ON a recallable by date will
be generated and displayed on the item tab.

Delete/Waive Flags
Waive Fees Flag: if OFF prevents deletion of any
item/patron record with associated fees.

Delete Outstanding Requests Flag: if OFF system
prevents deletion of any item/patron records with
associated outstanding requests.

Delete Special Status: if OFF system prevents
deletion of any item/patron with a linked special
status.

Circulation Operational Security Permissions
Item Acquisitions Tab: Determines whether the
Acquisitions tab appears on the Item Information
window in Edit mode
Allow an item barcode to be modified:
Determines whether the user can change an existing
item barcode.
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Allow an item owning location to be modified:
Determines whether the user can modify the owning
location of item records.

Allow item status to be edited at any location:
Lets staff modify the item status for items belonging
to any location; useful for designating items as “In
Transit”

Circulation InfoStation Reports

Items by Status: generates a list of items by status
and location within a given barcode range.

Shelving Pull List report: generates a list of items
that need to be returned from their current shelving
location to their owning location.

Circulation Workflow-Based Reference Guide
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Opening and Editing an Item Record

Obtain a Bibliographic Record

Search the OPAC by clicking the icon or by clicking on Search and choosing
a search type to verify that a bibliographic record exists.

il %
W Search - Customer Support Library u

Browse | Headingl I{e'_.rwnrdl Control Numherl Holdings Ke'_.rwurdl F'atrnnl
IAuthnr j || j

To begin a browse search of the library catalog, "

1. Choose the type of search by clicking the arrow in the first box. b

2. Then click in the empty box.

3. Type a whaole or partial last name, subject, title, call number or
other entry appropriate to the type of search yvou are doing.

4. Click the Search button or press the ENTER key on your keyboard.

m

LIBRARY NOTICE
Put wour customized library mes=sage here and on every other fab -
Collection Groups Location Search Cancel

W Virtua - Bellefonte - phoenix o | [ ﬁ

File | Search Circulation Acquisiions Options Tools Window Help

“? Search by State 0 & @ | ﬁ'ﬂ %

— | Author r

DefE: Title Fg Current connection: phoenix - staff i
Subject
Call Mumber
Patron Mame Fa
Keyword Fix
ISEM Shift+F2
125N
LCCN
Patron Barcode
Item Barcode F3
I55M Serials F10
Serial Abbreviation
Instructor
Course ID

Circulation Workflow-Based Reference Guide Last Revised: October 2017

*Updated to 16.1



14

If an exact match for your search term is found, the search term will be
highlighted or in the case that it is the only matching record in the OPAC the
View Bibliographic Record window will open.

If an exact match for your search tern is not found the term before where your
search term would be is highlighted.

-

W Browse - phoenix g -\

Title: much ado about nothing

Hits | Terms |

Much ade about nothing, i
Much ado about nathing [ William Shakespeare ; edited by David Bevington ; David

Scott Kastan, James Hammersmith, and Robert Kean Turner, assodate editors ; with

a foreword by Joseph Papp.

Much ado about nothing

Much ado about nothing / by Wiliam Shakespeare ; edited by Barbara A. Mowat and

Paul Werstine,

Much ado about nathing [electranic resource].

Much ado about nothing / edited by Floma Gill.

Much ado about nathing / William Shakespeare,

Much ado about nathing [OVD videorecording] f Samuel Goldwyn Company, a
Renaissance Films production ; adapated for the screen by Kenneth Branagh ;

produced by Stephen Evans, David Parfitt, and Kenneth Branagh ; directed by

Kenneth Branagh.

Much ado about nathing for kids [ by Lois Burdett.

Much ado about nathing [electranic resource] : notes, induding life of Shakespeare,
introduction to the play, brief synopsis of the play, list of characters, summariez and
commentaries. character sketches. suooested essav auestions, selected biblioaraohv .v.l

-

—

]

[EPEA

-

Title: much ado about nothing ‘

View | Page Up | Page Down Skip Delete ‘

Search terms with multiple hits retrieve an interim List of Titles window. To
view a record from the list, click on the item or select the item by clicking on the
View button. The View Bibliographic Record window will appear.
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Open an Existing Item Record

Select the Items tab from the View Bibliographic Record window. A list of all
items associated with the bibliographic record will appear.

% View Biblicgraphic Record - MoiErnie18 - O *

l

Description: 128 p. :ill. (chiefly col.), col. maps ; 24 cm. Status Counts
Title: Wind / Checked Qut: 0 On Reserve: 0
Imprint: Detroit [Mich.] : Greenhaven Press, c2007. Available: 1 Requested: 0
Series: Fueling the future On Hold: 0 Cther: 0
Publisher: Detroit [Mich.] : Total Ttems: 1 Unsatisfied Requests: 0
Total Circ: 3 Total Reguests: 0
Location | Item Class Barcode Call Number Units | Copy | Status LRL
BRYAM STACKS ITEM CLASS 0000:... 1000205093 T3820.W498 2007 1 Available
C'l":fr?nt Selection: Location: lm Show Group | ‘ View Item | Delete Item ‘ Request Item ‘
™ Masked Agency Req ‘ ‘ Edit ‘ Request Bib | Add Item | Refresh | Close |

The View Bibliographic Record’s Items tab contains the following information:

Label

Description

List of Items

Physical and/or virtual items attached to bibliographic record
(or with the holdings record linked to the bibliographic
record)

Item Level If the item record has a URL an icon displays to the left of
URL the call number.

Location Where items are located

Call Shelving location number

number(s)

Units Number of discrete pieces associated with the item

Copy Specific copy number

Barcode Barcode number of the item

Status Items available, on reserve, booked, or which have

Status Counts
Requested
Masked

Circulation Workflow-Based Reference Guide
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outstanding requests
Tallies or counts of items with specific statuses
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You can filter the list of items shown on the Items tab by location. To do this, select
a location from the Location drop-down list. The drop-down list also contains an
"ALL" option, which allows you to return to viewing all items associated with the
bibliographic record.

Item Information

The Item Information window gives details about a particular physical piece in a
library collection. While all copies of one title may have identical bibliographic
information, other types of information are unique and differ from copy to copy.

From the View Bibliographic Record window, select an item and click on the
View Item button or double click on the highlighted item. The Item
Information window will appear.

.
W Item Information - pho099 g
| statistics | other Elements
Information
Suthor: Shakespeare, Wiliam, 15641616,
Title: Much ado about nothing & Wiliarm Shakespears ; edited by Dawvid Bevington ; David ...
Publisher: Tororto ; Mew York ; Bantam Boolks, 19585,
tem Informatian Call Mumber
ftem 10 122510 Copy:
Barcode: | Call #: |
Barcode Type: | J 2nd Call #: |
tem Class: | J
Units
Rezerves tem Clazs: | -
ttem URL: | o
-
Location: | J ’7
Shelving Location: | J
-
Code:
Mumber of Pieces: = ™ | J
Price: I~
Location:
EPM Mumber: | meatan | J
AccEssion Mumber: |
Circulation Rules
A4 Accession Mumber: | =
| - 7 =
Collection Code:
v
™ Masked Delete | Edit | Refresh ‘ Close ‘
Circulation Workflow-Based Reference Guide Last Revised: October 2017
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The Item Information window contains the following Tabs
and Buttons:

Tab Description

Item Bibliographic, item, and call number information,

Elements preservation and conservation codes, non-
parameterized shelf location, and circulation rules

Notes Public and staff notes and check-in and check-out
alerts

Statistics Information grouped by bibliographic information,
record information, and circulation statistics

Status Special or system-defined circulation statuses

Button Description

Delete Deletes the item record

Edit/Save Displays as Save when in Edit mode to save changes

Refresh Refreshes the item record display

Close Closes the item record

To change item information, click the Edit button. Elements of the tabs will
become active and the Edit button will change to a Save button.

Edit areas as needed. Click the Save button to save the changes.

Circulation Workflow-Based Reference Guide
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Add Item Notes
To add an item level note, click on the Notes tab. If there is not a Notes tab,
click the Edit button, a Notes tab will appear.

W Item Information - phoenix E]
Item Elements Motes lStah'sh'cs ] Status ] Acquisitions ]
Bibliographic Information
Title: William Shakespeare's Much ado about nothing / edited and with an introduction by ...
Publisher: MNew York : Chelsea House Publishers, 1988,
Description: vii, 144 p. ; 25 am.
Motes
Public Notes: Staff Notes:
Checkout Alert: Checkin Alert:
[~ Masked Delete ‘ Save | | Close |

Public Note: a note that appears in the OPAC.

Staff Note: a note that can only be viewed from this window.

Checkout Alert: a note that pops up an alert during checkout/renewal of item.
Check-in Alert: a note that pops up an alert during the check-in process.

Select the Notes tab. Add, modify, or delete text in the Public Notes, Staff
Notes, Checkout Alert, and Check-in Alert fields as you would in any text

box.

Click the Save button to save your changes.

View Item Statistics
Click on the Statistics tab to view circulation statistics for the item.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
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¥ Item Information - phoenix E]
Item Elements ] MNotes Status ] Acqguisitions ]
Bibliographic Informati
Title: William Shakespeare's Much ado about nothing / edited and with an introduction by ...
Publisher: MNew York : Chelsea House Publishers, 1988,
Description: vii, 144 p. ; 25 cm.
Record Information
Item ID: 54480 Last Modified: 12152004
Barcode Date: 7f14/2004 by Operator ID: 9
Date Created: 6/26/2004
Circulation Statistics
Circ Count: 35 In House Circ Count: 4]
Temp Circ Count: 2 Temp In House Circ Count: o]
Since: 6/26/2004 Since: 6262004
Reserve Count: [u] Last Inventory Date:
Temp Reserve Count: i] Last Circulation Date: 1/42011
Since: 6262004
™ Masked Delete | Save | | Cloze |

On the Statistics tab, the statistical data elements are organized into three
sections:

¢ Bibliographic Information
e Record Information
Circulation Statistics

The data elements that appear in the Bibliographic Information section of the Item
Information window are configurable in the Profiler > OPAC - Client Views >
Item Information parameter. Only the first three elements configured will display
in the Bibliographic Information section. All other elements configured in this view
are displayed on the Item tab of the View Bibliographic Record.

Add Item Status

From any tab of the Item Information window click the Edit button. The Item
Information converts to edit mode, a Save button replaces the Edit button and
the status and notes tabs appear. The Status tab will display before the edit
button is clicked if any statuses are already associated with the item.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
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r 5
W Item Information - phoenix E]
Item Elements | Notes | Statisti
Bibliographic Information
Title: William Shakespeare's Much ado about nothing / edited and with an introduction by ...
Publisher: Mew York @ Chelsea House Publishers, 1988,
Description: vii, 144 p. ; 25 an.
Statuses
Status | Date Added [ Checked out | Location / Due Date | To Location | Repor...
In Transit [1f8f2011 |Bellefonte |Headguarters o
Add Modify Delete
[~ Masked Delete | Save | Close

Select the Status tab.

Select the Add button. A dialog box appears for adding statuses. Select a status
and location.

"W Add New Status x|
Status: [l |
Location: [Bellefonte ]

o | conca |

Click the OK button to add the status.
Click the Save button to save these changes.

The Statuses in the Add New Status drop down menu are configured in the
Profiler --> Global Settings > System - Status Displays the library is able
to create their own unique statuses to meet the needs of their library. Virtua
comes with several system assigned statuses, it is recommended that these
status not be deleted. Once a status is in use it can only be deleted if no items
have that status assigned to them.
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Add a New Item Record

From the View Bibliographic Record window click the Add Item button. The
Item Information window will appear.

pu

W Item Information - phoenix

BE %]

Bibliographic Information

Author: Hemingway, Ernest, 1899-1961.

Title: A farewell to arms { Ernest Hemingway.
Edition: 1st Scribner Paperback Fiction ed.

Ttem Information

Item ID: 337809

Barcode: |31781011073929

Barcode Type: |Regu|ar ﬂ
Item Class: ||3'30k ﬂ

Reserves Item Class: |

Ttem URL: |
Location: |Headquarters
Shelving Location: |Headquarters

Mumber of Pieces: 1 ¥| Circulate Pieces: r

Price: $13.00

EPM Mumber: |

Accession Mumber: |

Item Elements ]Notes ] Statistics ] Status ] Acquisitions | Other Elements

Call Number

Copy:

call 2: [F HEMINGWAY

and call = |

Units

" Free Text
~

(¢ Mone

[

[ Preservation and Conservation

Code: | J

[~ Mon-Parameterized Shelf Location

Location: | J

Circulation Rules

[~ Masked

AV Accession Number: | ¥ Use Matrix
™ Use Loan Period: i T
Collection Code: | j
Allow Request: v
Delete | Save | | Close ‘

Enter the item information appropriate to your library’s specifications.

Click the Save button to save the item to the database.
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Lost/Damaged Item Logic
Virtua Circulation Control uses the Receipt Date instead of the

Acquisition Date
to calculate the Total Replacement Cost. If the Receipt Date is not available,

Virtua will use the Acquisition Date. The Receipt Date can be specified on the
Acquisitions tab of the Item Information window in the client. If your library
does not use this workflow, the Acquisitions tab can be hidden from display for

any user using the Profiler > System > User Profiles >Permissions >

Operational Security > Item Information permission flag.

[3 = = :
W ttem Information - Virtua Library NN oo
Ttem Elements | Notes | Statistics | Status Acauisitions | Other Elements |
Biblingraphic Information
Authaor: Fussell, Edwin 5.
Title: Lucifer in harness ; American meter, metaphor, and diction / Edwin Fussell,
Description: xv, 182 p. ; 25cm.
Acquisitions Information
Purchase Order Id: || PO Line Mumber:
Receipt Date: [ UseDate: [10/15/2014 Invoice Unit Price:
Invoice Mumber: | Invoice Unit Discount:
Invaice Currency: | J Invaice Unit Fee:
——}'I.l'endnr:
Original Purchase Price: [ | | -
Circulation Workflow-Based Reference Guide Last Revised: October 2017
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When more than one item is attached to a bibliographic record, the Create Group
option is available in the right-click menu of the View Bibliographic Record

window.
Item Bookings -
~ y "
$ View Bibliographic Record - Virtua Databasi " =% ’, o
<) 2]as
Ful  {Tiems i marc |
|
Title: The book of spies : an anthology g Hold Ttem(s) for Relnk b
Imprrt: Nesw York : Moder Library, 2003, f e :
Description: ¥, 374p. ; 21 om. b Ot Z 0
Create Holdngs Record L tishied Re 0
- U ISO i w .
Create Holdngs from Workform Total Re rs: 0
Location | Cal Number Create Analytic Record l Status
BRENHAM READING ROOM 5.5. 86440 Create Authority Record(s)... Avsilable
BRYAN STACKS S.S. B64% Available
4 »
Current Selection: 7_P Create Group :
1/2 Show Group Stack Save Copy to Database Delete Item ] Request Item J
[ Masked Create Child Record J Refresh l e 1 !

Selecting this option opens the Create Group window, which displays the items

attached to the bibliographic record.

W Create Group - Virtua Database

BEx]

Title: The book of spies : an anthology of literary espionage /... Status Counts
Imprint: Mew York : Modern Library, 2003, Che#d o b Lrimsne E
Descrintion: s7ap.: 91 Available: 2 Reguested: i}
escription: i, p. ; 21cm. On Hold: ] Other: 0
Total Items: 2 Unsatisfied Requests: 0
Total Reguests: i}
Location Call Mumber Units | e | Barcode Status
D ERENHAM READING ROOM 5.5, B644o 1 1000181672 Available
D BRYAM STACKS 5.5, Bedo 2 1000181673 Available
4 3
View Item | Set as Primary ‘ Save | Cancel

On the Create Group window, select the item that you want to be the “primary”
item, and then click the Set as Primary button. This action puts a check in the
check box next to the item. The primary item is used to determine the circulation
rules for the grouped items. Next, while holding down the Control keyboard button
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select/highlight the other items that you want to include in the group, and click the
Save button.

From the View Bibliographic Record window, to see the group you created, click
the Show Group button.

To show ALL of the items within any group attached to a bibliographic record, de-

select all items on the View Bibliographic Record window, and then click the All
Groups button. From the Show All Groups window you can choose to remove a

non-primary item from a group, or you can break up an entire group by removing

the primary item from the group.

Checking Out a Group of Items

On the Check Out/Renew window, when a barcode for an item belonging to a
group is scanned for a checkout, Virtua displays the following message.

¥ 1
W Messages - venus88 g@
This item is part of a group. Do you wish to chedk-out the secondary
itemns as well?

Show Group Mo

If you click Yes, the Group Check Out/Renew window appears displaying the
primary item of the group in the list box. This window collects barcodes to send to
the server for checking out all of the items in a group and to confirm that all of the
items are present. The standard Check Out/Renew window remains open, but
cannot be accessed until the Group Check Out/Renew window is closed.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
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W Group Checkout/Renew E]@
Patron Check-outs | patron Limits ]
Patron 38888 1687414506 -~ Information
barcode: ml '
MName: Grace Killion == st
Patron type:  Adult Patron Requested: 0
Home library:  Hong Kong Central {*1000000) -- code; 1000000 i Overdue; 0
Registered at: Hong Kong Central (*1000000) - 1000000 Billed: 0
:grgfg:g 11 Rice Terrace Last Item: Adult Lending Books
Primary 2039331291 w| | CategoryLimit:  0f0
Chedk-out Type
{+ Reqular (" Fixed Time
(" In-house " Selected Time: — Date:
Item Barcode Item Class Title | Due Date,Time | Type

38888163740797  AdultLendi... The complete short stories of Emn...

<] (2]

[~ Print Receipts Item Barcode: |3888 1637407387
i {s

[~ Remember Last Check-out Type

Cancel | Show Group | Check Qut |

On the Group Check Out/Renew window, enter the barcode of another item in
the group.

On the Group Check Out/Renew window, you can...

¢ Click the Show Group button to see the Show Group window, containing
the details about member items of the group.

e Click the Check Out button to send the items listed to the server for
simultaneous checkout.

When you have checked out all of the items in the group, you can close the Group
Check Out/Renew window, and Virtua will put the Check Out/Renew window
back in focus.

When a patron checks out a group of items, the group of items counts as only ONE
item (the primary item) against a patron's checkout limits, but each item in the
group is counted when Virtua calculates alerts and blocks.

Library staff members have the ability to check out the primary item to patrons,
without checking out the entire group, but a patron is unable to check out
secondary items without checking out the entire group.
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Once the items in a group are checked out, they must all be renewed at once. If a
patron returns some of the items in a checked-out group, the rest of the items
cannot be renewed.

Lost/Damaged Workflow for Grouped Items

When a patron has a group of items checked out, and the primary item is set to
Lost, Virtua will assign the Lost Processing status to the primary item and the
Lost & Paid status to the secondary items.

BEX

W/ View Bibliographic Record - venus88

<[

10000000001233 |12/2/2011 11:19:33 AM
10000000008737 |12/2/2011 11:19:33 AM

Summary  Checked Out

Change Due Date |

Damaged

1/1/2012 11:13:00 AM
1/1/2012 11:19:00 AM

Bill

Extract To File

Ful  Ttems |marc |
Author: Patterson, James, 1947- Status Counts
Title: Middle school, the worst years of my life / James Patters... ChEFkEd iz Z Cu =S b
— S—— Available: [1} Requested: 1]
on: = &a On Hold: 0 Other: 0
Publication: Mew York : Little, Brown, 2011,
Description: 281p. il ; 20 cm. Total Items: 2 Unsatisfied Requests: 0
Total Requests: i]
Location | Call Number | Units | C..e | Item Id | Barcode | Status | Collection Code |
Hong Kong Central (*1... [Fic] 1 8285 10000000008787  Due: 1/1/2012 7:0...
Hong Kong Central (*1... [Fic] 1 3284 10000000001238  Due: 1172012 7:0...
Current Selection: X
12 Show Group | | View Item | Delete Ttem Request Item |
[~ Masked Agency Req View Archive Edit | Request Bib | Add Item | i Refresh Cloze |
W/ Patron Information - Grace Killion g@
Card Format ] MARC Format  Activity ]Account]
Total Items: 3
Barcode | Check Out Date | Due Date | Title | Checkout Location
2010082311 11/18/2011 11:06:52 AM 12/18/2011 11:06:00 AM Enchanted glass [ Diana Wynne Jones. Hong Kong Central (*1000000)

... [Hong Kong Central (*1000000)
... |Hong Kong Central (*1000000)

Middle school, the worst years of my life / James
Middle school, the worst years of my life / James

Check In | Renew | Dispute | Info |

I Print Receipt

Update | Renew All | Refresh | Close |
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¥ View Bibliographic Record - venus88 - |0 m
<[ =]
Full MaRC |
Author: Patterson, James, 1947- tatus Counts
Title: Middle school, the worst years of my life / James Patters... Che.d@d zuE CuEETE e
— F—— Available: Requested: i}
on: = 8a On Hold: Other: 2
Publication: New York : Little, Brown, 2011,
Description: 281p. ¢l ; 20 am. Total Items: Unsatisfied Requests: 0
Total Requests: 1]
Location | Call Mumber | Units | C... | Item Id I Barcode | Status | Collection Code I
Hong Kong Central {(*1... [Fic] 1 8285 10000000008787  Lost Processing
Hong Kong Central {(*1... [Fic] 1 3284 10000000001238  Lost & Paid
Current Selection: §
12 Show Group | Yiew LIRL | View Item | Delete Item | Request Item |
[~ Masked Agency Reg View Archive Edit | Request Bib | Add Item | Refresh | Close |
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Patron Record

Recommended
Workflow

Explanation

Create Patron
Record

h 4

Save Patron
Record

Edit Patron
Record

A 4

Retrieve Patron
Record

A 4

Output Patron
Record

Virtua uses a 2709 MARC-like format to store patron
records.

Summary

Enter a Patron record in Virtua using the Patron
Editor

Save the Patron record to the database

Identify elements of the Patron Information window

Locate information on various tabs of the Patron
Information window

Print, Save and Email information

Key Terms
Patron Type

Profiler Circulation Parameters

Circulation: Patron Types this parameter allows
the library to define patron types and assign a patron
code that is automatically entered in the 030 \a sub-
field of the patron record when the patron type is
selected from the pull-down menu. The parameter
allows the library to set different circulation rules for
different patron types.

Circulation : Location + Patron Matrix

Expiration Date: sets the length of time the patron’s
record remains active.

Deletion Date: sets the time and date at which a
patron record qualifies to be deleted from the system.

Circulation Workflow-Based Reference Guide Last Revised: October 2017

*Updated to 16.1

28



Circulation Parameters

Circulation InfoStation Reports
Patron List: generates a list of patrons

E-Mail Validation: generates a list of patron
records, by patron type and address preference, that
contain at least one invalid e-mail address

Patron Record Load and Extract: allows a user to
read patron records from a delimited or fixed length
format input file and upload them to the Virtua
database. Users may also download Patron MARC
records that have changed in a given period and
output them to a delimited or fixed length format file.
This report is an Administrative Group report.

Blocked Patrons: Generates a list of patrons that
have a manual block in either the 043 tag or the 007
fixed fields of their patron record and meet the
patron information criteria that you set for the report
configuration.

Expiring Patrons: Generates a list of patrons who
meet the specified patron information criteria and
whose patron records are due to expire within the
amount of time specified for the report configuration.

Patron Statistics: Generates counts and calculations
for all transactions possible in the circulation
transaction log for selected patron types from a date
range specified. These transactions include requests,
check-ins, check-outs, and notices.
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Use Patron Editor

The Patron Editor is a configurable workform in Virtua, which allows for easy
creation/modification/deletion of patron records.

To use the Patron Editor in Virtua, instead of the Patron Marc Editor, on the
Virtua menu click Options > Cataloging Options. The Cataloging Options
dialog box appears. Click on the Other Options tab. Select the check box
labeled Use Patron Editor. Click the OK button.

rw Cataloging Options - phoenix -\

Editor Keystroke Mappings ] Label Printing  Other Options l L

Validation Options
[v Validate when Saving to File
[w Validate when Saving to Database
[v Use Spedific Bibliographic Fule Files

Iv Show Delete Warnings [ Mask Mew Records
[v Edit 006, 007, 008 in Editor | Use Multiple Editors

| Owverwrite Variable Fields v E_Ise Patron Edib:urE

[v Print request slip for new

trapped items Analytic Record Contral
Bibliographic MARC Format Mumber Source Tag
[MARC 21 ~| |~ oo1 035
Holdings Spine Label Subfields  Email Reply To Address
i |
Default Library Symbaol Email From Address:

QK Cancel

See Appendix D for Hong Kong Public Library Patron Editor and Card Format.
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Create Patron Record

Select Circulation > Patron - New from the menu bar, or click on the ‘ icon on
the Circulation toolbar, or hit F7 to open the Patron Editor.

The Patron Editor window allows you to create and edit patron records without
using the MARC Editor, and without any specific knowledge of the 2709 patron
record format.

The Patron Editor window has the following tabs: Name, Main Address,
Secondary Address, Email/Phone, Birthdate, Card Number/Password,
Notes, Blocks, Passport, Academic Info, and Corporate Name.

Click on a tab to add or edit patron record data.

W Patron Editor - Customer Support Library E]
Mame: Cell Phone:
Address: Email:
City: Patron Type:
State: Birthdate:
Zip: Barcode:
Primary Phone: Password:

Alternate Phone:

l Main Address ] Secondary Address ] EmiailPhone ] Birthdate ] Card Mumber Password ] MNotes ] Blc4| ¥

Title: First Name: Middle Name: Last Name: Suffix:
| =l | | | =

Patron Type: Languaae Preference:
ﬂ | ﬂ v Valid name

[ Display name

[ In-Care-Of
Library Info
Reagistering Library:

Home Library:
|Lamnni-Bou:uk Collzction ﬂ

[~ Company

‘ Mext ‘ | Close |

Required fields will appear in red in the Patron Editor. As you fill in the fields, the
information will appear in the Patron Editor Header. Required data elements
must be completed for the patron record to be saved successfully. When all of the
required information has been entered, the submit button will become active and
the patron record can be saved to the database. The Virtua-required fields are
Name, Street Address, Patron Type, and Barcode.
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Note: If you do not enter a name on the Name tab, you can enter a corporate
name on the Corporate Name tab to save the patron record.

Other required fields are configured in the Patron Cataloging Options window in
the Virtua Profiler Required Fields section.

Profiler Tip: The Patron Cataloging Options parameter contains options that let
you customize various aspects of the Patron Editor window in the Virtua client.
See Configuring Patron Cataloging Options in the Virtua Profiler/Cataloging
Parameters User’s Guide for more information.

Many elements of the Patron Editor can be hidden from view by modifying the
Profiler > Global Settings > System > User Profiles > Group or User >
Permissions - Cataloging > Patron Editor.

Library Configurable Required Fields

Library specific required fields are configured in the Profiler > Cataloging >
Patron Cataloging Options.

Primary Phone: This parameter requires a phone number be entered in the
Primary Phone field before a patron’s record can be saved.

Password: This parameter requires a password to be entered in the password field
before a patron’s record can be saved.

Valid Birth Date: This parameter requires a valid date of birth to be entered into a
patron’s record before it will be validated by Virtua.

Verified ID: Enabling this parameter will require an ID to be verified each time a
Patron Record is modified by library staff. This parameter is disabled unless a
library enables it in the Profiler. The Verify ID check box is located in the Card
Number/PIN/Blocks tab. Selection of the check box enables the Enter New Barcode
and Enter New PIN fields. When saving a new Patron record the Verified ID check
box must be checked.
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Patron Communication Preference Validation

There are the four communication options on the Communication Preference
field drop-down list on the Email/Phone tab: Paper, Email, Text, and Text & Email.
When the Communication Preference field has Text, Text and Email or Email as
the preferred form of communication Virtua will not save a patron record without
the appropriate Cell Phone or Email fields populated. If an attempt is made to save
the patron record without the appropriate information an error message displays:
The communication preference selected requires a cell phone number (or email
address), please correct. The patron record cannot be saved if the appropriate
communication preference fields are not populated.

r’ﬁ" Patron Editor - Customer Support Library f;] |
Name: Hannah O'Connel Cell Phone:
Address: 1701 Kraft Drive Emai oconneltviis.com
City: Biacksburg Fatron Type: VA
State: VA Birthdate 20100222
Zip: 24060 Barcode: viis214
Primary Fhone: E408571201 Fassword i
Aternate Phone:

___________

[s40s571201 [Text - e

Agerna
| Error

Cel Phy
I_ @ The communication preference selected requires a cell phone number, please comrect.

Delete Mext Subemit Close
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Patron Phone Contact Option
(only for phone contact with TALKINGtech's i-tiva phone messaging service)

The Opt In For Phone Contact check box on the Email/Phone tab of the Patron
Editor determines whether the patron will be contacted via telephone for library
notifications. When this check box is selected, the patron record will qualify for
phone contact via the i-tiva phone messaging service.

W Patron Editor - Customer Support Library g
Name: Hannah C'Connel Cedl Fhone:
Address: 1701 Kraft Dive Emadl: oconnelitifhviis com
City: Blacksburg Patron Type: VA
State: WA Birthdate: 20100222
Zip: 24060 Barcode: wis214
Primary Phone; B405571201 Password: i

Aternate Phone:

Name ] Main Address | Secondary Address ‘ﬂirthdate] Card Number/Password ] Metes l | r

Primary Phone: Communication Preference:
|54c-55r1 201 |E-mai| j [~ Opt In For Phone Contact
Alternate Phone: Prosy Nofification:

|F{&5|}cnsible person n{:-tiﬁj
Cel Phane:

Primary E-mail Address:
|ODGHH&|H@‘."U5.DG[T‘|

Secondary E-mail Address:

Delete | Mext | Submit | Close ‘

Note: TALKINGtech’s i-tiva phone messaging service is a third-party product that
works with InfoStation to alert users about overdue library items, the availability of
requested items, recalled items, etc.
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Patron History Flags

W Patron Editor - Customer Support Library

=)

Mame:
Address:

City:

State:

Zip:

Primary Phone:

Alternate Phone:

v Verified ID
Primary Barcode:

Hannah C'Connell
1701 Kraft Drive
Blacksburg

VA

5571200

Expiration Date:

9f 9/2016 -

|vis214

Primary Password:

Record Permission:

Cell Phone:
Email:
Patron Type:
Birthdate:
Barcode:

Password:

|>=>=>=>=

Alternate Barcode:

|Read by anaother library

[

[~ Monibrary use acceptable

[ Recall protection
[~ Keep checkout history

Alternate Password:

[ Allow duplicate checkouts

oconnellt@vils. com
AA

2/14/1992

viis214

Mame ] Main Address ] Secondary Address ] Email ;Phone ] Birthdate Card Mumber/Password ]Ngtes ] Blc 4] *

Delete

Mext |

Submit ‘ Close
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Select the Keep checkout history check box if you want Virtua to store the check-

out history for this patron. This field corresponds to the 008 tag position 15 of the

2709 patron record format. Check-out history can be displayed on the History page

of the Patron Information window if the user’s permission settings call for the

History page to be displayed.

The Allow duplicate checkouts check box affects both Chamo and Virtua; but in
Virtua, the setting controls two aspects: patron history and duplicate check-outs.

This field corresponds to the 008 tag position 16 of the 2709 patron record format.

When this setting is checked (default setting):

Virtua will not maintain patron checkout history.

Virtua will allow multiple check-outs of the same item to the patron.

Circulation Workflow-Based Reference Guide

*Updated to 16.1

Last Revised: October 2017



36

When this setting is de-selected:

Virtua will maintain patron checkout history, which may be viewed on the
Patron Information window.

Virtua will not allow multiple check-outs of the same item to the patron.

Note: Running the script SetPatronAllowItemRepeatCheckoutOn.sh enables
the Allow Duplicate Checkout functionality for all patrons in the database.

Add Patron Notes

Patron notes added in the Patron Editor can display as pop-up alerts during
Check-in, Checkout, Renew, and Request transactions. To change any of the fields
in the Note Type, Print Notices, Display/ Alert, and Note Content highlight the
specific field and double click inside the content you wish to modify.

W Patron Editor - Customer Support Library E]
Mame: Hannah O'Connell Cell Fhone:
Address: 1701 Kraft Drive Email: oconnelle @vils.com
City: Blacksburg Patron Type: 5T
State: VA Birthdate:
Zip: 24060 Barcode: vils214
Primary Phone: 540-557-1201 Password: = FEERE

Alternate Phone:

Mame ] Main Address ] Secondary Address ] Email/Phone ] Birthdate ] Card Mumber Password Motes IBI_-: )

Most Recent P
MNote Type | Print Motices | Display/Alert | MNote Content | Change —
General Do notprin... Do not displ... n's lhearu a0 | IRate Operator
- What's This? 9051006  staff
Display Mote jﬂ
S———— ious
Changes
Date Operator
201209051002 staff
add Delete ‘ !
Record Created Il
Delete | Next ‘ Submit | Close ‘

To view the entire note right-click in the note section and select Display Note.
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F =

Information

\i’) Patron's library card was found and returned to Circulation.

Blocks

The Blocks tab allows you to add a block to a patron record.

To add a block to a patron record, click the Add button to open the Add Patron
Block window.

Select a block type from the drop-down list and click Add. The drop-down list
contains the block descriptions as defined in the Block Code Definitions parameter
in the Virtua Profiler.

To remove a block from the patron record, select the block you want to remove and
click the Delete button.

W Patron Editor - Customer Support Library E] O

Mame: Hannah O'Connell Cell Phone:

Address: 1701 Kraft Drive Email: oconnelle@vts.com

City: Blacksburg Patron Type: ST

State: VA Birthdate:

Zip: 24060 Barcode: vis214

Primary Phone: 540-557-1201 Password: T

Alternate Phd”s 4d Patron Block - Customer Suppor...

Main Address Eoze meer;’Password] Motes Blocks lEa i
|Pah'on record expired j

Block |
Add Cancel ‘

Delete
Delete Mext Submit Close
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Profiler Tip: The Block Code Definitions parameter lets you create definitions for
the codes that your library uses to block patrons. See Working with Circulation
System Parameters: Configuring the Block Code Definitions Parameter in the Virtua
Profiler/Circulation Parameters User’s Guide for more information.

Save the Record

When all of the required information has been entered, the submit button
becomes active and the patron record can be saved to the database.

e If a patron record is saved with a duplicate barcode number, the system will
generate an error message and the record will be saved in error state.

e If patron record duplicate checking is enabled, when a patron record is
saved, Virtua launches a keyword search on the following fields in the patron
record to check for duplicates:

e Patron Name

e Street Address

e Social Security Number
e Driver’s License Number

The record is saved to the database, and the Patron Information window appears
displaying the Card Format tab view of the record you just edited.

Duplicating Patron Records

A right click within the Patron Editor header will open a pop up menu with the
option to create a Duplicate Record in New Editor. Selecting this option displays
a copy of the current record in a new Patron Editor window, where the staff user
may edit the copy of the record and then save it as a new patron record.
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W Patron Editor - Customer Support Library g
Name: Cell Phaone:
Address: Email:
City: Patron Type:
State: Birthdate:
Zips Barcode:
Primary Phone: Password:
b What's This?
Alternate Phone:

Duplicate Record in Mew Editor

i Main Address ] Secondary Address ] Email Phone ] Birthdate ] Card Mumber Password ] Motes ] Blc 4] ¥

Title: First Mame: Middle Mame: Last Name: Suffix:
| =l | | | =

Patron Type: Language Preference:
ﬂ | j v valid name

[ Display name

[ In-Care-Of
Library Info
Registering Library:

Home Library:
|Larnoni-Book Collection j

[~ Company

‘ MNext ‘ ‘ Close |

Note: Your library can choose to allow patrons to Self-Register for library cards in
Chamo, to learn more about this workflow please refer to the Chamo Application
Users Guide.

Edit a Patron Record

From the Patron Information window on the MARC or Full tabs, click the Edit
button to open the Patron Editor.

Edit the record and save it again.

If you change the patron type, it will affect all future transactions once the
record is saved.

If you change the barcode by moving it to the former barcode subfield or simply
by changing it, the software can still link circulation transactions to this
patron record since transactions are linked to the patron ID number.
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The Patron Information Window

The Patron Information window contains the following tabs and buttons:

Tab

Description

Patron Record/Card
Format

Patron Record/MARC
Format

Activity Tab
Account Tab
Button
Renew All

Update

Refresh

Close

Patron information in format that your library can
specify

Patron information in MARC format

Displays patron circulation activity

Displays patron’s account, such as fees or fines
owed

Description

Renews all items that are eligible for renewal as
determined by the Profiler settings. To renew
specific items, navigate to the Activity Tab
Updates patron expiration date (tag 042 subfield
$b) as determined by the expiration date
parameters set in the Profiler

Refreshes the window to reflect changes to the
patron information

Closes the Patron Information window

In addition, a right mouse click from the Patron Information Window will display
several different menus depending on the tab.
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Patron Information Window Resizing Option

The Patron Information window is unable to be resized until the Smaller Patron
Information Resizing option is enabled. To enable the resizing option, on the
Virtua Main Menu go to Options > Circulation Options > Smaller Patron
Information Resizing. After enabling the option modify the Patron
Information window using the arrows around the edge of the window to modify
the size to your preference. Once the Patron Information window is resized the
new window size is persistent.

W Virtua - Lamoni-Book Collection - phoenix E]@

File Search Circulation Acquisiions Cataloging  Options Tools Window Help

= = i 3 b, "
W@HU| | & k| @ GE q 0Py Bl BD B[S
Default connection: phoenix - staff Language r
Font

Hyperlink Options. ..
Directionality 3

Change Location...

Circulation Options 3 Check-out/Renew Receipt Setup...
v Sort Patron Account by Location Check-n Receipt Setup...

Cataloging Options... Fine Receipt Setup...

Label Editar... In Transit Slip Setup...

Load Options. .. Billed Material Slip Setup...

Available Languages... Requested In Transit Slip Setup...
Requested Slip Setup...

Toolbars 3 )
Agency Requested Slip Setup...
Patron Address Label Setup. ..
Loans/Pages Setup...
Auto Populate Patron Barcode
Circulation Assistant Integration
Smaller Patron Information Resizing
Sort Checkout/Renew Receipt Items by Due Date
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Card Format

The Card Format is the public view of the patron record and displays the patron’s
personal information in a formatted view. The information displayed on the Card
Format tab is configured in the Profiler > OPAC - Client Views > Patron
Information/Checkout/ Renew/ Check-in MARC View Editor.

W Patron Information - 0'Connell, Hannah g@
| MARC Format | Activity | Account |
Patron barcode: vis214 i
Patron barcode: 1992
MName: O'Connell Hannah
Patron Catagory: AR
Date of Birth: 20100222
Home library: Belefonte
Primary Address: 1701 Kraft Drive, 24080, Blacksburg, Montgomery, VA, USA
Primary Telephone: 557-1200
E-mail: oconnelt@viscolm
Expiration date: 201112301111 w
Edit. ..

[ Print Receipt Update Renew Al Refresh ‘ Close |

MARC Format

The MARC Format tab can be displayed in Virtua if your library chooses to enable
this option in the Profiler > Global Settings > System - User Profiles >
Permissions - Operational Security > Patron Information > MARC Format
tab check box.
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W Patron Information - Library _E@ﬂ

Card Format

| Activity | Account |

LDR
001

003
00s
ooT
003
015
01%

00956nPa 2200277 4500

vil=000285058

NcFayC

20120527132600.0

p 00000000000000000100000000

20120527ra1000 1 0

\a 38888000111397 \b L111397 \c 6d718b8603e73e44a87dbe58088606ed
\a 5555 b 6074c6aa34858f3c2dddff2a7ca821aab

m

030 \a Ak

032 \a 166

039 9 \a 201205271325 \b staff \c 201205211440 \d staff \c 201205211440 \d staff \c 201205...

042 ‘\a 201108090941 \b 201208080941 \c 201408080941 \d 201205241115

100 ‘a Library Patron \d 05/31/1982

245 ‘\a Adult -
Edit...

[~ Print Receipt Update Renew All Refresh | Close |

Activity Tab

The Activity tab lets you view and manage various aspects of a patron’s circulation
activity. Category tabs will only display when a patron has an item in a category. If

the patron has an item that is checked out and overdue, it will display on the

Overdue sub-tab, not on the Checked out tab.

—

W Patron Information - 0'Connell, Hannah

Lo

Category

] Account ]

Overdue
Pending
Disputed

YSummary

Chedked Qut

AChecked Qut AOverdue APending ADisputed /

ol

I Print Receipt Update | Renew All |

Refresh | Close |

The Category sub-tabs contain columns of information about each item; your
library can choose which information is to be displayed in these columns. This
information is configured in the Profiler > OPAC -> Client Views > Patron

43

Activity: category sub-tab of user’s choice to define. Information columns can be
resorted by clicking on the column header. If the patron has multiple items on their

Checked Out sub-tab these can be resorted by Title, Due Date, or any column

header displayed.
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W Patron Information - 0'Connell, Hannah Q@
Card Formatl MARC Format
Total Items: 1
Title | Barcotf | Hold Till Date I Pickup Location | Motice Sent
Dangerous dating : helping young women break out of ab... [31781038014625 [12/13/2011 10:28:57 AM |Headquarters [N
Summary | Pending  pickup IHishary I Lost I Damaged
Inifa |
I™ Print Receipt Update Renew All Refresh | Close |

Suspending Pending Requests

To deactivate pending requests click the Deactivate button to open the Add
Suspension Dates window. The Add Suspension Dates window allows staff to
determine a date after which the selected request will be suspended.

To suspend the request indefinitely, define only a Start Date.

To automatically reactivate the request after a certain date, select the Use End
Date check box and define an end date.

W Patron Information - 0'Connell, Hannah [2@
Card Format | MARC Format Actvity } Account | rw Add Susp'ensiﬂn Dates... g@-\
s 1
Please select a start date/time for the request
s = = AT Fhe | BRI suspension. A?lem:ing dﬁteftinft:ris Dp;zqnﬂ. ﬂ
Start Date:
| B3uzo1a =] | susosam =
[~ Use End Date
End Crate:
| [7] | =
Summary | Blled  pPending [In Transitl
Save | Cancel |
Deactivate | | - |
I~ Print Receipt Upsste |  Renewm |  metesn | cose |

Click the Save button to save your changes.
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Possible Category Sub-tabs for Display on the Activity Tab

Tab Description

Checked Out Items Checked Out

Overdue Items Overdue

Billed Items Billed for Replacement

Requested Billed Billed Items Requested from the patron

Requested Items Requested from the patron

Requested Items Requested from the patron, which are overdue.

Overdue

Pending Items Pending (that is, items requested by or for the
patron)

In Transit Requests that have been trapped but that are not
ready for pickup

Pickup Requests for the patron that have been satisfied and
are ready for Pickup, including materials booking,
holds, recalls, and loans

Disputed Items Disputed by the patron

Waived Items Waived by the library

History History of patron transactions (008 Positions 15 & 16)
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Account Tab

From the Account tab, you can view and manage all the fines and fees associated
with a patron’s account.

Categories on the Account tab will only display if a patron has items in the
category. If a category has no items, the tab for that category does not appear on
the window.

Account Summary Sub-Tab

W Patron Information - 0'Connell, Hannah g@

Card Format ] MARC Format -"‘\ l Account]

What's This? il
Titie | Barcode | Check CutDate | - I
Mrs. McGinty's dead / Agatha ... |31781003078571 |1/6/20119:05:0... |1 Patron Check-Out

Patron Routing

Item Record
Itern Requests
Transaction Log

Print
Save
E-mail

Print Address Label
YSummary #Checked Qut AOverdue 4Pending ADisputed [

Extract To File | ‘ ‘ ‘

[ Print Receipt Update | Renew All ‘ Refresh | Cloze ‘

Fee and Fine Categories

Virtua includes a set number of default fee and fine categories. Your library can
define additional fees/fines in the Profiler > Circulation > System Parameters
- Fine Code Definitions. Listed below are the default fee and fine categories.

Overdue

Late Renewal
Item Price Fee
Damaged Item
Recall

Processing Charge
Dispute
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Right Click Pop-up Menus for Activity and Account Tabs

W Patron Information - O'Connell, Hannah

LoE

Card Format ] MAR.C Format -"‘\'IUVI‘EYI Account ]

Due D... | Call Mumber Title

1/6/20... |822.33Q025 William Shakespeare's Much ado about no

What's Thig? Items: 1

Patron Check-Cut
Patron Routing

Item Record
Itemn Requests
Transaction Log

Print
Save
E-mail
Print Address Label
WSummary AChecked Out AOverdue fPending ADisputed f
[ Print Receipt Update ‘ Renew Al | Refresh ‘ Close |

Right Click Pop-up Menus Contain the Following Options

Option Description

Patron Checkout Opens the checkout window

Patron Routing Displays serials routing lists the patron is
on

Item Record Retrieves the item record

Item Requests Displays items requested by patron

Transaction Log Displays transaction log for the patron
(Activity tab)

Audit Trail Displays audit trail log for the patron
(Account tab)

Lost/Damaged Displays the Lost/Damaged information

Note when an item has been marked Lost or
Damaged

Print Address Prints an address label for the patron

Label

Print Print Activity or Account information

Save Save Activity or Account information to

workstation

Email Email Activity or Account information to

Circulation Workflow-Based Reference Guide
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Print, Save, and E-mail

The right click pop-up menu from the Activity and Account tabs in the Patron

48

Information window allows you to Print, Save, or Email the information contained

in the tabs. You can record in the information in full using the Complete Detail

option or per tab using the Tab Detail option

-
Print - Customer Support Libra_ &u
—Printing
I Format: Patron Activity - Complete Det:j
Patron Activity - Complete Detail
Patron Activity - Tab Detail
—HRange Copies
Al Mumber of copies: |1 ﬂ
{¥ Selected Records
" Selected with Child Records

Printer Setup |

oK

Cancel

' N
% E-mail Records - Customer Support Library ‘ &u

—Record Information

Format: Patron Account - Complete Dej

[T Wapto IS0-8859-15
[+ Send as Attachment

Patron Account - Complete Detail
[ RN R Patron Account - Tab Detail

—Range
= ol
{" Selected Records

—Message information

Send To: I

Subject: |

If vou do not fill in the above information, yvour e-mail software will prompt vou to
finizh composing the message when you press Ok,

oK Cancel
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Retrieve Patron Records

To Obtain Patron Information by Entering a Patron Barcode

Click the View Patron Information icon ﬂ, press the F2 key on your
keyboard, or select Circulation > Patron > Record on the Virtua menu bar.
The Patron Access window will appear.

¥ Patron Access - Custom...

Primary Barcode:

{* Primary (" Alternate ("~ Both

QK Cancel |

Select the Primary, Alternate, or Both radio button. The Both radio button
allows you to search both the primary (patron record 015 tag) and alternate
(patron record 016 tag) patron barcodes in a single search. The presence of the
Both radio button is determined by an operational security permission setting in
the Virtual Profiler.

Enter the patron barcode and click OK. The Patron Information Window will
appear displaying the patron record.

Note: The radio button setting is persistent and becomes the default the next
time the Patron Access window is opened.

To Obtain Patron Information Without a Patron Barcode
Patron Keyword Search Types

On the toolbar, click the Search icon 1' and choose any of the following
options from the drop down menu in third row of the Patron search tab Patron
Name, Reading Program Nominator Code, Other Name, or Other
Document Number as your search category, or press F8 (opens patron name
browse search).

For the Patron Name search enter the name of the patron (last name, first name)
and click the Search button. The Browse Window appears.

For the Reading Program Nominator Code Search enter the ID number assigned
to the patron.

For the Other Name search enter

For the Other Document Number search enter the number of the document. This
is defined by the library for the 029 tag.
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W Search - lynx

Browse ] Heading I Keyword I Control Number I Holdings Keyword Patron I

[Additional name from 700 subfields a, h ,m and 710 subfields a, b

=

=

|anD

=

Other Document Number from 029 subfield a|  ~ |

50

l

|anD

Mame from 100 subfields a, b ,m and 110 subfields a, b
Other Document Mumber from 029 subfield a

Other name from 111 subfield a
Phone number from 270 subfield k
Reading program nominator code from 303 subfield b
Social Security Number from 020 subfield a

Street address from 270 subfields a, b, d, e

Student ID Number from 024 subfield a

Search I

.

Cancel

Double-click the name of the patron whose information you want to view. The
Patron Information Window will appear.

Control Number Search Types
Patrons can also be search for by Control Numbers in the Search window, using
the following control number types:

e Birth Certificate Number (patron record 025 tag subfield $a)
e Passport Number (patron record 022 tag subfield $a)

W Search - Customer Support Library

-,

Browse ] Heading ] Keyword Control Mumber lHuIdings Keyword ] Patron ]

|Auth ID

[] |

QCLC Mumber
Patron Barcode
Alternate Patron Barcode

-

Birth Certificate Mumber

Passport Mumber
Vendor ID
Patron Id

Ttem Id

1< |

ol number,

humber by dicking on the arrow in

Lt want to search.

ress the ENTER key an your keyboard.

El

Location

Search

Cancel
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Update a Patron’s Expiration Date
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Open the patron record in the Patron Information window:

W Patron Information - 0'Connell, Hannah

LEE

3t | MaRC Format | Activity | Account |

Patron barcode: vis214 ||
Patron barcode: 1932
MName: O'Connell Hannah
Patron Catagory: AR
Date of Birth: 20100222
Home library: Belefonte
Primary Address: 1701 Kraft Drive, 24060, Blacksburg, Montgomery, VA, USA
Primary Telephone: 557-1200
E-mail: oconnelt@vHscolm
——p | Expiration date: 201112301111 o
Edit. ..
[ Print Receipt Update | Renaw Al | Refresh ‘ Close |

If a patron record is about to expire clicking on the Update button will reset the
expiration date. A new expiration date will be set based upon the parameters set in
the Profiler > Circulation > Location + Patron Matrix. Both the expiration
date and the delete date parameters can be set as a fixed date, for example, the
end of a semester or the parameters can be a calculated date, for example, 2 years
from the date the patron was first entered into the system.
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Checkout Item

Recommended
Workflow

Explanation

Checkout from
Patron record

Obtain Patron
Record

Y
Checkout Item

A 4

View Patron
Information

Checkout from
Item Record

Obtain Item
Record

A 4

Checkout Item

Virtua provides a simple and straightforward workflow
for checking out items.

Summary

Retrieve a patron record by entering a patron
barcode

Retrieve a patron record by performing a browse
search

Checkout an item

View patron limits tab

Retrieve patron information for a checked-out item

Key Terms

Audio Signals
Circulation Matrix
Check-out

Due Date

Fixed Due Date
Patron Limits
Receipt

The Profiler parameters listed below affect the checkout
process.

Circulation: System Parameters

Checkout Limits: sets total number of items a
patron may check out.
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Circulation Parameters

Circulation: Location Specific Parameters

Closed Dates: sets dates library is closed and adjusts due dates
accordingly.

Library Hours: sets hours library is open for each main location.
Sub-locations have the same hours as their main location.

Library Defined Dates: allows library to set a fixed due date for the
loan parameter in the Location + Patron+ Item Matrix, e.g.: at the
Main Library all books checked out to faculty are annual loans and
therefore due Dec.31st.

Alerts and Blocks Matrix

Defines system-calculated Alerts and blocks based on:
Number of overdue items
Number of overdue items with requests
Number of days overdue
Number of bills
Number of overdue reserves
Amount of money owed to library

Circulation: Location + Patron + Item

Loan Rules: determines fixed or calculated loan period based on
checkout type.

Requests per Item that trigger a loan rule change: If more than
the number of requests specified here are placed against an item, the
loan period for this item is automatically set to the Guaranteed
Circulation Period.

Circulation: Location + Patron

Set Default Date & Time: Sets default date and time that displays
on the checkout/renew window when Fixed Date and Time is
selected.

Circulation: Location + Item

For the Items Circulating Less Than One Day Are Due at Closing
setting, it gives the option of choosing either . . .
Yes - An item with a loan period of less than one day is due at
closing on the day it was checked out.
_OR_
No - An item with a loan period of less than one day is due the
following business day if its loan period has NOT expired by
closing on the day it was checked out.
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For the Items Circulating One Day or More Are Due at Closing setting,
it gives the option of choosing either . . .

Yes - Items are due by closing on their due dates.

-OR-
No - On their due dates, items are due at the same time they
were checked out.

Circulation InfoStation Reports

Basic Circulation Statistics: generates circulation statistics.

Circulation by Call Number Range: generates count of items by
call number range, location, and date range.

Circulation Snapshot: generates a summary of circulation
statistics at the time the report is run.

Bills: generates a list of overdue items that are eligible for billing.
It can generate billing notices/emails.

Overdues: generates a list of overdue items. It can generate
overdue notices/emails.

Review Notices: generates a review notice for patrons whose
borrowed items are about to come due.

Journal Circulation: Generates statistics for serial titles in the
database.
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Checkout from Patron Record

Open Patron Record in Checkout Window
With a Patron ID Number (Barcode)

Click on the Icon on the Circulation toolbar or use the F5 key.

Enter the patron barcode. The Checkout window will appear.

W Check Out/Renew - Customer Support Library - Headquarters - vtls214 - 0'Connell, ... g@

Patron Check-outs l Patron Limits:

Patron wiis214 - Information
barcode: Fines: $.00
Patron WA Requested: 0

Catagony:

Date of Birth: 20100222 SuErirs L

Home library: Bordeaux il ) L
Home 1701 Kraft Dr, 24060, Blacksburg, VA sERilEm
Address: ] Category Limit:

Check-out Type

{+ Regular (" Fixed Time

™ In-house (™ Selected Time: ~— Date:

Item Barcode Title: | Due Date/Time | Type

[ Print Receipts ltem Barcode:

o =

Group Receipt [tems By
o =

[~ Remember Last Check-out Type

| |

If a patron whose borrowing privileges have expired attempts a checkout, a pop-up
message appears notifying the staff member of the expired privilege. Staff will
need to update the patron’s library record before the checkout can be completed.

If a patron whose borrowing privileges will expire during the checkout period a
message will display to notify the library staff member. The staff member will need
to decide whether to proceed with the checkout with a shortened due date, view
the patron’s record (this will cancel the transaction) or to cancel the checkout.

When a checkout is initiated Virtua checks for blocks against the patron for each
checkout or renewal transaction until a block is overridden for the patron. It is only
after a block is overridden that Virtua stops checking for blocks against the patron.
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Virtua still checks for blocks against a patron each time a new Check Out/Renew
window is opened.

Check Out Types

In the Check Out window select Check Out Type:

Type Description

Regular Loan rules based on the Circulation Matrix.

In-house Loan rules based on the Circulation Matrix.

Fixed Time Sets one due date and time for
everything.

Selected Time Allows you to override the Circulation
Matrix.

Without a Patron Barcode
Perform a Browse search for the patron’s name; this will open a Browse list with
the patron names near that of your patron. Highlight and double click on the
patron name you would like to open and the Patron Information window will
appear for display. From the Patron Information window, right mouse click
and select Patron Check-Out to open the Checkout/Renew screen.

W Patron Information - O'Connell, Hannah E]@

[Card Format | MARC Format | Activity | Account |

Patron barcode: vils214 2|
Patron barcode: 1992
Mame: O'Connell Hannah
Patron Catagory: AA What's This?
Date of Birth: 20100222 Patron Check-Out
Home library: Bellefonte Patron Routing
Primary Address: 1701 Kraft Drive, 24060, Blacks| _
Primary Telephone: 557-1200 Print
' Save

E-mail: oconnellt@vtscolm

- E-mail
Expiration date: 201112301111 V)

Print Address Label

Edit...
Copy Ctrl+C

¥ Print Receipt Update Renew Al Refresh ‘ Close |
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Checkout Using Item ID

Retrieve the Item Record

Select Search > Item Barcode from the Virtua menu bar or click F3 to open
the Control Number Search window with the Item category selected.

Enter the Item number (barcode) and click the Search button. The Item
Information window will appear.

Checkout Item

Right mouse click in the Item Information window and select Checkout from
the popup menu. The Patron Access window will appear.

W Item Information - Customer Support Library g

ltem Elements ] Notes l Smﬁsﬁcs] Smtusl Acquisitions | Other Elements
Biblicgraphic Information

Author: Jackson, Shidey, 1916-1965.
Title: Haunting of Hll House
Subject: Haunted houses Fiction. What's This?
Item Information {  Append/Print Spine Label
Item 10 974227 [ Clear Label File
AppendPrint Property Label L
Barcode: |379E' ¢ Clear Property Labels
Barcode Type: |F{egular j
Check Cut...
Item Class: |Book

Reserves ltem Class: |

Item Bookings

Ll Lol [l Lo

Item URL: | Item Requests
Bib Reguests
Location: Bordeaunx
| | AudicTrail... J
Shelving Location: |B<}rdeaux Transaction Log...
| ParentRecord
Bibliographic Record
1
Number of Pieces: 1 = [ Circulate Pieces Mare Nates j
Price: 51695 1 Print
Save
L ;
EPM Mumber: | E-mail j

Accession Number:
| Circutation Rules:

A Accession Number: | f* |se Matrix
) {~ Use Loan Period: 0 =
Collection Code: | [ v AowRequest [ Floats
[~ Masked Delete | Save | Cloze |
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In the Patron Access window, type or scan the Patron barcode number.

rﬁ Patron Access - Custom... -\

Primary Barcode:

{* Primary (" Alternate ("~ Both

QK Cancel |

The checkout window will appear with the item number already entered.

Select the Checkout Type and click the Checkout button to checkout the item.

W Check Out/Renew - Customer Support Library - Headquarters - vtls214 - O'Connell, ... E]@
Patron Check-cuts | Patron Limits

Patron viis214 - Information
barcode: Fines: < o
Faren A Requested: 0
i Overdue: 0
Date of Birth: 20100222 cue .
Home library: Bordeaux Billed: _
Home 1701 Kraft Dr, 24060, Blacksburg, VA ) | sEilEm
Address: > Category Limit:
Check-out Type
+ Regular " Fixed Time
" In-house " Selected Time: =1 Date:
Item Barcode Title | Due Date/Time [ Type
|| Print Recepis Item Barcode: 3750
¥ ')

Group Receipt ltems By
i i+

[ Remember Last Check-out Type

‘ Check Out |

The circulation rules are set in the Profiler - Circulation > Location + Patron +
Item matrix. Virtua looks at the rules established in this matrix each time
checkouts and/or renewals are performed.

To check out an item enter the item’s barcode and click on the Check Out button.

If the item you are checking out consists of more than one piece, Virtua alerts staff
in one of two ways:
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If the option to circulate individual pieces is turned ON in the Item Information
elements, you will be prompted to choose whether or not to perform a “partial
check-out.”

¥ Check Out: Number of Pieces - va: (=]

Yolumes 1 & 3 only|

Mumber of pieces to be checked out; |2 :Il
o4 I Zancel |

Use the arrow keys to adjust the Number of pieces to be checked out value to
the desired number of pieces.

Staff members have the ability to enter a note about the checkout transaction in
the text box at the top of the window, in case a piece is missing or they want to
make note of something about the transaction.

If the option to circulate individual pieces is turned OFF in the item record, you
will receive an alert that the item has multiple pieces, but the Note option and
the ability to adjust the humber of pieces being circulated are not available.

Virtua supports the option to perform an Improper Check-in when the item you are
checking out is already checked out staff will receive an alert that the “Item is
checked out - must be checked in.” Then you have the options of:

W Messages - Phoenix%% E]@

kern is checked out - must be checked in

Ancept Al FWaive

Cancel |

Accept All - the system checks the item in from the first patron, assesses any
fines that apply to the first patron, and then checks the item out to the second
patron.

Accept All/Waive - the system checks the item in from the first patron,
waives any fines that apply to the first patron, and then checks the item out to
the second patron.

Cancel - this will cancel the check out.
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Access to the View Bibliographic Record and Item Record

To access the bibliographic record from the Check Out/Renew window highlight
the checked out item and right click to open the pop-up menu and select Bib
Record.

W Check Out/Renew - Customer Support Library - Headquarters - vtls214 - O'Connell, ... g@
Patron Check-outs | Patron Limits
Patron wiis214 ~ Informaticn
fpEniE | Fines: 5.00
Patron VA 3 Requested: o
Catagory. Crverdue: 0
Date of Birth: 20100222 o o
Home library: Bordeaux .
Home 1701 Kraft Dr, 24060, Blacksburg, VA T
Address: w Category Limit: 150
Check-out Type
{* Regular " Fixed Time
™ In-house ™ Selected Time: — Date:
ltem Barcode Title | Due DaterTime | Type
13790 The haunting / by Shiriey Jackson. A2 204 W0 OhA___Domdar
What's This?
Mext Page Ctrl+Tab
Previous Page  Shift+Ctrl+Tab
Patron Record
Patron Activity
[~ Print Receipts Patron Account
i {+
) Item Record
Group Receipt [tems By Item Requests
i {+
Bib Record
[~ Remember Last Check-out Type

Clicking the Bib Record option opens the View Bibliographic Record window.
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W View Bibliographic Record - Customer Support Library g@
171
Full MARC
Title: The haunting / by Shirley Jackson. Status Counts
ISBN: 0140287434 (pbk.) : Checked Out: 1 On Reserve: L]
ISBN: 9780140287431 (pbk.) Avalable: 0 Requested: o
Publication: New vork, NY : Penguin Books, 1999, On Hodd: 0 Other: o
Description: 248p.; 20 cm. Total ltems: 1 Unsatisfied Requests: 0
Subject: Haunted houses Fiction. Total Reguests: 0
Call Number shetving Location | u... | status ltem Barcode
F JACKSON Bordesux Due: 1v23/2013... 3790
a4 3
L& it Selection:
1”;:3" " Show Group | | View ltem | Delete ltem ‘ Request Item ‘
™ Masked Agency Req ‘ | Edit | Request Bib ‘ Add ltem | Refresh ‘ Close |
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Also access to the Item Record or Item Requests is provided by the right click
pop up menu from the Check Out window.

Print Receipts

To print a receipt, check the Print Receipts check box on the Check Out window.

The Print Receipt setting is persistent. If print is enabled, closing the window
without printing will generate a reminder to print the receipt.

Select either the
After Each Item radio button
OR
When Checkouts are Complete radio button

Then click on the Print button to generate a receipt when checkouts are
complete.

OR

Uncheck the Print Receipt check box if you do not want to print a receipt.
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Configure Receipt Setup

Receipts in Virtua can be configured individually per workstation or through the
Virtua Profiler. The Profiler settings apply to all locations and will override receipt
and slip configurations set in the Virtua client. System wide receipts are configured
in the Profiler > Circulation > System Parameters > Receipt/ Slip Setup.

For the individual workstation receipt configuration:

Select Options -> Circulation Options > Checkout/Renew Receipt Setup
from the Virtua main menu.

Enter Library name/address in the Starting Text box (up to 3 lines of text)
Enter the field names to appear on the receipt.

Select the options to be included on the receipt i.e. checked out date, time, etc.

% Fine Receipt Setup - Customer Support Library g@
Starting Text:
Library of the Great West |

123 Raw Hide Road
Silver Spur, WY 33482

Fine Receipt |
Field Mames:
Payment Type: Payment Type: Location: Location:
Patron Name: User: " Show Owning Location
" Show Shelving Location
Patron Barcode: IUser ID:
# show Both
Author: Author: Payment Date: |Pa\,rment Date:
Title: Title: [v Include Payment Time
Call Number: Call Number: Amount Paid: |Amount Paid:
Item Barcode: Item Barcode: New Balance: |I'~Jew Balance:
Item's Due Date: [tem Due Date: [ Print Detailed Ttem Information
Amount Paid {For Item): |Amount Paid {For It Receipt Mumber: |Receipt Mumber:
Mew Balance (For Item): |New Balance (For It Transaction Reference Mum: |Transaction Ref Mum:
Reprint Text: Reprinting Fine Reo Fine: I—Fine:

(Only named fields will be printed.)

Ending Text:

Thank you for your patronage!

Copies to Print: |1 QK Canicel
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Enter any ending text to appear on the receipt.
Save the configuration by clicking the OK button.
The receipt will be printed.

Note: When the fine receipt is configured to print detailed item information, and
the Fine label is configured to print the fine type (Overdue, Replacement Fee, etc.),
the fine receipt will include the fine type for each fine or fee paid.

Library of the Great West
123 Raw Hide Road
Silver Spur, WY 38482

Fine Receipt

Name: Documentation
Barcode: 4589

Author: Brydges, Egerton, Sir, 1762-1837.
Title: Censura literaria: Containing
titles, abstracts, and opinions of old
English books / By Samue! Egerton
Barcode: 1000003110
Due date: 12/15/2011
Amount paid this item: $5.00
Amount due: $10.00
Fine: Processing Fee

Date: 5/2/2012
Total amount paid: $5.00

To configure the default Receipt Printer to be used by the workstation on the File
Menu select the Receipt Printer Setup option.
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Printing Grouped Items and Regular Items

A single checkout receipt may contain information about both regular checkouts
and grouped items since a receipt for all items in a transaction is printed.

Library of the Great West
123 Haw Hids Road
Silver Spur, WY 30482

Check-Cut Receipt

rleser: Sieels, James

User I0: 940

ser Phone: 757-555-0040

Author: Real Estate Ressarch Corporation.

Titlz: Nemghborhood presenafion - legal
and admmisiratve documenis [ prepared
for the Cffice of Policy Development and

Call Mumber: HT175.Ua RS2

lt=m I0: 100001 6369

Transaction Ref Num: 284407

Checked-out Date: 5/8/2012 5:42:14 PM

Due Date: 510/2012 5:27-42 PM

No-n—-< Location: Wilson Library

ouped User: Steels, James

glf P User ID: 940

ttems User Phone: T57-555-0040

Authaor: Raich, Steve, 1936-

Titla: Music for a lamge ansermnble ;
Wielin phase ; Octet sound recording [/
Stewe Reich.

Call Mumibar: ECM ECM-1-1168

Itamn 1D 1123455708

Transaction Fef Num: 284407

Checked-out Date: S/8/2012 5:42:23 PM

Due Date: 511002012 5:27 42 PM

Lku-:atinn: Garrda - Reserve Hoom

Usar: Steels, James \

Uzer ID: 940

Usar Phone; 757-555-0040

Authaor: Pritchard, John Pawl, 1902-

Title: Literary wise men of Gotham :
criticism in New York, 168151860

Call Murnbser: PRS9. 52 PY

ftemn 10 100001 3051

Transaction Ref Num: 2685407

Checked-out Date: S&/2012 5:57:04 PM

Due Date: 5102012 527 42 PM

Loeation: Wilsan Library

Liser: Gteelz, James G—ruuped items

Liszr I0)- 940

Liser Phone: 757-555-0940

Authar; Prifchard, John Paw, 1908-

Title: Literary wise men of Gotham
craticism in New York, 1815 1860,

Call Mumbsar: PNSO LS2 F7

Itz I0: 40000043092

Transaction Fef Num: 285407

Checked-out Date: 5/8/2012 55707 PM

Dug Date: 510/2012 5:27 42 PM

Location: Wilson Library
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Sort Checkout/Renew Receipt

To group items by due date on the checkout or renewal receipt select Options >
Circulation Options > Sort Checkout/Renew Receipt Items by Due Date

from the Virtua main menu.

Check-out/Renew Receipt Setup. ..
Check-in Receipt Setup...

Fine Receipt Setup...

In Transit Slip Setup...

Biled Material Slip Setup...
Requested In Transit Slip Setup...
Requested Slip Setup...

Agency Reguested Slip Setup...
Patron Address Label Setup...
Loans/Pages Setup...

Auto Populate Patron Barcode
Circulation Assistant Integration
Smaller Patron Information Resizing

Sort Checkout/Renew Receipt Items by Due Date

Due Date: March 16, 2012

Uzer Andrews, Catherine

User ID: vilsD215

Author: Grisham, John

Title: Tha lsst jurar/ John Grisham.
Call Mumbsr. FGRIS 2004

Item ID: 151

Transachon Rel Mum: G014
Checked-out Date: 3122012 1223131 PM
Due Date: 362012 10:30:00 PM
Location Brgan Campues Library

Due Date: March 20, 2012

Uszer. Andrews, Catherine

Uzer ID: w0215

Awthor: Grisham, John

Title: The king of torts [zound

recording] [ John Grisham.

Call Numbser: PT F GETk

Item 10 7063

Transachon Refl Mum: 6014
Checked-out Date: 313202 1223128 PM
Due Date: 3202012 10:30:00 PM

Loc atliom BREMNHAM READING RODM

Uszer Andrews, Cathenne

Uear ID: vile0215

Title: Runaway jury [videorecording] f
Reoency Enterprizes preserts a Mew
Regency Production | a Gary Fledler Film

Call Mumber: DWVD RET0j 2004

[tem O 577

Transaclion Ref Mum: 5014

Checked.owr Diate: 222042 1223434 Phd

Due Date: 22002012 10:30:00 PM

Location: BRENHAM READING ROCM

65

Note: The Sort Checkout/Renew Receipt Items by Due Date option is ignored

for checkouts that include group items.
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Patron Limits Tab

Click on the Patron Limits tab; the following Check Out/Renew window will

appear.

W Check Out/Renew - phoenix - Bellefonte - vtls214 - 0'Connell, Hannah

== <)

Patron Check-outs Patron Limits l

|

Patron Type

Patron Type:  Adult

Category Current Count

Max Count

Book
Paperback

DvD

Video

Audio Book Cazsstte
Magazines
Music CD
Reference

Book Large Print
Audio Book CD
Kit
Mizcellansous
Best Seller

Big Read

2 Hour Reserve

(=T =T =T — T — T~ R R~ T~ T~ — T I =R L]

200
200
4
25
25
50
25
0
200
25
25
100
200
200

Patron Limits

Patron Limits are based on parameters set in the Profiler > Circulation>
System Parameters > Check-out Limits Matrix. The parameters here work in

combination with the settings of other Profiler Circulation matrices, which are

listed below.

Patron Type + Item Class + Location
Patron Type + Item Class

Patron Type + Location

Patron Type

Default (None)
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View Patron Information for a Checked Out Item

When a book is checked out it is sometimes necessary to know who has it for
the purpose of holds, recalls, etc. This information can be obtained using the
Item’s Barcode or if you do not know the barcode number, open the bib record
in the View Bibliographic Record window. From the list of items, highlight
the item and right mouse click to access patron activity information.

To use the item barcode select Search > Item Barcode from the Virtua menu
bar or click F3 to open the Control Number Search window with the Item
category selected. Enter the Item number (barcode) and click the Search
button. The Item Information window will appear.

- .
W Item Information - phoenix E]
Item Elements | statistics | Status | Acquisitions |
Bibliographic Information
Title: The World Book student discovery encydopedia.
Publisher: Chicago : World Book, 2004,
Description: 13v. :ill. (some col.), col. maps ; 29 cm.
Item Information Call oy~ What's This?
Ttem ID: 811528 Copy: Append/Print Spine Label
Barcode: | e Clear Label File
- I
Barcode Type: | J and call Patron Activity
Ttem Class: | J Check In...
Renew...
Reserves Item Class: | Enen )
Units Ttem Bookings
Ttem URL: | = Item Requests
Bib Reguests
Location: i
oeaten | = Audit Tral...
Shelving Location: | J fs Transaction Log...
Parent Record
Bibliographic Record
e
Number of Pieces: x r Mare Notes
-
Price: Print
Code: 5
EPN Mumber: | ave
E-mail
Accession Mumber: |
Lamination: | J
Circulation Rules r
-
o v = Location: J
=
[~ Masked Delete | Edit | Refresh | Close |

Right mouse click in the Item Information window and select Patron Activity
from the pop-up menu. The Patron Information window will appear containing
the patron record associated with the item.
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Fastrac Circulation Assistant

Virtua is integrated with Fastrac with regard to circulation transactions (check-
outs, check-ins, and renewals). The Fastrac Circulation Assistant lets you use
your RFID hardware to perform circulation transactions singly or in bulk. The RFID
technology handles the communication with the Virtua client. The Circulation
Assistant works by reading the barcode on an item’s RFID tag via an antenna and
then sending the item barcode to the Virtua client to complete the circulation
transaction.

Select Options - Circulation Options > Circulation Assistant Integration
on the Virtua Main Menu to enable this option to tell Virtua to look for and
process Fastrac input.

W Virtua - Lamoni-Book Collection - phoenix E]@
File Search Circulation Acquisiions Cataloging  Options  Tools  Window Help
W @iO| & R|@ GE|a OPACDPa "lg| | BD BB
Default connection: phoenix - staff Language 4

Font F

Hyperlink Options. ..

Directionality 3

Change Location...

Circulation Options k Check-out/Renew Receipt Setup...
v Sort Patron Account by Location Check-in Receipt Setup. ..

Cataloging Options. .. Fine Receipt Setup...

Label Editor... In Transit Slip Setup...

Load Options... Billed Material Slip Setup...

Available Languages. .. Requested In Transit Slip Setup...

Requested Slip Setup...
Agency Requested Slip Setup...
Patron Address Label Setup...
Loans /Pages Setup...

Toolbars 4

Auto Populate Patron Barcode

Circulation Assistant Integration

Smaller Patron Information Resizing

Sort Checkout/Renew Receipt Items by Due Date

Fastrac will send the input barcode as a filename with the extension .fca to Virtua.
The file will reside in C:\temp. Virtua will respond with the barcode, a code
indicating the transaction type, and a code indicating whether the transaction was
successful.

Note: The Circulation Assistant Integration option is registry-persistent.
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Renewal and Check In

Recommended
Outline Explanation
I}fne"g‘wsglg Virtua offers simple and efficient ways to renew and
em Barcode oo
Information check-in items.
Summary
: Renew a book by entering an item (barcode) number.
Renewal Using Renew a book by entering a patron barcode
Patron .. Ly .
Information Renew a book by obtaining a bibliographic record
Check-in a book
= oa Key Terms
enewa Sll’lg
Bibliographic Check In
Record Item number (barcode)
Patron Barcode
Renew
Check-in Trapped
General Parameters
Location Names: Global Settings tab; Amnesty Flag,
Check In Status, Check-in Date, Check-in Flag 3-M
Status Displays: Global Settings Tab
Circulation Parameters
Circulation System: Renewal Override
Location + Patron + Item: Renewal loan rules
Location + Patron + Item: Renewal Limit
Restrict staff mediated renewals to items
belonging to own location
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Circulation Parameters

The parameters listed below affect the renewal or check-in
process.

Status Displays (Global tab)

Item statuses will be updated by the
ItemStatusMonitor.exe program, even if the Age Threshold
is set to zero. Libraries are advised to review their item
status definitions so that desired statuses will not be
deleted. Pay particular attention to statuses that have an
Age Threshold of 0 minutes/hours. These statuses must
have the Next Status box unchecked in order to prevent
them from being deleted by the ItemStatusMonitor.exe
program.

Circulation Basic Options (Circulation tab)

Renewal Override: Allows or disallows renewal if there are
requests the item qualifies for.

Library Names Parameter (Global Settings tab)

Amnesty Flag: determines if fines are assessed when a
patron returns an overdue item.

Check In Status: specifies the item status that will be
assigned to items checked in at that particular location.

Check-in Date: set date and time that will be used for all
items checked in if the check box is selected.

Check-in Flag 3-M: allows or disallows patron self-check-in
using the 3M system.

Location + Patron + Item (Circulation tab)
Renewal Loan rules: determines loan rules for renewals.
Renewal Limit: sets renewal limit and period.
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Renewal Using Item Information (Book In-hand)

Click on the Renewal icon on the circulation toolbar, press F6, or select
Circulation > Circ Desk > Renew from the Virtua Menu Bar, or to open the

Renew window.

W Renew - Customer Support Library

BEX

Patron Renewals l

Infarmation

Fines:

Requested: ——
Owverdue: e
Billed: -
Last ltem: ————-
Categony Limit; —_—

Renewal Type

{+ Regular " Fixed Time

" In-house " Selected Time: ~— Date:

ltem Barcode Item Class Title | Due Date/Time | Type

4

[w Print Receipts
{+ After Each ltem " When Renewals Are Complete

Group Receipt ltems By

{* Due Date " Patron Barcode

[~ Remember Last Renewal Type
[+ Skip requested activity and 007 info

Pay ‘

Chuit

Item Barcode:

| | I

Enter the item barcode and click Renew. The item will be renewed.

The Renew window allows users to renew items that are checked out to any
number of patrons and displays the item information and patron information

associated with each renewal.

Items checked out to any number of patrons may be renewed on the same

Renew window.

The header and the Information area display information about the patron
associated with the most recent renewal.

All renewals performed while the Renew window is open are considered part of
a single session and the fines for all associated patrons may be managed at the

same time.
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The Group Receipt Items By option allows users to specify whether items are
grouped by due date or patron barcode.

The SKkip requested activity and 007 info option users to skip 007 tag
generation and Requested information in the header area.

In the Profiler > Circulation> System Parameters > Circulation Basic
Options—> Item Options section is a parameter to Restrict staff mediated
renewals to items belonging to own location, if enabled staff will not be able
renew items belonging to a location other than their own location.

Renewal Using Patron Information

Click the icon, press the F2 key on your keyboard, or select Circulation >
Patron > Record on the Virtua menu bar. The Patron Access window will
appear.

-

W Patron Access - Custom... -‘

Primary Barcode: |

{* Primary (" Alternate " Both

oK | Cancel |

Click the Activity tab of the Patron Information window. Click the Checked
Out tab to view a list of items checked out to the patron.

%W Patron Information - O'Connell, Hannah E]@
Card Format] MARC Format ~Activity l.-!\u:ccuuntl
Total Items: 1
Title Barcode Check Qut Date Due Date Check... | R...

The Hollow { Agatha Christie, 31781049119942 | 12/29/2010 9;39...  1/19/20119;39;,.. Belefonte

YSummary #Checked Out ACverdue fPending /

Bill Extract To File Check In | Renew ‘ Dispute | Info |
[ Print Receipt Update | Renew All | Refresh | Close |
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Other category tabs may be available depending on the status of items the patron
has checked out, e.g. checked out, overdue, etc. If the item is not on the Checked
Out tab, look at the other available tabs.

If your library would like to provide a printed receipt of the renewed item(s), click
to place a check in the Print Receipt box.

Highlight a single item or multi-select items in a category tab using the Ctrl-Key,
and then click the Renew button to renew the selected items. There is also the
Renew All button to renew all checked-out items that qualify for renewal.
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Renewal from Item Record
Search the OPAC for the bibliographic record. Open the record in the View

Bibliographic Record window.

74

Highlight the appropriate item record from the list of item records displayed and

click the View Item button.

Right mouse click and select Renew from the pop-up menu.

The Checkout window will appear with the item information already entered.

Click the Checkout button to renew the item.

W Item Information - phoenix

—-

BE <

Item Elements ]Siﬁh’sh’cs ] Status I Acquisitions I
Bibliographic Information

Author: Christie, Agatha, 1890-1975.
Title: Appeintment with death / Agatha Christie. What's This?
Edition: 1st Winterbrook ed. Append;Print Spine Label
Ttem Information CallNy  Clear Label File
Item ID: 859720 Copy: Patran Activity
Barcode: | call £:
Chedk In... -
Barcode Type: | J 2nd 21 Rensu..
Item Class: | J Item Bookings
| | Itern Requests
Reserves Item Class: )
Uniits Bib F.{equn?sm
Item URL: | ~ Audit Trail. ..
Transaction Log...
Location: | J o
Parent Record
) . o]
Shelving Location: | J l— Bibliographic Record
More Motes
- )
Mumber of Pieces: j" L Print
r Save
i E-mail
Price:
Code: T j
EPM Mumber: |
Accession Number: |
Lamination: | J
Circulation Rules I
.
= v ]' Location: J
-
™ Masked Delete ‘ Edit ‘ Refresh | Close ‘
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Renewing Items in a Group

Renewing Items in a Group via the Check Out/Renew Window
Select Circulation - Circ Desk > Renew on the Virtua Main Menu, the
Renew i icon, or F6 on the keyboard to open the Renew window.

W Renew - Customer Support Library g@
Patron Renewals l
Infarmation
Fines: e
Requested: ——
Owerdue: e
Billed: e
Last ltem: ————-
Categony Limit: —_—
Renewal Type
{+ Regular " Fixed Time
" In-house " Selected Time: ~— Date:
ltem Barcode ltem Class | Tite | Due DataTime | Type
:< I )
M PRz Item Barcode:
{+ After Each ltem " When Renewals Are Complete
Group Receipt ltems By
{+ Due Date " Patron Barcode
[~ Remember Last Renewal Type
W Skip requested activity and 007 info
Pay ‘ Chuit | |

Enter the item barcode and click Renew.

A message displays:

-,

Virtua 2013.1.1

This item is part of a group. All related items will be renewed. Do you wish to continue?

Click Yes. All items in the group are renewed simultaneously.
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¥ Renew - Headquarters - vtls214 - 0'Connell, Hannah Grace

[il 1!

Patron Renewals |
Patron V5214 | Informaton
::DME: va Fines: 500
ron . Requested: skipped
oz Overdue: 0
Date of Birth: 20100222 cue: .
Home library: Bordeaux o
Home 1701 Kraft Dr, 24060, Blacksburg, VA e
Address: M Category Limit: 2/50
—Renewal Type
{* Reguiar " Fixed Time
" In-house (" Selected Time: | 95243 Av=| Date:  [10/102013 7]
ltem Barcode | ltem Class | Tite | Due DaterTime | Type
31781037828348  Book The essential plays / Anton Chek...  11/7/20139:00.00 AM 1/ 3 Renew - Reguiar

—|v Print Receipts

* pfter Each ltem " When Renewals Are Complete

Item Barcode: I

roup Receipt ltems By

{* Due Date " Patron Barcode

[T Remember Last Renewal Type
¥ Skip requested activity and 007 info

Quit | Erirtt

| Renew I
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Renewing Items in a Group via the Patron Activity Window

To renew group items from the Patron Information window Activity tab,

Checked Out tab highlight the item and click Renew.

=

¥ Patron Information - 0'Connell, Hannah Grace

-

BEX

Card Format | MARC Format Activity |mooun1|
Total Items: 4
Title Barcode Check Cut Date Due Date Checke... | Re... | Reques...
The haunting / by Shir...| 3790 1082013 11:19:58... | 10023/2013 5:00.00... | Headqua...
The essential plays / ... |317810375828348 102013 10:68:5... | 10024/2013 10:58.0... [Headqua. ..
The essential plays / ... |31781037828462 10102013 10:58:5... [10:24/2013 10:58:0... |Headqua. ..
The essential plays / ... |31781037328406 100102013 10:58:5... | 10v24/2013 10:58:0... | Headqua...
Summary Checked Out | F’eming|
Jue Date Bl | Extract To Fie | Check In | Renew | Dispute | Info |
[ Print Receipt Update | Rensw All | Refresh | Close |

A message displays:

Virtua 2013.1.1

-,

This item is part of a group. All related items will be renewed, Do you wish to continue?

Click Yes. All group items are renewed simultaneously.
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Fs

¥ Patron Information - O'Connell, Hannah Grace M
Card Format | MARC Format  Actvity | Account |
Total ltems: 4
Title | Barcode | Check Out Date | Due Date | checke... | Re... | Reques... |
The haunting / by Shir...| 3790 10/9/2013 11:19:58... | 10/23/2013 5:00:00... | Headqua. .
The essential plays /... |31761037828348  [10/0/2013 10:58:5... | 11/7/2013 10:58:00... |Headgua... |10/1...
The essential plays /... |31761037828462  |[10/0/2013 10:58:5... | 11/7/2013 10:58:00... |Headgqua... |10/1...
The essential plays / ... |31761037828405  [10/0/2013 10:58:5... | 11/7/2013 10:58:00... |Headgua... |10/1...
Summary Checked Out | F’enliu|
e Date Eill | Extract To Fie | Checl: In | Renew I Dizpute | It |
™ Print Recsipt Update | Renew Al | Refresh | Close |

When a user tries to renew only one item that is checked out as part of a group a

message displays:

1

¥ Patron Information - O'Connell, Hannah Grace M
Card Format | MARC Format  Activty |A[x:um‘l|
Total Items: 3
Title Barcode Check Out Date Due Date Checke... | Re... | Reques... |
The haunting / by Shir...| 3790 1082013 11:19:58... [10W23/2013 5:00:00... | Headqua...
The essential plays | .. | 31781037026406 | 10/10/2013 10:68:5... |[11/7/2013 10:56:00,.. | Headqua... |10/1...
The essential plays / .. |31781037828462 | 10/10/2013 10:58:5... [ 11/7/2013 10:58:00... |Headqua... [10M...
Summary Checked Out | Pe“i'gl
Jue Date Bill | Ex'tractTuFiel Check In | Renew | Dispute | Info |
™ Print Receipt Update | Renew &l | Refresh | Close |
Error ﬁ

78

renewed. Please see a librarian for assistance.

This item is part of a group and can only be renewed as a set. Mot all items are available for renewal; therefore this item cannot be

Circulation Workflow-Based Reference Guide
*Updated to 16.1

Last Revised: October 2017



79

Check In

Click the Check In icon , press the F4 key on your keyboard, or select
Circulation - Circ Desk > Check In from the Virtua menu bar. The Check In
window will appear.

W Check In - Wilson Library =HEEN X

Activity
Fines: ——
Requested: s
Overdue: e
Billed: e
Blocks: e
Last Item: =

Information

Checdk-n Date: MfA Amnesty Flag: Off

Settings Printing Options

Iv skip fines notification [¥ Print Receipt [v Requested Slip

I¥ Warn if item is not chedked out ¥ In-transit Slip [v Billed material Slip

ap AN == |v¥ Requested In-transit Slip

[ Agency Requested Slip

[ Print Request Wrapper

[ Print Request Wrapper At Any Check In Location

[ Select Time: |10:00

Date:|10/14/2014
[ In‘house usage
[ Suppress patron notes
| Skip requested activity and 007 info

|v Suppress In Transit message

Items

Requested by:
Route to:

L...| Item ... | Due Date/Time Fine Mew Status Loca... | Title

Item Barcode:
| [ cresr |

[ Delete next request

Enter the item barcode and click the Check In button. The item will appear in
the list with a new status.
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Statuses

In Transit status indicates that the item belongs at another location. The item
has to be checked in at its owning location for the status to change to
Available.

In Transit Requested status indicating the item has been requested at a
location different from where the check in has taken place.

On Hold item has been requested at the check in location and is now available
for pick up by the patron.

Shelving status will automatically change to “Available” once the amount of
time set in the Profiler for shelving an item has elapsed.

W Check In - Wilson Library =R X
Patron 456739 »  [TActvity
barcode: S
Name: Documentation 19750112 g| | Fines: $35.33
Preferred en Reguested: i}
Language: Owverdue: [u}
Patron type: Library Board Member Billed: i}
Home library: Garca Research Library -- code: 20000 Blocks: 5
Registering  Garda Research Library — 20000 '
e = | Last Item: Book
Information
Check-in Date: NfA Amnesty Flag: Off
Settings Printing Options
¥ Skip fines notification [¥ Print Receipt [v Requested Slip
v warn ifitem is not chedked out Iv In-transit Slip [v Billed material Slip
I Select Time: |10:00:30 &AM — r3 Reguested In-transit Slip

™ Agency Requested Slip

Date:|10/14/2014
- I Print Request Wrapper
In-hi
AR ETE I~ Print Request Wrapper At Any Check In Location
I Suppress patron notes

I Skip requested activity and 007 info

W Suppress In Transit message

Items
Requested by:
Route to:
L...| Item ... | Due Date/Time Fine MNew Status Loca... | Title
1 24348 5232014 5:00:00 PM  $12.13 Available Gard... ... DTN

Item Barcode:

[ Delete next request
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To access the bibliographic record from the Check In window, highlight the item
and right-click to open the pop-up menu and select Bib Record. Clicking the Bib
Record option will open the View Bibliographic Record window.

'W Check In - Wilson Library |. == 2R |
Patron 456739 " Activity
barcode: S
Name: Documentation 19750112 g| | Fines: $35.33
Preferred en Reguested: 0
Language: Overdue: 1]
Patron type: Library Board Member Billed: ]
Home library: Garcia Research Library - code: 20000 Blocks: &
Registering  Garcia Research Library — 20000 ) "
Library: - Last Item: Boo
Information
Chedk-in Date: MA Amnesty Flag: Off
Settings Printing Options

[v skip fines notification
[v warn if item is not checked out

10:00:30 AM

[ Select Time:

Date: | 10/14/2014
[ In-house usage

[ Suppress patron notes
| Skip requested activity and 007 info

[v Suppress In Transit message

[v Print Receipt
[v In-transit Slip
[+ Requested In-transit Slip
[ Agency Reguested Slip
[ Print Request Wrapper

[v¥ Requested Slip
[v Billed material Slip

[ Print Request Wrapper At Any Chedk In Location

Items
Requested by:
Route to:
Line | Item Barcode | Due Date/Time Fine Mew Status | Location Tite
i 24348 5/23/2014 5:00:00 PM  §1712 Aszil bl Coxcinlan,, L MDYTIN
What's This?

Item Barcode:

S

[ Delete next request

Patron Record
Patron Activity

Patron Account

Item Record

Item Requests

Bib Record

[

[ oean |

The Check In window displays information about the patron activity and account.
This information can be configured in the Profiler > OPAC > Client Views >
Patron Information/Checkout/Renew/Check-in view.
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Check In Window Settings

Skip Fines Notification: You will not receive the message “Patron owes
$nn.nn” in a pop-up window when an overdue item is checked in.

Warn If Item Is Not Checked Out: If the item is not checked out, you will
receive the message “Item is not checked out”. This setting can be overridden
by the Suppress In Transit message setting; see below.

Select Time/Date: Used to back date check-ins.

In-house Usage: Increments the In House Circ Count for each item that you
check in, regardless of check-out type or checked-out status.

Suppress Patron Notes: Specifies whether notes from the patron record are
displayed as items are checked in. When the check box is selected, any note
found in a 5xx field of the patron record will NOT be displayed as an
alert/message during check-in from the Check-in window. The option will not
affect check-ins done from the Patron Information window.

Skip requested activity and 007 info: Specifies whether to suppress the
information from the 007 tag of the patron record and requested information at
the top of the window. This can be useful when checking in items for a patron
with many items checked out.

Suppress In Transit message: Specifies whether to suppress the pop-up
message that appears when a checked-in item’s previous status was In Transit.
Also suppresses the “Item is not checked out” message, even when the Warn if
item is not checked out check box is selected.

Delete Next Request: Specifies whether to delete the next request on the item
being checked in. When this check box is selected, a confirmation message will
appear before the request is selected. This setting can be useful when a patron
decides they no longer want items that have been trapped for their request.

Check In Window Printing Options

Print Receipt: Select this check box to print a receipt for each item checked in.

In-transit Slip: Select this check box to print a slip for each item that needs to
be transported to another location.

Requested Slip: Select this check box to print a slip for each item checked in
that has been trapped by a request.

Billed Material Slip: Select this check box to print a slip for each item checked
in for which a Bill notice has been generated.
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Requested In-transit Slip: Select this check box to print a slip for each
requested item checked in that needs to be routed to another location.

Agency Requested Slip: Select this check box to print a slip for each item
checked in that has been trapped for an agency request.

Print Request Wrapper: Select this check box to print a request book wrapper
for each item checked in that has been requested at the check-in location.

Print Request Wrapper At Any Check In Location: Select this check box to
print a request wrapper for any requested item that is checked in, regardless of
whether the check-in location is the same as the request pickup location.

Check In of Requested Items

When a requested item is checked in, a pop-up message will display to alert staff
that the item has been requested.

-

W Messages - Customer Support Library — l — | (=] |-?3—J1

This item has been requested at current location

Close |

LN 1 L3 e -

If the patron requesting the item is set up to receive e-mail notifications:
Running the Availability Report can generate notices.
OR

In the Profiler >Circulation-> Circulation Basic Options, the library can
enable automatic e-mail notification for available requests, by selecting the
checkbox for the parameter to Send e-mail when requested item is
checked in.

Automatic Reset of the Shelving Location

After an item is checked in and the “At Shelving Location Until” date in the item
record has been reached, Virtua automatically resets the item’s shelving location to
the owning location.

When Virtua resets the shelving location to the owning location at check-in, it sends
a notification to the staff user, and the owning location will be used in determining
whether or not the item needs to be sent in transit.
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For current customers who may not want Virtua to reset the location automatically,
VTLS provides a script that will delete, or make null, the “At Shelving Location
Until” date in all or selected item records.

The script RemoveShelvingDate.ksh can read a list of item barcodes from a file
and removes the items’ “"At Shelving Location Until” date OR can remove the
shelving location date for EVERY item. The script will use as input a file of barcodes
generated from the Shelving Pull List report.

Usage:
RemoveShelvingDate.ksh inputType [< barcodeFile]

where inputType = 0 (default) tells the script to use input from a file and inputType
= 1 tells the script to process all items.

Example:

./RemoveShelvingDate.ksh 0 < barcodeFile (remove shelving location dates using
barcodeFile)

./RemoveShelvingDate.ksh 1 (remove shelving location date for ALL items)

If customers want to retrieve items that are past their “"At Shelving Location Until”
date that haven't been checked out or checked in and are still shelved, customers
will still need to use the Shelving Pull List report to generate the list of items that
need to be pulled from the shelves.
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Accounts Management

Recommended
Workflow Explanation
Adjust Fees Virtua offers the Fine Adjustment Wizard as a quick and

easy way of accepting payments.

View Patron

Account Summary
Use the Fine Adjustment Wizard to manage patron
v accounts
Fine Adjustment Use the payment button to accept a payment
Wizard Move a fine or fee to the disputed tab

Pay Fines for Multiple Patrons in a Session
\ 4

Select Type of Key Terms
Adjustment Alerts and blocks
Audit Trail
v Delete Fees
Print Payment Dispute Fee/Item
Receipt Fines
Dispute Fee/Fine Category
Fine/Fee Grace
Grace Period
Dispute Mail Grace Period
Checkout Processing Fee
Place Ttem on Resolve Fee/Item
Dispute Status Waive Fee/Item

Circulation InfoStation Reports

\ 4

Waive or Patron Account: generates a list of patron account
Reinstate summaries.
Delinquent Patron Accounts: Generates a list of
v fines and fees that are considered to be “delinquent,”
Check In according to the information in the patron account

and criteria that you specify in the report
configuration.

Transition Disputed Items: Allows you to change
items that are at a status of Disputed to a status of
Overdue after a user-defined number of days.
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Circulation Parameters

The Profiler parameters listed below affect the accounts
management process.

Circulation: System Parameters

Fine Code Definitions: Sets codes and definitions for
fines that your library assesses. These display on the
Patron Information Account tab and on reports and bills
sent to patrons.

Circulation: Location + Patron + Item

Fines/Grace: Calculates fines to be paid when a patron
returns or renews an overdue item. Fines can be
calculated differently for requested and non-requested
material.

Circulation: Location + Item

Fines Accrue: Determines if fines accrue during non-
operating hours.

Circulation: System Parameters: Circulation Basic
Options

Prohibit item fine payments at non-assessed
locations: Determines whether patrons are allowed to pay
a fine at a different location from the item's owning
location.
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View Patron Account

Open the Patron Information window by clicking the icon on the
Circulation toolbar and entering the patron barcode or by searching the OPAC
for the patron name or number.

On the Patron Information window, click the Account tab. The summary tab
displays a list of all categories with charges.

-
Card Format | MARC Format | Activity | Account |
Total Payable: § 30.00 Total: $ 30.00
Category Amount
Late Renewal $2.00
Overdue 18.00
Lost tem Replacement Fee £10.00
Summary | Late Renewal] Overdue] Lost tem Replacement Fee
Payment | Adjust |
™ Print Receipt Update | Renew All Refresh | Cloze |

= o

Buttons Displayed on the Patron Account Tab

Payment: Displays Payment window to enter payment amount.

Adjust: Displays Fines Adjustment wizard to add, modify, or resolve a fine or
fee. Note: Virtua does not support very large fines/fees (>$29,000,000.00).

Click on a category tab to see an itemized list of charges for that category.

Select a category or item to adjust. If you do not select a category or item, any
action taken will result in a change to the category or item that is highlighted.

To accept payment or adjust a fee or fine for a whole account, select the
Summary tab.

To accept a payment or adjust a fee/ fine for a fee category, select a category
tab.

To accept payment or adjust a fee/ fine for a specific item within a category,
select the appropriate category tab and then highlight the item.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



88

Accept Payment via the Payment Button

The Payment button on the Accounts tab is a quick method of accepting
payments.

From the Patron Accounts tab, click on Payment. The Account Payment
window will appear.

W Account Payment for:0196100026...

Pay for

f* Account ™ Category f'“

Pay

" Ful amount

{* Partial amount: | CADZ20.00

Amount tendered: | CADZ25.00

[v Print Receipt

oK | Cancel

Select full or partial amount and enter the amount of the payment.

Enter the amount tendered by the patron. (Optional)

Click to place a check in the Print Receipt box if you wish to print a receipt.
If you type a value in the Amount Tendered field, when you click the OK button,

a summary message will appear, displaying details of the transaction, including
the system-calculated “change due to patron”

Account Balance Due: .
Ccap220.00

Amount Tendered:

CcaD25.00

Change Due to Patron:

CcAaD5. 00

Mew Account Balance: "
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Access Fine Adjustment Wizard

Staff can be granted the permission to use the Fine Adjustment Wizard to
accept or adjust fee/fine payments in the Virtua Client. In the Profiler > Global
Settings > System - User Profilers > Permissions > Circulation - Fine
Adjustment wizard, your library can choose to disable the Fine Adjustment
Wizard for individual user profiles or a group of users. Disabling the Fine
Adjustment wizard will have the effect of allowing only supervisory staff to make
adjustments to fines and fees, but will allow student or volunteer workers to
accept payments via the Payment button.

From any tab within the Accounts window, click on the Adjust button. The Fine
Adjustment wizard will appear.

Fine Adjustment for: sam(01

Current Category: Damaged Item

Adjustment Types

= Modify a charge
" Resolve a fee

‘ Next > | Cancel ‘

Select Type of Adjustment
There are four fee adjustment options:

Add new charge
Accept a payment
Modify a charge
Resolve a fee

Add New Charge
Select Add New Charge and click Next. The Adjust/Add window appears.
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Fine Adjustment for: sam01
Current Category: Damaged Item
Adjust: Add

Item Barcode: 0134354

Fee Category: Damaged Item hi
Fee Amount: $ 15.00

< Back ‘ Mext = | Cancel ‘

Enter the item barcode (optional).

Select a Fee Category.

Enter a Fee Amount and click Next. If the adjustment is successful you will see
the window below.

Note: Virtua does not support very large fines/fees (>$29,000,000.00).

Fine Adjustment for: sam01 E]
Current Category: Damaged Item
Adjust: Add

Completed 111

Cancel

Click Finish to return to the Patron Information window.

Accept a Payment
Select Accept Payment. The Adjust: Payment window will appear.
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Fine Adjustment for: sam01 E]

Current Category: Damaged Item
Adjust: Payment

Payment choices
(% For the selected item

" For the selected fee category
('“

<ms [

Cancel |

When the For the whole account option is grayed out the Fine Wizard was not

accessed from the Summary tab. Only the Summary tab allows you to pay on the
whole account.

Select a Payment choice; click Next, and the Payment Method window will
appear.

-

Fine Adjustment for: sam01 E]

Current Category: Damaged Item
Adjust: Payment
For: Ttem: £ 5.00

Payment method
f+ Cash

(" Check

(" Debit Card
(" Credit Card
" Other

< Back

Cancel ‘

Select a Payment method, Click Next. The Fee Amount window will appear.
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Fine Adjustment for: sam(01 E]
Current Category: Damaged Item
Adjust; Payment
For: Item: § 5.00

Item Barcode: 000005548

Fee Category: Damaged Ttem

Fee Amount: | 5.00

Tendered Amaount: | £.00

< Back ‘ Cancel

Enter a Fee Amount and Tendered Amount (optional), and then click Next.
You will get a Completed Message if the transaction is successful.

Fine Adjustment for: sam01
Current Category: Damaged Item
Adjust; Payment
For: Item: § 5.00
Completed 11

| Finish | Cancel

Click to add a check in the Print Receipt box if you wish to print a receipt.

Click Finish.

When an Amount Tendered is entered in the Fine Adjustment/ Fee Amount
window; the Change Calculator window will appear displaying details of the
transaction, including the system-calculated “change due to patron” value.
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7 Messages - Phoenix99 M=)
Item Balance Due: $ 5.00
Amount Tendered: $ 5.00
Amount Paid: $ 1.00
Change Due to Patron: $ 4.00
New Item Balance: $ 4.00

Paying Fines for Multiple Patrons in a Session
The Session feature in the Virtua client lets you start a payment session in which
you can pay fines for multiple patrons in one transaction.

When you renew or check in an item that is overdue, the Session button appears
on the Messages screen.

f Messages - pho0%99 g@w

Fenewal will add late renewal fee: .20

Session Pay Close

When you click the Session button, a Session window appears:
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¥ Renew Session M]
Patron Check-outs
Check-out Type
g Regular
" In-house " Selected Time: 116127 Ahﬂﬁ Date: |1 20 Bf2011 vl
tem Barcode Title | Due DatelTime I Type
9406 The consumer handbaok on dizziness an... 120272011 11:56:00 AWM 176 Fenew - Regular
I Print Peceipts ftem Barcode: I
" After Each ftem % When Checlk-outs fre Complete
[~ Remember Last Check-out Tvpe
Pay Gt | Prirat | Chezl: Gt I
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W Check In Session - Wilson Library - Audiovisuals E]@
Information
Check-in Date: MfA Amnesty Flag: Cff
Setkings Prinking Cptions
-

o [ Print Receipk [ Requested Slip
Iv Warn if item is not checked aut

[ Selack Time: | 110516 a1 — [ In-transit Slip
pate:| 1/10/2011 =] [ Requested In-transit Slip

[ In-house Usage [v Agency Requested Slip
|v Suppress Patron Mokes [ Print Request Wrapper
Ikems

Reguested by:

Route ko
Line | Item Barcode Due Dake) Time Fine Mew Status Loc...
1 1000012200 1)7/2011 ;51:00 ... .40% In Transit Earc,..

Itemn Barcode:

| Pay | | it | |

On the Session window, you can simply check in or renew items from multiple
patrons; there is no need to enter multiple patron barcodes.

When you complete the check-in or renewal session, click the Pay button to open
the Session Payment window.
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7 Session Payment - Virtua Library

Accounts IDocumental:ion I Lucas, Elizabeth |

Total Payable: 19.20$ Total: 19,204
Marne Amount
|Documentation 18.404
Lucas, Elizabeth .80%

IV Print Receipt

Refresh Close

From the Session Payment window, you can click the Payment button from the
Accounts tab to pay fines associated with all of the accounts or you can click on an
individual patron tab to pay fines for a specific patron.

W Pay All Accounts W
{~ Category " Item
Payment Method: I ;I
—Pay
f* Full amaounk
£ Parkial armount: I 00g
Armount tendered: I L00%

[ Print Receipt

I, I Zancel
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Re-printing Patron Receipts

To Re-print a patron receipt: Select Transactions > Reprint Fine Receipt on the
Circulation menu in the Virtua toolbar to reprint the receipt. Only the most recent
receipt is available for reprint.

"W/ Virtua - Wilson Public Library - lafayette70 m|E x|
File Search Patron Information Circulstion Acquisitions Options Tools Window Help

0 @oiv| N 2 A% eol MBE

hD B =E§ Transactions L3 Requests,,,
Default connection: lafaystte?0 - sty Reserves y Loans/Pages...

A R shs ¥
TRy e Audit Trail,..

Transaction Log...

Circ on the fly...
Reprint Fine Receipt *

When a receipt is printed it is also saved as the file fee_receipt.txt in the Virtua
directory on the user’s workstation. The text file will be overwritten the next time a
receipt is printed.

Receipt Numbers on Fine Payment Receipts

Each library location has the ability to generate receipt numbers on fine payment
receipts. The receipt numbers are unique and are incremented for each fine receipt,
starting with a customer-determined value defined in the Next Receipt Number
setting of the Location Names parameter. The Fine Receipt/Slip Setup contains a
Receipt Number label.

Modify a Charge
From the Fine Adjustment window select Modify a charge and click Next.

L= M
Fine Adjustment for: vtls214
Current Category: Overdue
Adjustment Types

" Add new charge
" Accept a payment

(" Resolve a fee

| Mext = | Cancel

Select a Payment Choice and click Next.
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Fine Adjustment for: vtls214 @
Current Category: Qverdue
Adjust: Maodify

Payment choices
{* For the selected item

" For the selected fee category
~

< Back

Cancel

The Fee Amount window appears.

Select a Fee Category and enter a Fee Amount. Click Next.

-

.
Fine Adjustment for: vtls214 @
Current Category: Qverdue
Adjust: Modify
Far: Item: S 5.00

Item Barcode: 31731006351157

Fee Category: |Ouerdue ﬂ

Fee Amount: | 5.00

< Back Cancel

To reduce a fine, enter a minus sign before the amount, (-10.00).
To increase a fine, enter the amount by itself, (10.00).

If the adjustment is successful you will see the completed message window below.

Click Finish to complete the transaction.
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Fine Adjustment for: vtls214

Current Category: Overdue

Adjust: Modify

Far: Item: & 5.00
Completed 111

[~ Print Receipt

Cancel

Resolve a Fee

From the Fine Adjustment window select Resolve a fee. Click Next and the
Payment Choice window appears.

-

Fine Adjustment for: vtls214
Current Category: Summary
Adjust: Resolve

Payment choices
f'“

{* For the selected fee category

" For the whole account

< Back

Cancel

Select a Payment Choice and click Next. The Resolve Options window
appears.
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Fine Adjustment for: vtls214
Current Categary: Sumrmary
Adjust: Resolve
Far: Category: £ 4.10

Resolve options

(* Waive fee

(" Delete fee

< Back |

Cancel

Choose a Resolve option:

Waive: fee/fine is removed from balance due but kept on waive tab for history
Delete: fee/fine is removed from balance due and patron information. To find
the history you must use the audit trail.

Click Next. The Complete Message will appear if the transaction is successful.

Click Finish to return to the Patron Information window.

Dispute Fines/Fees or Items

Disputed fines do not count towards alerts and blocks, and fines do not accrue for
disputed items. The Dispute button is available from any category tab except the
Summary sub-tab on the Account tab of the Patron Information window.

Highlight the item you want to dispute, and click on Dispute button. A
Disputed tab will be created if one does not already exist, and the item will be
moved to that category.

Once a resolution has been found to the disputed item, you may either reinstate
the item to its original fee category, or waive the fee.

From the Account tab of the Patron Information window, click on the
Dispute Tab.
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BEX

W Patron Information - O'Connell, Hannah
Card Format | MARC Format | Activity | ¥
Total Payable: § 2.00 Total:  2.00
Barcode Number | Title | Chedk... | Date Fine A... | Fee A... | Balance
31781006351157 |wiliam Shakespeare's Mu... [1/6/201...[1/6/2011 8:3... |§5.00 [§2.00
YSummary fOverdue jDispute §
Reinstate ‘ Waive | Info
[ Print Receipt Update Renew All ‘ Refresh | Close

Reinstate - moves from dispute category back to original category
Waive - moves from dispute category to the waive category for history

To waive a fee, click the Waive button on the Dispute Tab. A Waive tab will
be created if one does not already exist.

mE] %]

W Patron Information - 0'Connell, Hannah
Card Format | MARC Format | Activity | 3
Total Payable: £ 2.00 Total: § 2.00
Barcode Mumber | Title | Chedk... | Date Fine A... | Fee A... | Balance |
31781006351157 |wiliam Shakespeare's Mu... | 1/6/201...|1/6/20118:3... |§5.00 [$2.00
\Summary AOverdue )Waive f
Delete | Reinstate | Info |
[~ Print Receipt Update Renew All | Refresh | Close |

Click the Delete button to delete a waived fine/fee from the patron’s account.
On the Confirm window, click the Yes button to proceed with the deletion. The
item will be removed from the patron’s record. The history can then only be

accessed through the audit trail.
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-
Confirm
€  Deleting will terminate the link between the item and the patron. Continue?
\_‘

Dispute Checkouts
Checked out items may also be disputed i.e., a patron claims to have returned an
item. A disputed checkout still has a status of Checked Out, but will not count

towards the patron’s checkout limit.
Open the Patron Information window and click the Activity tab.

Click the Checked Out sub-tab located at the bottom of the Activity tab.

W Patron Information - 0'Connell, Hannah E]@
Card Format] MARC Format Activity l Account ]
Total Items: 1
Title Barcode Check Out Date Due Date Check... | R...
The Hollow [ Agatha Christie, 317281049119942 1 12/28/2010 9:39,,, | 1/19/2011 9:39;,... Bellefonte

WSummary AChecked Out ACverdue fPending f

Bill Extract To File Check In | Renew | Dispute | Info ‘

[v Print Receipt Update ‘ Renew All | Refresh ‘ Close |

To move an item to the dispute tab, highlight an item and click the Dispute button.
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W Patron Information - 0'Connell, Hannah E]@
Card Format] MARC Format Activity l.ﬁ.ccauntl
Total Items: 1
Barcode Title Dispute Date
31781043119942 The Hallgw. { Agatha Christis 12292010 9:49:0.....}
WSummary AOverdue APending ADisputed f
Delete | Reinstate ‘ Waive | Info |
[v Print Receipt Update | Renew All | Refresh | Close |

An item on the Disputed tab may be Waived, Reinstated, or Deleted by
highlighting the item and clicking the Waive, Reinstate, or Delete button. This
has the following implications for charging of overdue fines.

If the item is checked in from the Waived tab, the system will not assess

fines.

If a disputed item is returned to Checked Out status, the system will assess
fines based on the due date.

If the item is checked in from the Disputed tab the system will assess fines
based on the due date.

If the item is deleted it is removed the item from the Disputed tab and any
fines or fees associated with the item (including billed fines or fees, if the
item has already been billed) are deleted. In addition, the item’s circulation
status is removed and the item is no longer checked out. Note that the item
should now be checked in so that Virtua can check for requests that the item

might satisfy.

Force Item into Billing

The Bill command button moves the selected item(s) to the Billed category,
bypassing the Overdue/Billing process done in InfoStation. The Bill command
button is available on the following Patron Activity pages:

Disputed
Overdue

Checked Out

Requested
Requested Overdue
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W Patron Information - 0'Connell, Hannah

JoE

Card Format] MARC Format Actvity ]Account]

Total Items: 4
Title Barcode Chedk Qut Date Due Date Chedk... | R...
The Hollow { Agatha Christie, 31781019782604  [1/6/2011 10:07:... |L/6/2011 11:49:... Belefonte |1f6...
Mrs, McGinty's dead / Agatha ... |31781003078571 |1/6/2011 9:05:0... |1/6/2011 11:52:... |Belefonte |1/6...
Witness for the prosecution /... |31781003130760 |1/6/2011 11:44:... |1/6/2011 11;:54:... |Bellefonte
Hamlet [ Willam Shakespeare. 31781019064987  |1/5/2011 11:45:... [1/6/2011 11:55:... |Belefonte
WSummary AChecked Qut APending /Disputed /
Bill Extract To File Check In | Renew ‘ Dispute | Info |
[ Print Receipt Update | Renew Al | Refresh | Close

Highlight the item you wish to place in Billed status.

Click the Bill button.

If the item’s status is Billed For Replacement, the item’s status is set to the
status defined in the Deleted billed for replacement dispute status
parameter configured in the Profiler > Circulation > Circulation Basic

Options > Item Statuses.

Processing Lost/Damaged Items

When a patron loses or damages an item, the Virtua staff can use the Lost or

104

Damaged button on the Activity tab of the Patron Information window to begin
the process for charging the patron for an item based on the original purchase price
for the item, taking into account the purchase date, a rate of depreciation, binding

or lamination costs, and a library-defined surcharge.

Lost and Damaged Buttons

The Lost and Damaged buttons are located on the Activity tab of the Patron
Information window. The buttons are available from the following page tabs of
that window: Checked Out, Overdue, and Disputed.
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W Patron Information

- 0'Connell, Hannah

BE X

Card Formatl MARC Format  Activity lAccount]

Total Items: 2
Title Barcode Check Out Date Due Date Location She... | Rene... | Requested
Timbuktu / Paul Auster, .. |38888168741340 1/123012 12:37:19 PM 2{2{3013 13:37:00 PM Headquarters  |Cliffd... |
The Haiku anthalogy : ... [31781018312791 8382011 13:15: 20 BM 20152012 3:52,00PM ] Headouarters[Hope... [ 1/86720...
summary  Checked Out |Pending ] Pickup I History J Lost ]
Change Due Date | Lost | Damaged | Bill | Extract To File Chedk In | Renew | Dispute | Info |
[ Print Receipt Update | Renew Al | Refresh | Close |

The Process Lost/Damaged Item window is where staff users can declare an
item lost or damaged, and review and edit the below information that impacts
how the replacement fee is calculated.

These fields available for edit:

Original Purchase Price and Currency
Depreciation Rate (Per Year)
Maximum Depreciation

Binding Cost

Lamination Cost

Surcharge

Acquisition Date
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Process Lost/Damaged ltem - phoenix

Ttem Information
Title:

Item Barcode:
Item Class:
Accession Mumber:

Chedk-out DateTime:

Lamination Status:
Exchange Rate:

Qverdue Fines:

Replacement Cost

Qriginal Purchase Price:

Maximurn Depreciation:
Binding Cost:
Lamination Cost:
Surcharge:

Receipt Date:
Surcharge Amount:

Total Replacement Cost:

Criginal Purchase Price Currency

Depredation Rate (Per Year):

The Haiku anthology ; haiku and senryu in English |,

31781018312791

Book

9/29/2011 12:15:20 FM
Mone

1

§10.00

|United States D... USD _+ |

0.00 %o

100.00 %

5.00

5.00

0.00 %o

6/26/2004

Edit Continue

[
£ 10.00

Cancel

The original purchase price and currency on the Process Lost/Damaged Item

106

window are either pulled from the item's invoice or defined on the Acquisitions tab
of the Item Information window.
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Lost/ Damaged Note

Details associated with a lost/damaged item charge have been made available via
the right-click Notes option on the Account tab of the Patron Information
window. The note will provide a breakdown of the individual elements of the total
lost/damaged item charge.

¥ Patron Information - O'Connell, Hannah g@
Card Format | MARC Format | Activity Account |
Total Payable: 5 6.00 Total: 56.00
Barcode Number | T|ﬂ_e | Checked In | Date Fine A... l Fee Amount | Balance | Eh | Iﬁc... | She... |
31781000064665 |The Japanese haiku, its essenti... | R |s6.00 [1lam... [1slam... [1slam...
What's This?
Patron Chedk-Out
Patron Routing
Item Record
Audit Trail
Lost/Damaged MNote
Print
Save
Summary [oet Trem Renlacement Fee | Overdue | Damaged Item Replacement Fee | E-mal
Print Address Label
Adjust | Dispute | Info |
[~ Print Receipt Update Renew Al | Refresh | Close |
Fa -1
. —
W Messages - phoenix g@
Lost/Damaged Motes for Item barcode: 3178 1000064665
Lamination Cost: 5 .00
Binding Cost: § .00
Surcharge: £ 1.00
Deprecated Unit Price: § 5.00
Total Replacement Cost: £ 6.00
Circulation Workflow-Based Reference Guide Last Revised: October 2017
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Profiler Settings for the Lost/ Damaged Workflow

The Lost/Damaged tab is found in the Profiler - Circulation - Location +
Item matrix.

W Arlington Library + Book Matrix B=

De=precation Rats: | 10,00 % Per rear

Maximum Depreciation: | 20.00 9%
Binding Coat: | 2.E08
Laminaticn Cost: | 2,005
Surcharge: | 10.00 %

Apply To | Save | Cancal

Last medified at 11302010 9:07:135 AN by Root User
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System Assigned statuses workflow:

Profiler > Global Settings > Status Displays > Damaged Processing or Lost
Processing.

7 Virtua Profiler @@

File Edit System Options Help

Global Settings IOPACI Cataioging| Circulation Aoquus'mnsl ASR |

- Status Displays A
At Bindery
At Photocopy
Billed For Replacement (Long Overdue)
Bindery Ready
Brad's Agency Req Status
Claim Entered

el  [Damaged Processing]

Deposit kem

in Cataloging

in Transit

' Lost Processing |

Circulation Basic Options for Lost/ Damaged Items

The Circulation Basic Options window contains the settings for defining the item
status of a lost or damaged item that has been paid for.
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= 'I',' ";;;'0""'7".'
Dedete / Wakve Opticns
7 Deiete Outstancing Requests

¥ Delete Specal Status

W Require Actvity Daspute/Waive Notes
V' Alow wihdrawal of checked out tems
Vhen fees are present

Do et alow Rem deleton

" Wane fees

' Keep fees

Reguest Optons
¥ Send e-mail when requested tem is checked n

W Alow renewal of tems with outstanding requests
 Aways
(5 Oaly when at least one avalable tem exists

¥ Upcate request expration date af check-n

¥ Show total requests with request Queue posticn

V Bockings take pricety over satisfied requests

W Aow kbans at requesting location

M Regquest Ciear Notfication

I~ Asow patrons to request Bems they have checked cut

Agency Reguest Priorty
(& Check for agency roquests st
(™ Check for apency requests first

Patron Activty RequestedRecaled tab optons
(" Recals on Recaled tab, no Requested tab
Al res on R b, no Ry a0
(¢ Recals on Recaled tad, others on Requested tab
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tem Opticns
I Resinct check-outs 10 owned tems

I Restirict staf! medated renewals 1o owned ters
™ Do not trap new tems

I™ Disatow new status for checked out tems

™ Prohiot tem fine pay

e R non >
¥ tNo message or fnes at check-out
™ Usa traasaction kecaticn for due date calculations

tem Statvses
¥ Pad for replacement status

iSNhnp

Led

[V Deleted bised for replacement dispute status
’Sh«mg

Le

¥ Not avatable unti sireet date stabus
{Street Date Not Reached

Lej

¥ Agescy request satisfied status
lOn Meld

Led

™ Lost and paid status

{Lost and pais e]_
¥ Damaged and pad status

{Damagec Processing .
Renewal Options

" Use current date for renewals
& Use due date for renewals

Conversion Factor and Alternate Conversion Factor Radio Buttons in

the Currencies Parameter

The Alternate Conversion Factor column allows for configuration of an alternate
set of currency conversion factors. The Alternate Conversion Factor will ONLY be
used by Virtua to calculate the replacement cost of lost items (and the replacement
cost of billed items that are long overdue).

W Currencies s
Code |Conversion |Description Symbol |Decimals|Decimal GroupinﬂLeadinglPositive Negative |Group  |Alternate | A
Factor Separator{Size Zeros |Format |Format  |Separator|Conversion [?|
AED [0.2723 United Arab Emirates, Dirhams s 2 @ 3 No 118|811 3 0.2723 |
aFA |1 | Afghanistan, Afghanis s 2 [ 2 No 115 |-s1.1 l0.123
ALL [0.01 | Albania, Leke s 2 I 3 No  [145 |11 0.01
AMD [9.29 |Armenia, Drams s 2 I 3 No  [145 |s14 |, 0
ANG[0.5581 |Netherlands Antiles, Guiders | 2 . '3 No 115 511 05581 [y
—Schedule/lUnSchedule Conversion
(™ Conversion Factor (+ iAlternate Conversion Factor:
Schedule Updates Unschedule Errors Re-encumber | Save I Cancel |
ILast Modified 11/22/2010 11:07:05 AM by Root User
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The radio buttons for Conversion Factor and Alternate Conversion Factor work
as follows:

— If the Conversion Factor radio button is selected, clicking the Schedule
Updates button or the Unschedule button will let you schedule or unscheduled
updates to the exchange rates in the Conversion Factor column.

— If the Alternate Conversion Factor button is selected, clicking the Schedule
Updates button or the Unschedule button will let you schedule or unscheduled
updates to the Alternate Conversion Factor exchange rates.
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Circulation History

Recommended
Outline

Explanation

Alerts and Blocks

Audit Trail

Circulation
Transaction Log

Virtua provides several ways of tracking circulation
records.

Alerts and Blocks: A system of circulation alerts and
blocks that gives your library flexibility in dealing with
patron delinquencies.

Audit Trail: A log of all financial transactions
recorded by the system. Entries in the log are
organized by transaction groups. For example, the
assessment of a fee, its partial payment, and then its
final payment compose one transaction group.

Transaction Log: The circulation transaction history
of a particular item or patron. The transaction log is
read only, and only authorized users may access it.

Summary

Distinguish between alerts and blocks

Enter Block codes in a patron record

Delete Block codes from a patron record

View patron audit trail

View Item, Patron, and Item/Patron circulation
transaction and audit trail logs

Key Terms

Alert

Block

Audit Trail
Transaction Log

Circulation Parameters
System: Block Codes, Audit Trail Flag

User Permissions: Circulation >Transactions 2>
Transaction Log
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Circulation Parameters

The parameters listed below affect the processes related to
Circulation History.

System Parameters (Circulation tab)

Block Codes: Defines codes used to block circulation
transactions, these codes are added manually to the
043 tag of the patron record.

Circulation Basic Options (Circulation tab)

Audit Trail: Determines whether financial transactions
are logged and searchable by the Audit Trail feature of
the Patron Activity window.

User Permissions (Global Settings tab)

Operational Security tab > Circulation
Permissions 2> Override System Blocks: Determines
if user can override system-assigned blocks.

Circulation tab-> Transaction Log > Transaction
Log Menu: Determines whether circulation transactions
are logged in the transaction log table of the Patron
Activity window (currently cannot be disabled, but
permission to view the transaction log may be
disabled).

InfoStation Reports

Blocked Patrons: Generates a list of patrons who have
one or more blocks (system-generated or manual)
against them.
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Alerts and Blocks

Alert: A message during a circulation transaction that indicates an "alert"

114

condition exists for the patron. An alert condition is typically a delinquency such

as owing a fine for an overdue book.

Block: A message encountered during a circulation transaction that indicates

that a "block" condition exists for the patron. A block condition is more serious

than an alert, for example, the patron account shows an excessive number of

billed items. Blocks can cause the transaction to be canceled.

The Alerts and Blocks Matrix

The Alerts and Blocks Matrix in the Profiler > Circulation > System
Parameters >Alerts & Blocks allows the library to set the threshold at which

Virtua will send an alert or block during a specified transaction such as a check-out,

renewal, or request.

Foculy Block/AlerMaix M|
Alert/Block Owverdue | Requested Overdue | Billed |Reserve Crverdue |Owed Amount |Days Crverdue ‘
Checkout &lert 3 3 1 o 100.00 1
Checkout Block 100 7 3 10 150.00 200
Renewal Alert 4 2 2 3 100.00 1
Renewal Block 100 4 3 o 150.00 20
Hold Alert 15 5] 3 g 30,00 1
Hold Block. 30 15 H] 12 100,00 |
Recall &lert 2 1 0 1 30.00 1
Recall Block 3 2 1 2 30.00 kil
Loan Alert o 4 2 4 40.00 1
Loan Black g 4 4 g &0.00 il
Page &lert 12 9 5 2 30.00 1
Page Block. 15 12 7 4 50.00 il

Cancel
|Last Modified 08/01/2000 25738 PM
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When you enter a patron barcode to begin a check-out, renewal, or request, Virtua
checks this matrix and acts accordingly. For a given transaction:

If the parameter calls for an alert, the Messages window pops-up, displaying a
message about the delinquency.

W Messages - Phoenix01 E]@

Patron owes money

If the parameter calls for a block, the Blocks dialog box appears, displaying the
reason for the block(s). If permissions have been enabled, an Override and
Cancel button appear. If Override is selected, the Checkout/Renew
window appears. If Cancel is selected, the transaction is canceled.

W Blocks M=%

Patron has too many items billed

¢ Qyerride Cancel ‘

Block Code Definitions

Block Code Definitions gives your library the ability to create its own block
codes and define its own blocks. These are set in the Profiler > Circulation >

System Parameters > Block Code Definitions.

Warning: Do not change the numeric block codes that are default settings in
Virtua.

[“ZBlock Code Definitions B P ] 1

Block Code | Block Descrigtion H
Charging privileges denied

Renewsal privileges denied A

03 Recall privileges denied Remave |

04 Hald-placing privileges denied LI

Help I | Save I Cancel |

Lazt Modified 117132002 3:44:21 P
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Add Block Codes to a Patron Record

Once your library has defined its own block codes, you can assign them as needed
by manually inserting them in the 043 tag of the patron record or in the Patron
Editor on the Blocks tab.

Open the patron record in the MARC Editor. If the Editor is in label mode go to
Options > Cataloging Options on the Virtua main menu. Turn off MARC
Labels.

Right mouse click to create a 043 tag if one does not already exist.

iZ] MARC Editor - phoenix . [=1 |
[ [ ] [20000000000000000000000000 |
] 2010 1730r2 10000000" !
Cfes JLI0]  [evistidbiamb
CEE )] [ty we
Cfom JLIL] [ean |
Cfez2 O] [eso
Ol UL [gremee=v:
D D D @ Iresiet Linicode Conirol Characte
LG JLI0] [eadd 1 e cuiep
m o
L] LIL]  [etesdaertes b2
B N P —
0 (] (oo
Dedete Tag shift+Cirl+0
| {P) Address record i H
I MARC 21 Patron: Patn
\OPAC1 / B
Clase fecord N

rw Add Tag - phoenix 1

Tag Indentification:

Enter Tag Mumber:

Enter Tag Indimtorsl

043

—Tag Position:

* Place in sorted order

™ Place after current cursor

o]

Cancel
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Type the first block code for the patron in the 043 field and press enter. The
software will automatically add the delimiter, (e.g. $a).

To add a second block code, type the delimiter followed by the second block code.
Continue in this way until you have manually entered all needed block codes for this

patron.

For example: $a AA $a DG $a OO
Note: Instead of repeating subfield $a, you can create multiple 043 tags.
Save the record to the database.

Delete Block Codes from a Patron Record
Open the patron record in the MARC Editor.

Delete the appropriate subfields from the 043 tag.

Save the record to the database.

Manually Block Patrons Using an 007 Tag Fixed Field

Patron blocks can also be set using the fixed fields in the 007 tag p (Patron Blocks
and Restrictions) is entered as the category of material.

Open the patron record in the MARC Editor

Click in the 007 tag to open the Fixed Field Editor. The Patron Blocks and
Restrictions fields will display.

7 Fixed Field Editor - Phoenix01

Blocks and Restrictions {Patron) 007 Fixed Fields

Chrg Priv Deny: Notblncked - Renw Priv Dery; Im Recl Priv Deny: ’W
H-P Priv Deny: W ILL Priv Deny: Im Card Lost: ’m
Card Stolen: W Maz Itms Chrgd: W Max Itms Odue: ’W
Maxed Renewls: W M Ikm RE Clns: W Max Itms Losk: ’W
Excsv Fines: W Excsv Fees: IW‘ Recall Cvdue: ,WI
Max Ikms Billed: |Mot blocked = Sys Chckout Blk: l—_| Sys Rerv Blk, l—_l
Svs Hold Blk: I—_| &ddress Blk: IW‘ Other Circ Blks: |Mot blocked =
Svs Loan EBlk: I—_| Sys Recl Blk: l—_l Sys Page Elk: l—_l
Inskitution: IW

ol4 | Cancel |
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To set a patron block, select Blocked from the pull-down menu for the block you
wish to set, such as Chrg Priv Deny.

Note: System generated blocks display, but are grayed out and cannot be
changed manually.

How Virtua Displays the Blocks

If blocks are associated with the patron’s account, during an appropriate
transaction Virtua issues a message that displays the block definition.

=0l ]

Patron iz blocked for the following reazon - Address Block ;I

[

Cancel |

For libraries using the 3M Patron SelfCheck Interface: The SelfCheck program
detects when a library card is left in the machine or when a patron tampers with
the machine. The program automatically notifies the Virtua software, which
responds by entering a 1 in the Card Lost fixed field of the 007 tag. In this way,
Virtua blocks any transactions by a person using the lost card illegally or by the
person caught tampering.

Audit Trail

You can access the log of financial transactions by entering any of the following
information:

Patron barcode
Item barcode
Date range

A flag in the Circulation parameters called the Audit Trail Flag controls The Audit
Trail function. The flag is ON by default. When the flag is OFF, the Audit Trail no
longer collects information and the list of financial transactions will become
outdated.
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Access the Audit Trail

On the Virtua menu, click Circulation - Transactions - Audit Trail. The
Audit Trail window appears.

W Audit Trail - venus88 E]@

Search Criteria lResuHE ]

‘fou may search using one or more of the following criteria:

Item Barcode: Filters
| |v Use Dates/Time:

Patron Barcode: L

| [11/142011 |

To:
Transaction Reference Mumber:

| |11/16/2011 |

Receipt Number: [~ Filter by Location

= A
| Chamo - Internet (*000010000)
TPU
Hong Kong Central (*1000000)
Hong Kong Central - bookdrop (1000001)
To be deleted (2)
City Hall (301000000}
City Hall - bookdrop {301000010)
To be deleted
Kowloon (302000000)
To be deleted (3)
Kowloon - bookdrop (302000002)
To be deleted (4)
Sha Tin (303000000)
Sha Tin - bookdrop (303000001)
Tsuen Wan (304000000)
Tsuen Wan - bookdrop (304000001)

Tiiam Mon FROEANAOAAY

Search Close

The Audit Trail window has two tabs: Search Criteria and Results.

The Search Criteria tab lets you enter search criteria such as a specific patron
barcode, item barcode, transaction reference number, receipt number, or any
combination of these. In addition, you can limit the list of transactions to a specific
date range, or filter the list of transactions by location.

Click the Search button or press ENTER. The results of the search will appear on
the Results tab.

You can change your search criteria at any time by clicking on the Search Criteria
tab.

Search on any or all of the fields listed in the left hand side of the window.
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If you search by patron barcode, Virtua displays all fee transactions for that

patron.
If you search by patron barcode AND item barcode, Virtua displays the fee

transactions for that patron and that specific item.
If you search by item barcode, Virtua displays all fee transactions for that item
and the barcodes of all patrons associated with the transactions.

Enter a date range to limit your search results by date.

Click the Search button or press ENTER. The results of the search will appear
on the Results tab.

The Results tab displays the list of account transactions that corresponds to your
search parameters. The list is sorted: 1) by transaction groups in ascending date
order, and 2) within a transaction group by date and time.

W Audit Trail - venus88

M=%

Search Criteria Results ]

Use Dates/Time: From: 11/14/2011 12:00:00 AM To: 11/16/2011 12:00:00 AM

Patron | Type | Fee | Date/Time Amount | Balance | Payment Method | Item Barcode | Assessment ID
wtls0215 Delete - Reguest Placed HK$9.00 11/14/2011 10:21:1...  -HKSS9.00 HK$0.00 10060000607854 1858 :
vis0406 Delete - Request Placed HK$1.00 11/14/2011 10:21:3...  -HKS1.00 HK$0.00 10000000003704 1859
11152008123450 Payment - Overdue HK5130,00 11/15/2011 1:36:49 .., -HKS130.00 HKS0.00 Cash 33888000200380 1862
11182008123450 Assessment - Overdue HK$130.00 11/14/20119:30:30 ... HKS130.00 HK$130.00 385888000200330 1862
100 Assessment - Late Renewal HKs0. 10 11/14/2011 9:40:12 ... HKS0.10 HKs0.10 33333000200330 1883
100 Assessment - Late Renewal HKS0. 10 11/14/20119:40:13 ... HKSD.10 HK$0.10 335388000200323 1564
vis0215 Payment - Overdue HK$10.00 11/14/2011 3:22:44 ...  -HK$10.00 HK$0.00 Cash 10000000000511 1566
vil=0215 Aszgessment - Overdue HKS$10.00 11/14/2011 10:37:2...  HKS10.00 HK.$10.00 10000000000511 1866
vis0215 Payment - Lost Item Replacem...  HKS0.01 11/14/2011 3:22:44 ... -HKS0.01 HK$0.00 Cash 10000000000511 1867
vis0215 Assessment - Lost Item Replac...  HKS0.01 11/14/2011 10:37:2...  HKSD.01 HKS0.01 10000000000511 1867
vils0215 Payment - Request Placed HKS5.00 11/16/2011 10:25:3...  -HKS3.00 HKS0.00 10000000000511 1868
vis0215 Assessment - Request Placed HK$9.00 11/14/2011 4:03:14 ... HKSS.00 HK$5.00 10000000000511 1563
vils0215 Payment - Request Trapped HKsS2.50 11/15/2011 10:25:3...  -HKS2.50 HKs0.00 10000000000511 1869
vis0215 Assessment - Request Trapped HK$2.50 11/14/2011 4:21:09 ... HKS2.50 HK$2.50 10000000000511 1569
vils529 Payment - Request Placed HK$295.00 11162011 11:43:5...  -HKS999.00  HKS0.00 Cash 754 1870
vtls529 Assessment - Request Placed HK&293.00 11/15/2011 11:43:3...  HKS939.00 HK$395.00 754 1870
4321 Assessment - Late Renewal HK$10.00 11/15/2011 12:47:0...  HKS10.00 HK$10.00 00000000000033 1571
11182008123450 Payment - Request Trapped HK$2.50 11/15/2011 2:05:05 ... -HKS2.50 HK$0.00 Cash 33888000200323 1572
11152008123450 Assessment - Request Trapped HKs2.50 11/15/2011 2:04:28 ... HKS2.50 HKS2.50 33888000200323 1872
11182008123450 Payment - Request Trapped HK$2.50 11/15/2011 2:23:31 ... -HKS2.50 HK$0.00 Cash 38888000200372 1875
11182008123450 Assessment - Request Trapped HKsS2.50 11/15/2011 2:23:23 ... HKS2.50 HKS2.50 33833000200372 1875
101 Assessment - Overdue HKS30.00 11/15/2011 2:26:46 ... HKS30.00 HK$30.00 101 1573
vis0215 Payment - Request Picked Up HKS0.01 11/16/2011 10:25:3...  -HKS0.01 HK$0.00 10000000000511 1583
vile0215 Asgessment - Request Picked Up  HKSD0.01 11/16/2011 10:24:2...  HKS0.01 HKS0.01 10000000000511 1883
vis0215 Delete - Request Placed HK£999.00 11/16/2011 10:57:0...  -HK$993.00  HKS0.00 10000000005915 1584
vils0215 Assessment - Request Placed HK£999.00 11/16/2011 10:42:4...  HKS999.00 HK$995.00 10000000005915 1584

Each fee occurrence has a unique transaction number for audit purposes. This
means that if the same item number is associated with a fee for the same patron
more than once, you can associate and track payments to a specific fee. In
addition, the Audit Trail logs the date, hour, minute, and second that the fine is
assessed or the transaction processed.
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Audit Trail records are grouped by the unique transaction number and sorted by

time and date in reverse chronological order. This allows for a sequentially view of
the history of a transaction from assessment through final resolution. By clicking

on any of the tabs you can alter the sorting of the log. For example a click on the
Date/Time tab rearranges the sorting of the items by ascending or descending

date/time.
Fatron Type | Fee | Date/Time Amount Balance Payment Method | Ttem Barcode nt ID
11152008123450 Assessment - Overdue HKS130.00 11/14/20119:30:30 ... HK$130.00 HK$130.00 38388000200380 1862
100 Assessment - Late Renewal HKS0, 10 11/14/20119:40:12 ...  HKSD.10 HKS0, 10 38883000200380 1863
100 Assessment - Late Renewal HES0, 10 11/14/2011 9:40:13 ...  HKS0.10 HES0, 10 33383000200323 1864
vis0215 Delete - Request Placed HKES.00 11/14/2011 10:21: L., -HK$9.00 HKS0.00 10000000007854 1858
vils0406 Delete - Request Placed HKS1.00 11/14/2011 10: HK$1.00 HK$0.00 10000000008704 1858
vis0215 Assessment - Overdue HKE10.00 11142011 10: HKE10.00 HKS10.00 10000000000511 1866
vils0215 Assessment - Lost Item Replac,..  HKSD.01 11/14/2011 10: ... HKS0.01 HKS$0.01 10000000000511 1367
vis0215 Payment - Overdue HKs10.00 11142011 3:22:44 ...  -HK$10.00 HKS0.00 Cash 10000000000511 1866
vils0215 Payment - Lost Item Replacem...  HKS0.01 11/14/2011 3:22:44... HKS0.01 HK$0.00 Cash 10000000000511 1367
vis0215 Assessment - Request Placed HKs8.00 11/14/2011 4:03:14...  HK$8.00 HKS3.00 10000000000511 1868
wis0215 Assessment - Request Trapped HKs2.50 11/14/2011 4:21:09 ... HKS2.50 HKs2,50 10000000000511 1369
vis529 Assessment - Request Placed HK$959.00 1: ... HKS599.00 HK$995,00 754 1870
4321 Assessment - Late Renewal HK$10.00 ... HKS10.00 HK$10.00 00000000000083 1871
11182008123450 Payment - Overdue HE$130.00 11/15/2011 1:35:49 ... -HK$130.00  HK$0.00 Cash 333830002003680 1862
11182008123450 Assessment - Request Trapped HKS2.50 1115/2011 2:04:28 ... HKS2.50 HKS2,50 38888000200323 1872
11182008123450 Payment - Request Trapped HKS2.50 11/15/2011 2:05:05 ... -HK$2.50 HK$0.00 Cash 33888000200323 1872
11182008123450 Assessment - Request Trapped HKS2.50 11/15/2011 2:23:23 ... HKS2.50 HKS2,50 38888000200372 1878
11182008123450 Payment - Request Trapped HKS$2.50 11/15/2011 2:23:31... -HKS$2.50 HK$0.00 Cash 38888000200372 1878
101 Assessment - Overdue HKS30.00 11/15/2011 2:26:46 ...  HK$30.00 HKS30.00 101 1873
vils0215 Assessment - Request Picked Up ~ HKS0.01 11/16/2011 10: ... HKSD.01 HK$0.01 10000000000511 1383
vis0215 Payment - Request Placed HKs8.00 11162011 10: -HK$9.00 HKS0.00 10000000000511 1868
vis0215 Payment - Request Trapped HKS2.50 11162011 10: -HK§2.50 HK$0.00 10000000000511 1389
vilsD215 Payment - Request Picked Up HES0.01 11/16/2011 10: HK$0.01 HES0.00 10000000000511 1383
vis0215 Assessment - Request Placed HK$299.00 11162011 10: HK$299.00 HK$929,00 10000000005516 1384
vils0215 Delete - Request Placed HK$999.00 11/16/2011 10: ... HK$999.00 HKS0.00 1000000000516 1384
wils529 Payment - Request Placed HK$999.00 11/16/2011 11:43:5...  -HK$999.00  HKS0.00 Cash 754 1870
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To access related information about a specific item highlight the desired line item,
notice that more information about the transaction is displayed in the gray area at
the bottom of the Audit Trail. A right click on the mouse will bring up the pop-up

menu to gain further information access.

W Audit Trail - venus88 =Jo&d
Search Criteria  Reslts I
Use Dates/Time: From: 11f14/2011 12:00:00 AM To: 1116/2011 12:00:00 AM
Patron ‘ Type | Fee | Date,Time ‘ Amount ‘ Balance ‘ Payment Method | Item Barcode | Assessment ID
viis529 Payment - Request Placed HK5999.00 1116/2011 11 7 tremenstes  HKS0.00 Cash 754 1870 |
viis0215 Delete - Request Placed HK$399.00 11f16f2011 1q  What's This? HICS0.00 10000000005916 1884
vils0215 Assessment - Request Placed HK£995.00 11/16/2011 10 Patron Record HK$599.00 10000000005916 1834
vils0215 Payment - Request Placed HKg9.00 11/16/2011 10 HKg0.00 10000000000511 1868
vtis0215 Payment - Request Trapped HKS2.50 11f16/2011 1]  Patron Activity HK$0.00 10000000000511 1869
wis0215 Payment - Request Picked Up HKS0.01 11f16f2011 10  Patron Account HK$0.00 10000000000511 1883
vils0215 Assessment - Request Picked Up  HK$0.01 11/16/2011 10 HKs0.01 10000000000511 1883
101 Assessment - Overdue HK£30.00 11/15/20112;  ItemRecord HK$30.00 101 1878
11182008123450 Payment - Request Trapped HKs2.50 11f15/2011 2: . HKg0.00 Cash 38888000200372 1876
11182008123450 Assessment - Request Trapped HKS2.50 11f15/2011 2: Print... HKS2.50 38888000200372 1876
11182008123450 Payment - Request Trapped HK$2.50 11f15/20112; Save... HKs0.00 Cash 38838000200323 1872
11182008123450 Assessment - Request Trapped HKS2.50 11/15/2011 2: E-mail... HK$2.50 33388000200323 1872
11132008123450 Payment - Overdue HK$130.00 115/2011 11 gape as CSy HKS0.00 Cash 33333000200330 1862
4321 Assessment - Late Renewal HK£10.00 11f15/2011 12 e | HK$10. 00 00000000000083 1871
vis529 Assessment - Request Placed HKS999.00 11f15/2011 11:43:3...  HK$999.00 HK$999.00 754 1870
vHs0215 Assessment - Request Trapped HKs2.50 11/14/2011 4:21:09 ... HKS2.50 HKs2.50 10000000000511 1869
vils0215 Assessment - Request Placed HKs5.00 11/14/2011 4:03:14... HK$5.00 HK$3.00 10000000000511 1868
vils0215 Payment - Overdue HK£10.00 11/14/2011 3:22:44 ... -HK$10.00 HKs0.00 Cash 10000000000511 1866
vils0215 Payment - Lost Item Replacem...,  HK$D.01 11/14/2011 3:22:44 .., -HK$0.01 HKg0.00 Cash 10000000000511 1867
vils0215 Assessment - Overdue HKS10.00 11/14/2011 10:37:2...  HK$10.00 HK$10.00 10000000000511 1866
vils0215 Assessment - Lost Item Replac...  HKS0.01 11/14/2011 10:37: HKs0.01 HKs0.01 10000000000511 1867
vils0406 Delete - Request Placed HKs1.00 11/14/2011 10:21: HK$1.00 HKs0.00 10000000008704 1859
vilsD215 Delete - Request Placed HK9.00 11/14/2011 10:21:1...  -HK$2.00 HKg0.00 10000000007854 1858
100 Assessment - Late Renewal HKs0. 10 11/14/2011 9:40:13 ...  HK$0.10 HKe0. 10 38888000200323 1864
Assessment - Late Renewal HKS0. 10 11/14/20119:40:12... HKS0.10 HKS0.10 38888000200380 1863
11182008123450 Assessment - Overdue HK5130.00 11/14/2011 9:30:30 ...  HK$130.00 HK$130.00 33388000200330 1862
Operator: User, Staff
Location: Hong Kong Central (*1000000)
Receipt Number: HKC309
Transaction Reference Num: 35268
System Generated: No
Machine Name: oconnelle.vtls.com

Select Patron Record, Patron Activity, or Patron Account to view additional
information about the patron associated with this transaction or select Item
Record to view information about the item associated with this transaction.

Note: The Audit Trail shows the username instead of the internal user ID for the
Operator field.

Audit Trail Notes

When an entry has an account adjustment note or a lost/damaged note it is
identified by an asterisk (*). To view a note stored in the Transaction Log,
highlight the row, right-click, and select Display Note.
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7 Audit Trail - venus88 (=
Search Criteria  Results
Patron Barcode: 38888168741456
Patron | Type | Eee | Date/Time | Amount | Balance | Payment Method | Item Barcode Assessmer
33838168741456 Payment - Overdue HKS70.00 12j6/2011 12:38:21... -HKE70.00 HKS0.00 Cash 2011012801 1960
33888168741456 Assessment - Overdue HKS70.00 12/1f2011 11:55:12 .., HKS70.00 HK$70.00 2011012801 1960
33833168741456 Payment - Lost Item Replacem...  HK$103.96 12/2/2011 11:13:45 ... -HK$103.96  HKS0.00 Cash 10000000008787 1963
38888168741456 Assessment - Lost [tem Replac...  HKS103.96 12/1/2011 12:26:38 ... HKS103.96 HK$103.96 10000000008737 1963
38888168741456 Payment - Lost Item Replacem...  HK$103.96 12/2/2011 11:46:45 ... -HKS103.96  HKS$0.00 Cash 10000000008737 1967
33833168741458 Aszessment - Lost [tem Replac...  HK$103.96 12/2/2011 11:26:32 ... HKS103.96 HK$103.96 10000000008787 1987
33888168741456 Delete - Request Placed HKS1.00 12/2/2011 12:34:47 ...  HKS1.00 HKS0.00 38888168740797 1968
33833 168741456 Assessment - Request Placed HKS1.00 12/22011 12:34:33 ... HKS1.00 HK$1.00 38868168740737 1963
38888168741456 Delete - Request Placed HKs1.00 12/3/20118:34:21 AM  -HKS1.00 Hk$0.00 358858168740797 1969
38888168741456 Assessment - Request Placed HKS1.00 12/2j2011 12:46:39 ... HKS1.00 Hk$1.00 35888168740797 1969
33833168741458 Delete - Reguest Placed HKE1.00 12/5/2011 12:03:32... -HKS1.00 HKS0.00 383831658740797 1970
33888168741456 Assessment - Request Placed HKS1.00 12/3/20118:37:26 AM  HKS1.00 HK$1.00 38888168740797 1570
33833 168741456 Delete - Overdue * HKS57.00 -HK$58.00 HK$0.00 36883 163740789 2112
16874145 Modify - Gverdie “HiKgE7. 60 AR AR R LR G HiKg58.00 3daaaTagv4078Y i3
33888168741456 Assessment - Overdue HKS57.00 1/27, What's This? 57.00  HKS57.00 33888168740789 2112
Display Note
Patron Record
[L] Patron Activity [l]
Operator: User, Staff Patron Account
Location: Hong Kong Central (*1000000)
Transaction Reference Num: 59297 Item Record
System Generated: Mo .
Account Adjustment Mote: Patron previously returned item, Print...
Machine Name: oconnelle.vils.com Save...
E-mail...
Save As C5V

Clicking the option will display the note in an Information window. Notes are
displayed in full.

= =y

Information

\l) Patron previously returned item.
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Saving Audit Trail Information

Audit Trail information may be saved in .csv (comma-separated value) format via
the right-click menu.

W Audit Trail - venus88 E]@

Search Criteria  Results

Patron Barcode: viis214

Patron | Type Fee | Date/Time ‘ Amount | Balance | Pa... | Item Barcode Assessment ID
vils214 Dispute - Request Placed £9.00 8/13f2011%:01:27 AM  ($9.00) s.00 44444449444440 878
vis214 Assessment - Request Placed £9.00 8/13/20115:59:30 AM  $9.00 $9.00 HH0 878
vis214 Payment - Request Canceled §2.50 8/13/20119:02:29 AM  (52.50) 5.00 HHEE 879
wis214 Assessment - Request Canceled §2.50 8/13/20119:01:27 AM  §2.50 52.50 HHH0 879
vis214 Payment - Request Canceled §2.50 8/13/20119:02:29 AM  (82.50) s.00 mbha787 880
vils214 Assessment - Request Canceled 52,50 8/13/20119:01:35 AM 2,50 $2.50 mbha787 880
vils214 Payment - Architecture §2,000.00 11/17/2011 11:11:5...  (82,000.00) &.00 Cash 1860
vils214 Assessment - Architecture * §2,000.00 11/10/2011 11:3%:5...  $2,000.00 £2,000.00 1860
vis214 Assessment - Request Placed $399.00 11/17/2011 12:23:1...  $999.00 $999.00 2010082012 1888

What's This?

Print...

Save...

E-mail...

Save As C5V

The .csv file may be viewed in a text editor, for example, Notepad.

o test - Notepad [:][:]Eii

File Edit Format View Help

Patron,Item,Type,Fee,Date,Amount,BaWance,oEerator,Receipt,system,Pa
vt1s5214,44444444444440, Dispute - Request Placed, $9.00,8,/13/2011, ($¢
vE15214,44444444444440, Assessment - Reguest Placed, $9.00,8/13/2011,
vE15214,44444444444440, Payment - Request Canceled, $2.50,8/13/2011, {
vi1s5214,44444444444440, Assessment - Reguest Canceled, $2.50,8/13/201
vt1s214,mbh8787, Payment - Request Canceled, $2.50,8/13,/2011, (%2.50),
vt1s214, mbh8787,Assessment - Request Canceled, $2.50,8,/13,/2011, $2. 5C
vt1s214,,Payment - Architecture,"$%2,000.00",11,/17/2011, "(%2,000.00)
vt1s5214, ,Assessment - Architecture,”$2,000.00",11,/10,/2011, "$2,000.C
vt1s214, 2010082012, Assessment - Request Placed, $999.00,11,/17,/2011, 9

[(] 1il [)]
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Circulation Transaction Log

Retrieve the Transaction Log

On the Virtua menu bar, click Circulation > Transactions > Transaction
Log. The Transaction Log window appears.

W Transaction Log - venus88 E]@

Search Criteria lResuIiE ]

‘You may search using one or more of the following criteria:

Item Barcode: Filters
| " Use Dates/Time:

From:
Patron Barcode: =

To:
Transaction Reference Number: |

[ Filter by Location

= -
Chamo - Internet {*000010000)
TPU
Hong Kong Central (*1000000)
Hong Kong Central - bookdrop (1000001)
To be deleted (2)
City Hall (*301000000)
City Hall - bookdrop (301000010}
To be deleted
Kowloon {302000000)
To be deleted (3)
Kowloon - bookdrop {302000002)
To be deleted (4)
Sha Tin (303000000)
Sha Tin - bookdrop (303000001)
Tsuen Wan (304000000)
Tsuen Wan - bookdrop (304000001)

Tiram W F20EANANAATY

I Show Denied Transactions

™ Patron Initiated (Renewals Only)

Search ‘ Close |

The Transaction Log window has two tabs: Search Criteria and Results.

The Search Criteria tab lets you enter search criteria such as a specific patron,
item, transaction reference number, receipt humber, or any combination of these.
In addition, you can limit the list of transactions to a specific date range, or filter
the list of transactions by location.

Search on any or all the fields listed in the left-hand side of the window.

If you search by item barcode, Virtua displays all transactions for that item and
the barcodes of all patrons associated with the transactions.

If you search by patron barcode, Virtua displays all transactions for that patron.

If you search by patron barcode AND item barcode, Virtua displays the

transactions for only that patron and that specific item.
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To limit your search results, specify a date range. Results of the transaction log are
sorted by time to the second and by date in reverse chronological order.

Click the Search button or press ENTER. The transactions that meet your
criteria appear in the list box on the Results tab of the Transaction Log

window.

The Results tab displays the list of account transactions that corresponds to your
search parameters. The list is sorted: 1) by transaction groups in descending date
and time order, and 2) within a transaction group by date and time. Note that
Virtua limits search results to the first 1,000 entries returned for your search

criteria.

W Transaction Log - venus88

M=% ]

Search Criteria  Results

Patron Barcode: wHs529 AND Use Dates/Time: From: 10/17/2011 12:00:00 AM To: 11/17/2011 12:00:00 AM

Date/Time | Transaction | Patron Barcode Location | Item Barcode

11/16/2011 10:57:03 AM Add Request witls529 Hong Kong Central (*1000000) 2010082114

11/15/2011 11:43:32 AM Add Request vHs529 Hong Kong Central (*1000000) 754

11/15/2011 11:11:40 AM Delete Request wHs529 Chamo - Internet (0000 10000) 62626262626606

11f15/2011 11:04:07 AM Add Request vils529 Chamo - Internet (*000010000) 52626262626606

11/15/2011 11:01:23 AM Regular Check-in wHs529 Hong Kong Central (*1000000) 2nd1

11/15/2011 11:00: 18 AM Regular Check-n vHs529 Hong Kong Central (*1000000) 62626262626606

11/14/2011 11:38:56 AM Delete Request wHs529 Hong Kong Central (*1000000)

11/14/2011 10:34:53 AM Add Request vHs529 Hong Kong Central (*1000000)

10/28/2011 10:15:17 AM Regular Check-in wHs529 Hong Kong Central (*1000000) 2nd2

10/28/2011 9:47:33 AM Regular CkOut vHs529 Hong Kong Central (*1000000) 2nd2

10/28/2011 9:47:32 AM Regular CkOut wHs529 Hong Kong Central (*1000000) 2nd1

10/28/2011 9:47:32 AM Regular CkOut vHs529 Hong Kong Central (*1000000) 62626262626606

BibId 41795 had
CallNumber [Fic] [Tl
Username: User, Staff

Reserve Ttem: NO

Patron Class: Adult Patron

Transaction Location: Hong Kong Central (*1000000)

Transaction Reference Num: 35261

Expire Date/Time: 11/15/2012 10:57:03 AM

Request Date/Time: 11{16/2011 10:57:03 AM

Pickup Location: Hong Kong Central (*1000000)

Request Location: Heng Keng Central (*1000000) I
RequesiType Loan ]

By highlighting a line item in the list box, additional information about that
transaction appears in the text area below the list box. Click the right mouse

button to see the options for viewing patron and item information.
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¥ Transaction Log - venus88 E]@
Search Criteria Reslts
Patron Barcode: vils529 AND Use Dates/Time: From: 10/17/2011 12:00:00 AM To: 11/17/2011 12:00:00 AM
Date/Time | Transaction | Patron Barcode Location | Item Barcode
1171672011 10:57:05 AN Add Rlequest vtis539 Hong Kong Cenfral (*1060000) 720 . "
11/15/2011 11:43:32 AM Add Request vis529 Hong Kong Central (*1000000) 74 i
11/15/2011 11:11:40 AM Delete Request =529 Chamo - Internet (*000010000) 81 patronRecord
11/15/2011 11:04:07 AM Add Reguest vils529 Chamo - Internet {*0000 10000) ¥ i
11/15/2011 11:01:23 AM Regular Check-n vils529 Hong Kong Central (*1000000) »f Patron Activity
11/15/2011 11:00:18 AM Regular Checkn viis529 Hong Kong Central (*1000000) gy Patron Account
11/14/2011 11:38:56 AM Delete Request vis529 Hong Kong Central (*1000000)
11/14/2011 10:34:53 AM Add Request viis529 Hong Kong Central (*1000000) Ttem Record
10/28/2011 10:15:17 AM Regular Check-in wils529 Hong Kong Central (*1000000) 2z ItemRequests
10/28/2011 9:47:33 AM Regular CkOut =529 Hong Kong Central (*1000000) 2r] .
10/28/2011 9:47:32 AM Regular CkOut wils529 Hong Kong Central (*1000000) Print..
10/28/2011 9:47:32 AM Regular CkOut wis529 Hong Kong Central (*1000000) 6] Save...
E-mail..
Save As C5V
BibId 41795 il
CallNumber [Fic] [
Username: User, Staff
Reserve Ttem: NO
Patron Class: Adult Patron
Transaction Location: Hong Kong Central (*1000000)
Transaction Reference Num: 35261
Expire Date/Time: 11/15/2012 10:57:03 AM
Request Date/Time: 11/16/2011 10:57:03 AM
Pickup Location: Hong Kong Central {*1000000)
Request Location: Hong Kong Central (*1000000)
RequestType Loan |

Select Patron Record, Patron Activity, or Patron Account to view additional

information about the patron associated with this transaction or select Item

127

Record or Item Request to view information about the item associated with this

transaction.

The Information Detail area of the Circulation Transaction Log displays a number

of new fields:

e Override - Indicates by a Yes or No if the transaction is an override of a

patron block check-out, renewal or request.

¢ Authorized by - Username of the staff that authorized/performed the
override (only appears if Override field contains Yes).

e Username - Username of the staff member logged in at the time of the

transaction.

e Fee Exempt - Indicates if an item is exempt from fees associated with the

request.
¢ New Status - The item status change after a check-in.

e Barcode Type - The type of barcode that was used for a check-out or
renewal.
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J Transaction Log - venus88 =Jokd
Search Criteria  Results |
Use Dates/Time: From: 10/17/2011 12:00:00 AM Ta: 13/17/2011 12:00:00 AM
[ Transacton | patron Barcece [ Lecatn
Improper Check-n visss Horg Kong Central (
Reguar CkDut vis214
Reguler CkDut visSas
Adc Regquest 19851122
Add Request 15661122 Horg Kong Central (
Delete Regquest 104 Chamo - Internet (X
AddRequest ¢ Chewo_lIntenet (X
Chedkan vis0215 Hong Kong Ce

Lost Processng vis0215 Horg Kong Centrsl ( 0200005936
Reguiar CkDut vis021S Hong Kong Central ( 100000000052 36
Dedete Rag st vin0215
Reguiar ChkDut 113520068 123450 38838000200372
Dedete Requmst k2003
Dejete Reguest ko005
Add Request vis0215
Regular CkDut vis0512 08704
Delete Regaest vis0215 05935
Add Regquest vissS9
Add Reguest vis0215 05935
Reguler Checkn vis0215 1000 00511
Reguier CeDut vEis0215 1000000000053
Deled= Reguest vis0719
Regulr Chackan 100 930
Reguiar CkOut 100 950
Reguiar CkOut 100 952
Regular ChkOut 100 Mong Kong Centr 51
Reguiar Checkan 103 Hong Kong Central ( 101 v
Uszr, Staff
NO
Adult Patron
Hong Kang Central {*1000000)
sz
11/23/2011 5:05:00 PM
VG011 1: 442 M
Hong Kong Central {*100000C)
Hong Kong Central {*1000000)
Jdunior Lending Cassettes
CFf
e ¥,

The Circulation Transaction Log is updated each time a patron record is updated
via the Patron Account Statement report or via the Overdues report when the
Include Patron Account Info setting is enabled.

Transaction Log Related Ad Hoc Views

In conjunction with the addition of data elements to the Transaction Log, the
following fields have been added to the following Ad Hoc views:

CIRC_CHECKOUT_LOG_V
CIRC_RENEWAL_LOG_V

CIRC_REQUEST_LOG_V.
These fields allow the library to generate reports of:

1) Patron block overrides performed by staff at a particular workstation for check-
outs, renewals and requests.

2) Document type usage, specifically for the MASC card and the library card.

3) Changes to item status, in particular changes related to “transit” check-ins,
which may assign the status In Transit or In Transit-Requested.
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Transaction Log Notes

To view a note stored in the Transaction Log, highlight the row, right-click, and

select Display Note.

W Transaction Log - venus88

=Bk

Search Criteria  Results

Patron Barcode: 38388168741456

DateTime | Transaction Patron Barcode Location | Item Barcode ”/‘l
12/2/2011 11:46:45 AM Biled and Paid Delete 383B2163741456 Hong Kong Central (*1000000) 10000000008787
12/2/2011 11:26:32 AM Lost Processing 383B8163741456 Heng Kong Central {*1000000) 10000000001238
1222011 11: Lost Processing 383B8168741456 Hong Kong Central {*1000000) 10000000008787
12/2/2011 Lost Secondary Item Removed 38388168741456 Hong Kong Central (*1000000) 10000000001238
12/2/2011 Regular CkOut 38388163741456 Hong Kong Central (*1000000) 10000000008787
12f2f2011 Regular CkOut 38383168741456 Hong Kong Central (*1000000) 10000000001238
12/2f2011 Biled and Paid Delete 38888168741456 Hong Kong Central (*1000000) 10000000008787
12f1/2011 Lost Processing 38888168741456 Hong Kong Central {*1000000) 10000000001238
12f1/2011 Lost Processing 38588168741456 Hong Kong Central {*1000000) 10000000005787
12f1/2011 Lost Secondary Item Removed 383B8163741456 Hong Kong Central {*1000000) 10000000001238
12/1j2011 Regular CkOut 383B2163741456 Hong Kong Central (*1000000) 10000000008787
12/1/2011 12:21:53 PM Regular CkOut 383B3163741456 Heng Kong Central (*1000000) 10000000001238
12/1/2011 12:01:50 PM Regular Check-in 388B8163741456 Hong Kong Central (*1000000) 62626262626606
12f1/2011 Regular Check-n 385883163741456 Heng Kong Central {*1000000) 2nd2
12f1/2011 Regular Check-n 38888168741456 Hong Kong Central {*1000000) 2nd1
12f1/2011 Regular Check-n 38888168741456 Hong Kong Central {*1000000) 2011012801
12/1/2011 11:53:52 AM Regular CkOut 38888168741456 Hong Kong Central (*1000000) 2nd2
12/1f2011 11:53:50 AM Regular CkOut 38888168741456 Hong Kong Central (*1000000) 2nd1
12/1/2011 Regular Ckout 383B88168741456 Hong Kong Central (*1000000) 62626262626606 L
11/18/2011 11:10:50 AM Regular Check-n 383B2163741456 Hong Kong Central (*1000000) 2390847309848 3
11/18/2011 11:10:08 AM Regular CkOut 383B2163741456 Hong Kong Central (*1000000) 2390847309848
11/18/2011 11:07:23 AM Regular CkOut 383B3163741456 Heng Kong Central (*1000000) 2011012801
11/18/2011 11:06:52 AM Regular CkOut 388B8163741456 Hong Kong Central (*1000000) 2010082311
11/18/2011 11:03:59 AM Patron note deleted 38888168741456 Hong Kong Central (*1000000)
11/18/2011 11:02:13 AM Patron note added 38888168741456 Hona Knna Central (*1000000)
11/18/2011 11:01:40 AM Patron note added 38888168741456 What's This? &l (*1000000)
-
Display Mote
Username: User, Staff
Patron Class: Adult Patron Patron Record
Transaction Location: Hong Kong Central (*1000000) Patron Activity
Note Type: General Patron Account
Mote: Infrequent patron
Machine Name: oconnelle. vils. com Print...
Save..
E-mail...
Save As CSY

Clicking the option will display the entire note in an Information window.

f - =1

Information

\") Infrequent patran
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Displaying Denied Transactions

The Circulation Transaction Log reports any transaction in which a block
appeared with the prefix '‘Blocked’ in the Transaction column. When a block has to
be overridden the transaction log reads ‘Blocked - Regular CkOut’. If the block was
NOT overridden, the transaction log will read ‘Blocked — Denied - Regular CkOut'.

To display denied transactions select the Show Denied Transactions check box
on the Search Criteria tab.

Note: The Show Denied Transactions check box setting is persistent. When the
Transaction Log window opens, the Show Denied Transactions setting is either
enabled or disabled, based on the check box setting that was used for the previous
Transaction Log search.

W Transaction Log - venus88 E]@
Search Criteria I Results ]
You may search using one or more of the following criteria:
Item Barcode: Filters
| [~ Use Dates/Time:
Patron Barcode: Fram:
To:
Transaction Reference Mumber: | J |r —|
[ Filter by Location
= ~
Chamo - Internet (*000010000)
TPU
Hong Kong Central (*1000000)
Hong Kong Central - bookdrop (1000001)
To be deleted (2)
City Hall (*301000000)
City Hall - bookdrop (301000010)
To be deleted
Kowloon {302000000)
To be deleted (3)
Kowloon - bookdrop {302000002)
To be deleted (4)
Sha Tin (303000000)
Sha Tin - bookdrop (303000001)
Tsuen Wan (304000000)
Tsuen Wan - bookdrop (304000001)
Tiian M (20EAAANAMY il
¥ Show Denied Transactions:
[” Patron Initiated (Renewals Only)
Search Close
W Transaction Log - venus88 E] @.?
Search Criteria Results l
Patron Barcode: 38888 168741456 AND Show Denied Transactions
Date/Time Transaction Patron Barcode Location | Ttem Barcode Eadl
1272011 10:35:37 AM Blocked - Regular CkOut 388881687414556 Hong Kong Central {(*1000000) 53535353535306
12/7/2011 10:35:20 AM Blocked - Denied - Regular CkOut JEEE8 165741456 Hong Kong Central {*1000000)
1272011 10:34:57 AM Manual Block Added - Card repor...  38888168741456 Hong Kong Central (*1000000)
12/7/2011 10:33:15 AM Denied - Regular Renewal 38883168741456 Hong Kong Central {*10000007) 2010082311
12/7/2011 9:55:56 AM Denied - Regular Renewal 38888 168741456 Hong Kong Central {*1000000) J8888168740739
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Saving Transaction Log Information
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Circulation Transaction Log information may be saved in .csv (comma-separated

value) format via the right-click menu.

W Transaction Log - venus88

[B]f=1/%

Search Criteriz  Results

Patron Barcode: viis214

What's This?

Print...
Save...
E-mail...
Save As C5V

Date/Time ‘ Transaction | Patron Barcode Location | Item Barcode
11f17/2011 12:23: 14PM Add Request vils214 Hong Kong Central {*1000000) 2010082012
11f17/2011 11:12:10 AM Regular CkOut vils214 Hong Kong Central {*1000000) 2010082112
8/13/20119:01:35 AM Delete Request vis214 Hong Kong Central {*1000000) mbh8757
8/13/20119:01:27 AM Delete Request vHs214 Hong Kong Central {*1000000) M
8/13/20118:59:49 AM Add Request vs214 Hong Kong Central {*1000000) mbh8787
8/13/20118:59:30 AM Add Request vs214 Hong Kong Central {*1000000) 0
8/12/20119:46:19 AM Delete Request ws214 Hong Kong Central {*1000000)

8/12/20119:46:16 AM Delete Request vs214 Hong Kong Central {*1000000)

8/12/20119:41:23 AM Add Request vis214 Hong Kong Central {*1000000)

8/12/20119:41:23 AM Add Request vis214 Hong Kong Central {*1000000)

The .csv file may be viewed in a text editor, for example, Notepad.

) test - Notepad [::H:]ﬁa

File Edit Format View Help

pate, Transaction, Patron, Patron Class,Item,Bib Id,Location, TRN,Machi
11/17/2011 12:23 PM,add Request,vt1s214,adult Patron,2010082012,113
11/17/2011 11:12 aM,Regular Cckout, vt15214 Adult Patromn, 2010082112 4

§/13/2011 9:01 AM, Delete Request, vt15214 Adult Patron, mbh8787 11621
8/13/2011 9:01 AM,Delete Request,vt1s2l4,Adult Patron, 4444444344444
§/13/2011 8:59 AM,Add Request,vt15214,hdu1t Patron,mbhE?E?,llﬁzl,Hc
8/13/2011 B:59 AM,Add Reguest,vtl1s214,Adult Patron,44444444444440,1
8/12/2011 9:46 AM,Delete Request,vtls2l4,Aadult Patron,,40207,Hong k
8/12/2011 9:46 AM,Delete Request,vtls2l4,Adult Patron,,40208,Hong k
8/12/2011 9:41 AM,Add Reguest,vtls214,adult Patron,,40208,Hong Konc
9

8/12/2011 9:41 AM, Add Reguest,vtl1s214,adult Patron,,40207,Hong Konc

[(] 1l [)]
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Recording Improper Check-ins

Virtua is capable of storing information about “improper check-ins” in addition to
regular check-ins.

When an item already charged to a different patron (i.e., an item that has not
been checked in since its last check-out) is attempted to be checked-out, an
alert is displayed.

The options are to Accept All/ Waive, Accept All, or Cancel the transaction.

If either of the Accept options is selected, Virtua will record the check-in as an
"Improper Check-in" in the Transaction Log of the item and the patron who
originally had the item checked out.

If the item associated with the improper check-in is overdue, the word Overdue
will appear in the Due Date/Time field in the information detail of the
Transaction Log.

W Transaction Log - venus88 E]@

Search Criteria  Results

Ttem Barcode: 2010082112

Date/Time Transaction Patron Barcode Location | Item Barcode

11/17/2011 11:12:10 AM Regular CkOut vils214 Hong Keng Central {*1000000) 2010082112

11/17/2011 11:12:10 AM Improper Chedk-in vils529 Hong Kong Central (*1000000) 2010082112

11/17/2011 11:10:55 AM Regular CkOut vils529 Heng Keng Central (*1000000) 2010082112

BibId 41795 fad
Callnumber [Fic]

Username: User, Staff

Reserve Item: NO

Patron Class: Adult Patron

Transaction Location: Hong Keng Central {*1000000)

Transaction Reference Num: 36273

Due Date/Time: 12172011 11:10:00 AM

Out Date/Time: 11172011 11:10:55 AM

Owning Location: Hong Kong Central (*1000000)

Shelf Location: Hong Kong Central (*1000000) |
Item Class: Adult Lending Books ™

Both Check-in and Improper Check-in transactions are available for Ad Hoc and
InfoStation reporting.
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Logging Renewal Statistics

The Circulation Transaction Log also gathers/records data on the data elements:
Previous Due Date and Login Mode. These two elements will appear in the
Information area below the transaction log table on the Circulation Transaction
Log window.

For the Log-in Mode value the Circulation Transaction Log can record the
following types of logins:

¢ Internet :Chamo accessed remotely

e OPAC: Chamo accessed internally or Virtua client
e Self-Check: Fastrac or 3M SelfCheck

e Other

Another element to the Circulation Transaction Log window is a filter that allows
you to get search results on patron-initiated, self-renewals only. The filter is a
check box labeled Patron Initiated (Renewals Only).

W Transaction Log - venus8d - Dkﬂ

Search Critevia | Resdls
You may search usng one or more of the followng oitena

Item Barcode: Fiters
[V Use Dates/Time

From:
Pawon Barcode: st

| 10/27/2011 w | 17 112:0000 A <4

To:
Trarsacson Reference Nurber: [ = -
13/177011 £% 11:99-45 o~

[~ Fiter by Location

[ Show Derved Transsctors

v Pavon intated Renenals Only)

Search Ocze |
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Search Criberia Hﬂhl

L D T From: D017/3011 12:00:00 AM Te: 12/372001 12:00000 A AND Parron Initated [Renaval Only]

13/11{2011 3:55:43 PM Reguar Rerewsal 11553008 LTI4E0 Onamo - Intenet ("000010000) 3823800000365
11072011 %:00: 19 PM Feguiar Seremal 15861122 Thamo - Internet (S0000000) b ERr sk L
11/10{2011 2:58: b5 PM Requar Rerenal 15851122 Cram - Intemet (*000010000) 2093847039847
1000 10: 2802 A Reguisr Berewmal 2 Hang Kong Ceniral (* 000000) 12

10/21{2011 10:25:31 A Requar Rerewsal 102 Haong Kong Central [ B000004) 103

102172011 20:26:31 AM Beguier Beremal 102 Heng Kong Central (*1000000) 102

10/21{2011 10:35:47 &M Reguar Rerewsal 102 Hong Kong Cantral (*1000000) 103

12011 20: 2547 A4 Beguier Berwmal 102 Heng Kong Cental (1000000) 102

10/21/2011 1012341 &M Requiar Reresal 02 Central (= 1 102

AT/ 10:22:13 AW Eaguier Rmrwal 102 Heng Kong Certal [ 1000004 102

10/21{2011 10121200 A Requiar Rerewsal 02 Hong Kong Central = 1000004) 102

A0TLATL 10 ¥500 AM Reguisr Rerwmal ] Herg Kong Ceriral (" 1000004 1W0HR 0101036
10/21{2011 10: 14:38 &M Reguar Rerewssl 102 Haong Kong Cantral (*1000000) 102

A/TL0T0 20: 1414 AM Reguber Berwmal 102 Herg Korg Cenral (I000000) 103

10/21/2011 10111217 &M Requiar Rerewnsl 02 Hong Kong Central (~1000000) 103

AT 30: 1= 17 AW Risguisr Rerwmal liF} Heng Korg Cantral (* 000000) 02

10/2L{2011 101 L1206 &M Requiar Rerewsal 02 Hong Kong Cenral (= 1000004) 101

TR0 10:05:55 AM Reguiar Reremal w3 Heng Korg Ceniral (% p000000) 1wz

10/Z1/2011 100845 &M Reguar Renesal 12 Hong Kong Ceniral (1000004 L

AT L0 48120 AM Riguiar Ricwmal 2 Heng Korsg Corviral (™ 1000004) w2

10/21/2011 548109 AM Requiar Ferewal 102 Hong Kong Ceniral (*1000000) 101

10T FAT53 AM Riguiar Ricsrmal 2 Heng Korsg Casiral (™ 1000004) 03

Cut Dt Time; ILIS2011 129550 PH -
Owing Locaion: Butterfly Estate (702000000)

Sheif Location: Butterfy Estate (702000000)

Them Claxss: Adult Lending Books

Renewals: i

Amnisty Flag: off

Creprncie; Ha

Machine Mame: robertsa. vils. com E
Prevaous: Due [ate: TLLS001 1=aT00 PH

Faitron Login: Iriermet

Patren Barende Type: Primary
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Requests via the Virtua Client

Recommended
Workflow

Explanation

Virtua Client

Obtain Bib
Record

A 4

Open Request
Wizard

A 4

Enter Request
Information

Virtua allows for both staff mediated and user initiated
request functions.

Summary
Place a request using the Virtua Client

Key Terms:

Bib Level Request
Holds

Item Level Request
Loans

Pages

Recalls

Request Group
Request Level
Request Queue
Request Type
Request Wizard
Volume Level Request

InfoStation Reports

Availability: Generates a list of requested items that are
currently available.

Expired Requests: Lists Available Requests with expired
Hold times and Unavailable Requests with expired
Expiration dates.

Excessive Requests: Generates a list of title with an
“excessive number” of outstanding patron requests.
Recalls: Generates a list of items for which recall
requests have been placed.

Requested Bills: Generates a list of billable items
requested by other patrons.

Requested Overdues: Generates a list of overdue items
requested by other patrons.

Unsatisfied Requests Report: Generates a list of
unsatisfied requests.
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Request Processing Workflow

Flacing on-line Requests
wia the iPortal,

l

l

Fatron logs-in via Fatron
Aoress
{1 and pasanard)

Fatron Searches the
Catalog

l

Patron selects a record for
request and olicks on the
Request button

I I

Patron selects relevant Pation enters patron
request parametars: inforrnation
raquest expiration, *

request pickup location,
eteetera.

{ID and password)

Placing Requests via the
Virtua Client.

!

Librany staff searches the

catalog

I

I

136

When a record is chosen

library staff either clidis an
the Request Bib orthe
Request ftem button

then a record is chosen
library staff right-mouse
clicks and selects view

!

itemn requests

Staff enterz requesting
patron'z barcode

Staff clicks on the Add
button

l

Proceed to requests processing
Renuests trapped at check-in, InfoStation outstanding requests
repar, reviesing 10ans and pading requests.

Staff selects relevant
request parameters:
Auto, request, page, recall,
loan, request expiration,
request pickup location,
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Place Requests via the Virtua Client

Requests can be placed in two ways: using the Requests icon and entering a
bib-id or item-id, or by searching the OPAC to obtain a bibliographic record.

Obtain a Bibliographic Record
Search the OPAC for the requested item.

Open the bibliographic record in the View Bibliographic Record window.

Open the Request Wizard

W View Bibliographic Record - venus88 g@
K I EVE
Ful  Ttems |MARC | Statuses |

Author: Jones, Diana Wynne. Status Counts
Title: Enchanted glass f Diana Wynne Jones. Cth:ked zag 0 ETiE=EE v
[ st ed Available: 7 Requested: i}

o st ed. On Haold: i} Other: 4
Publication: Mew York, NY : Greenwillow Books, c2010,
Description: 222p. ; 22 cm. Total Items: 11 Unsatisfied Requests: 1

Total Requests: 2
Location | Call Number | Units | C.. | Itemn Id | Barcode Status Collection Code |
Kowloon {302000000) [Fic] 2167 2011013104 Mon-grculating
Kowloon {302000000) [Fic] 2 2165 2011013102 Mon-circulating
Kowloon (302000000) [Fic] 2 o907 2010082114 Available
Kowloon {302000000) [Fic] 3 2166 2011013103 Mon-grculating
Hung Hom (705000000)  [Fic] 1 2164 2011013101 MNon-circulating =
L] 3
Current Selection: :
7/11 Show Group ‘ | View Item ‘ Delete Item ‘ Request Item |
™ Masked Agency Req | View Archive | Edit | Request Bib ‘ Add Item ‘ Refresh ‘ Close ‘

You may place requests at the bibliographic level or you may request a particular
item.

a) To place a Bib-level request click the Request Bib button on the View
Bibliographic Record window.

b) To place an Item level request highlight the item and click the Request
Item button. The Request wizard will open.

The Include Item-Level Requests in That Number setting in the Virtua Profiler
determines whether item-level requests count towards the number of requests
allowed on a Bib-ID for each patron type.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



138

Enter Request Information

The Request Wizard will prompt you for the patron barcode. Enter the patron
barcode and click the Next button.

W New Request for Item: 2010082114 - venu... @

Author; Jones, Diana Wynne,
Title: Enchanted glass f Diana Wynne Jones.,
Edition: 1sted.

Publication: Mew York, NY : Greenwillow Books, c2010.

Patron Barcode: |

‘ MNext > | Cancel

The Request Type window will appear.

W New Request for [tem: 2010082114 - venu... @

Author: Jones, Diana Wynne,
Title: Enchanted glass / Diana Wynne Jones.
Edition: 1sted.

Publication: Mew York, NY ; Greenwillow Books, c2010,

Request Type
™ Auto
(" Page
* Loan;
™ Hold
" Recal ™

< Back ‘ MNext > | Cancel
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The default setting is Auto. This setting lets Virtua decide the most appropriate
Request Type based on such factors as item class, patron class, and status. All Auto
requests are placed at Bib-level.

Select the type of request: Hold, Recall, Loan, Page or leave on Auto.

Type of Request | Description

Holds Placed on a checked-out item or title where no
action is taken until an item is checked in.

Recalls Placed on a checked-out item, which may result in a
shortened due date and a letter to the item’s
borrower.

Loans Placed on an available item at a location other than
the log-in location.

Pages Request placed on an available item at a location or
sub-location designated as a paging location.

If Recall is selected the Immmediate Recall check box will become active. Click
in the box to recall the item immediately.

W New Request for [tem: 2010082114 - venu... @

Author: Jones, Diana Wynne,

Title: Enchanted glass / Diana Wynne Jones.
Edition: 1st ed.

Publication: Mew York, MY : Greenwillow Books, c2010,

Request Type
"~ Auto
(" Page
" Loan
™ Hold
(¢ Recal

< Back ‘ MNext > | Cancel
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Click the Next button to continue. The next window prompts you for Request
Options.

W New Request for Item: 2010082114 - venu... @

Author; Jones, Diana Wynne,
Title: Enchanted glass f Diana Wynne Jones.,
Edition: ist ed.

Publication: Mew York, NY : Greenwillow Books, c2010,

Request Options

{* Only This Item ¢ Any Item of This Yolume

Pickup location: |Hong Kong Central (*1000000) |
Not needed after: [ Use date:

Request From Group: |5tandard Libraries (CH) j

Mumber of items in database:

Calculate the number of qualifying items: Caloulate

Mumber of items that qualify for this request: |?

< Back ‘ MNext > | Cancel

When placing an Item-level request, you will have two additional request options
active on the Request Wizard window: Only This Item and Any Item of This
Volume.

e Only This Item - Lets you place a request for a specific item in a multi-
volume (or multi-part) set. This is set as the default and will place an item-
level request.

e Any Item of This Volume - Lets you place a request for any copy of the
specified volume in a multi-volume set. If chosen, this will place a volume-
level request. (Mostly used for serial requests.)

Select a Pick-up Location.
Enter a Not needed after date (optional).

If you are placing a request for a bib without items, you MUST select a Not needed
after date.

Enter a Request Group. (This field is active only if your library allows group
requests.)

Note: Request Groups are set in the Virtua Profiler. All groups of which the login
location is a member will appear in the drop down menu.

Enter a Minimum period needed (only active if set in Virtua Profiler).
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Click on the Fee Exempt checkbox to waive any fees normally associated with
placing the request.

Click on the Calculate button to see if the request will be successfully
processed.

Click the Next button. A message will appear indicating that the request was
successfully placed.

Information

\]::) A new request has been added successfully!

Note: Virtua no longer assesses fees when an unfilled request is cancelled; it is
only after the request has been trapped and is ready for pickup and then cancelled
that a cancellation fee is assessed. In this case, a request is considered trapped as
soon as a requested item is checked in.

Profiler Tip: In the Patron Types setting of the Virtua Profiler you can set limits for
the number of outstanding requests a patron can have at a given period of time. A
limit will be set for each type of request the library allows (Hold, Recall, Loan, and
Page). In addition, the Maximum number of all outstanding requests must be set.
See Working with the Patron Types Parameter: About Patron Type Settings:
Request Limits in the Virtua Profiler/Circulation Parameters User’s Guide for more
information.

Request Access

You may access requests from the View Bibliographic Record window and the
Item Information window or from the Circulation main menu.

Access Requests from the View Bibliographic Record Window

On the View Bibliographic Record window, you can view and manage ALL
requests of any type for a specific bibliographic or item record.

To view a request from the Items window, right mouse click and select Item
Requests.
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Create Holdings from Workform

Create Analytic Record
Create Autharity Record(s). ..

What's Thes?
<| »| 4380
JJ / Print...
Ful  Iiems |MaRc | Stahses |
SEVE...
Tithe:z The complete sormets and peems [ Wiliam Shakes) E-mad...
1sBh: 780199535798 {pbk.) :
[5BM: 0199535795 (phik.) Patron Activity 1
Publicaton: COniford ; Mew York : Oxford Universty Press, 2008
Deseription: e, 750 . 1 ill § 20 em, equests: 0
131 0
| Ttem Bootangs —
Call Mumber shelving Location Item Requests we
83s T Headquarters BEEGs
821.35 Bordeain:
821.3% East Regional 92812
Hold Ttem(s) for Relink
Current Selection: 173 | Request tem
[ Masked  Aaency Req Edt | create Holdings Record ] Close |

The View Request window appears. Each request appears in the list in the order it

will be satisfied.

Highlight a request to view additional information about the request. The specific
information about the request will appear in the area below the request list box.

-

-

W View Requests for Item: 31781048892895 - phoenix

=Jo/ed

Author; Shakespeare, Wiliam, 15564-1616
Title: The complete sonnets and poems | William Shakespeare ; edited by Colin Burrow.
Type | Status | Level | Patron Barcode | Patron Name |
iHald Pending Item vis214 O'Coninell, Hannah H
1
4 |
BibId 324393
CallNumber 82135
Ttem Barcode: 31731048892895
HMin Period Needed: 0
Placed Date/Time:  1/5/2011 12:42:00 FM
Expire Date/Time: 1/8/2012 12:42:00 PM
Placed Location: Bellefonte
Pickup Location: Headquarters
Patron Name: O'Connell, Hannah
Patron Type: Adult
Current Selection: 1/1 Add Modify Delete Close
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From the Circulation main menu, you can view and manage ALL requests of any

type for a specific bibliographic record or item record.

Select Circulation >Transactions > Requests from the Virtua menu or click

the ah
will appear.

You have the choice of searching for requests by bibliographic ID or by item
number.

Select the All Copies radio button to search on requests by bibliographic ID.

r

W Requests Access - phoenix 1

Bib-id: |

* Al copies { Holdings " Spedfic copy

| Cancel |

Select the Holdings radio button to search for requests by holdings ID.

W Requests Access - phoenix
Haoldings Id: |
" All copies (o Haldlngs " Spedific copy

| Cancel |

Select the Specific copy radio button to search for requests by item barcode
number.

[ = |

W Requests Access - phoenix @
Item Barcode: |
" All copies " Holdings is Epeuﬁcmpy

| Cancel |

To re-order requests, use the up and down arrows or highlight the item, hold
down the left mouse and drag the item to the proper position in the queue.

-OR-

Requests icon on the Circulation toolbar. The Request Access window

Right-click on the request, choose the Reorder Request option, and type the new

queue position for the request in the Reorder Request window.
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W Reorder Requ... | [

Mew gueue position: |ﬂ
| Ok |

Cancel |

To Add, Modify or Delete a request in the queue, click on the appropriate

button:
Button | Description
Add Opens up a new Request Wizard
Modify Opens up the Request Wizard for the selected patron
barcode
Delete Opens up a confirm delete window
W/ View Requests for Item: 31781048892895 - phoenix =Jo&d
Author: Shakespeare, Wiliam, 1564-1616
Title: The complete sonnets and poems [ Wiliam Shakespeare ; edited by Colin Burrow.
Type Status Level Fatron Barcode Patron Name
Hold Pending Item vils214 O'Connell, Hannah
iHold Pending Item visdil QConnel, Tom | ﬂ
4]
BibId 324898
CallNumber 821.35
Item Barcode: 31781048892895
Min Period Needed: 0
Placed Date /Time: 17/2011 10:14:00 AM
Expire Date/Time: 1/7/2012 10:14:00 AM
Placed Location: Bellefonte
Pickup Location: Headguarters
Patron Name: O'Connell, Tom
Patron Type: Adult
Current Selection: 242 Add Modify Delete Close

Group Requests

When a user places a request on an item that is the primary item of a group and all
other items in the group are available, Virtua prompts the user to inform them that
the item is part of a group and to ask whether the user would like to request all
items in the group.
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Click Yes to request the secondary items in the group.

i
W View Bibliographic Record - venus88 g@
il = I 1/1
Ful  TItems |marc |
Author: Hemingway, Ernest, 1893-1951, -~ tatus Counts
Title: The complete short stories of Ernest Hemingway : th... Che.d<ed = ToreEsE v
e A Available: 2 Requested: 0
e artstories On Hold: 0 Other: 0
Edition: 1st Scribner Paperback Fiction ed.
Publication: Mew York, M.Y. : Scribner Paperback Fiction, 1998, M Total Items: 2 Unsatisfied Requests: 0
Total Requests: 0
Location | Call Mumber | Units | C... I Item Id I Barcode | Status | Collection Code |
] (302000000] i 8740737 Available
Kowloon (302000000) 1 8424 33888168740789  Available
Current Selection: .
1/2 Show Group | View URL | View Item | Delete Item | Reguest Item |
[~ Masked Agency Reg View Archive Edit | Request Bib | Add Item | Refresh | Close |
L =1
- T—
Virtua 2011.2.14
This title includes secondary items. Do you wish to place a request for all secondary items as well?
Mo | Show Group{s}ll

When a loan request is placed on a group of items, the Loans/Pages window

indicates that the request is a group request.

W Loans/Pages - Kowloon (302000000)

==X

Outstanding | Denied I

Shelf Location | Call Mumber | Author | Title | Request Date |
Kowloon {30200... L Journal of Candy 7/8/2011 1:43:24FM
Kowloon (30200... (L) Hemingway... The complete short stories of Ernest Hemin... 12/2/2011 12:46:33 PM
Kowloon (30200... 341.2303 (L) Moare, Joh... Encydopedia of the United Mations f John ... 11/29/2011 4:15:20 PM
Kowloon {30200... 813/.5409 (L) Hamilton, G... Encydopedia of American popular fiction ... 11292011 4:15:20 FM
Kowloon {30200... 818/.5409 (L) Gillespie, M... Maya Angelou : a glorious celebration /by ... 11/15/2011 11:43:32 AM
Kowloon (30200... GV199.6 .B33... (1) Beyond backpacker tourism : mobilites and... 1/24/2011 8:00:27 PM
Kowloon (30200... [Fic] (L) Jones, Dian... Enchanted glass { Diana Wynne Jones. 11/16/2011 10:57:03 AM

Satisfy | Deny |

Pull List | Refresh | Close

To view the loan information, highlight the item and click the I

nfo button.
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"W Information - Loans/Pages uw
Author: (L) Hemngway, Emest, 1893-1961.
Title The complete short stories of Ernest Hemingway : the
Finca Vigia edition / [foreword by John, Patrick, and
Gregory Hemingway ; preface by Charles Sorbner, X.].
Shelf Location: Kowloon {302000000)
Item Barcode: 33888168740797
Request Location:  Aberdeen (501000000)
Reguest Date: 12/2/2011 12:46:39 PM
Expire Date: 12/1/2012 12:45:58 PM
Request Levek Ttem
Pickup Location: Hong Kong Central (*1000000)
Patron Name: Grace Kilon
Patron Barcode: 3888316874145
Patron Type: Adut Patron

When a request is placed on a group of items, the View Requests for Item
window displays a Group Request entry in the additional information area for each

request.
W View Requests for Item: 31781013932999 - phoenix mE x|
Author: Hemingway, Ernest, 1899-1561
Tite: Foe whom the bel tolls / Ernest Hemingway.
Type | Status | Level Patron Barcode Patron Name ‘
Bibid 116197
CallNumber F HEMINGWAY
Ttem Barcode: 31781013932959
Min Period Needed: 0
Placed Date/Time:  12/10/2011 8:48:00 AM
Expire Date /Time: 12/5/2012 8:48:00 AM
Location: Technical Services
Pickup Location: Beliefonte
Patron Name: O'Connell, Hannah
Patron Type: Very Important Person
—'» Group Request: YES
Fee Exempt: NO
Current Selection: 1/1 [ ag | o | e | oo |

Virtua will trap the primary item in a request group first, and will only trap
secondary items in the group after the primary item is trapped.
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Process Hold and Recall Requests

Recommended
Workflow Explanation
Generate a List of In order to trap requested items for the hold shelf, all

Requested Items items must be processed through check-in.

l If the specific item (item level request) or all
attached items (bib level request) are checked
out when the hold/recall is placed; they will be

Trap Holds via

Check-i
e trapped at check-in.
l If the specific item (item level request) or all
attached items (bib level request) are available
Generate Hold

when the hold/recall is placed; staff will need to
generate a list of requested items via InfoStation.
When the items are pulled from the shelf they will
be checked-in and the items will be trapped for
the hold shelf.

Pick-up Notices

Summary

Trap items for hold pick-up.
Generate a request pull list.

Key Terms

Guaranteed Circulation Period
In transit

In transit requested

On hold

Trap
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Generate a List of Unsatisfied Requests

The Unsatisfied Requests report is used to pull items from the shelves to trap for
the hold-shelf. This report can be scheduled to run automatically and is able to
email the results to staff.

Open a web browser and connect to InfoStation.
Login to Circulation reports.

Select the Unsatisfied Requests report for configuration (See Virtua InfoStation
Reports Training Guide for details).

Run the report.
Trap Items for the Hold-Shelf

In order to trap items for the hold-shelf, items must be checked-in in the Virtua
Client.

When an item is trapped for a hold the client will indicate to the staff member that
the item has a hold and needs to be placed on the hold-shelf or to send it transit to
the appropriate hold pick-up location.

Statuses of Requested and In Transit Items

Items that have been trapped and are in transit to another location to fulfill a
request are tracked as the system assigned status of In Transit Requested. These
items are tracked separately from items that are In Transit. The Circulation
Transaction Log displays both In Transit and In Transit Requested statuses. In
addition, both statuses are available for InfoStation and Ad Hoc reporting with
appropriate views.
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Process Loans and Paging
Requests

Recommended
Workflow Explanation
A Loan is a request on an item that is available at a
Loans location other than the location where the request is
View Loan placed.
Requests . .
If the library satisfies the request, the status of the
il item changes to On Hold or In Transit,
, depending on where the item is to be picked up.
Satisfy or Deny If the lib d - th t the it
oan Request e library denies the request, the item appears
on the Denied (loans) tab of the requesting
library, and if loans are flagged as Group in the
A 4 . . .
) Circulation parameter Global Request Trapping
Denied Loan .
Requests Flags, the loan request circulates to the next
library in the group.
Pages A Page is a request to view an item from a closed stack
, or remote storage location.
View Page
Requests Summary
View outstanding requests
View requests for other locations
Satisfy or deny a loan request
View denied loan requests
Resubmit and delete denied requests
View outstanding page requests
Key Terms
Denied Loan Request
In transit
On hold
Page
Satisfied Loan Request
Circulation Parameters
Location + Item: Requests, Loan Requests allowed
Location + Item: Requests, Page Requests allowed
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Loans

The Loans/Pages Setup window allows you to configure which fields are included
on the loans/pages printout. To configure the fields go to Options - Circulation
Options > Loans/Pages Setup. (This may also be configured in the Virtua
Profiler: Circulation Parameters and overrides anything set in the individual client
work station.)

Loans/Pages Setup - venus88

Patron Name: Patron Name: | Edition: [Edition:

Author: |.-5.uﬂ'|nr: Bib Id: |Bib Id:

Title: |Title: Units: |units:

Call Mumber: |Ca|| Mumber: Shelf Location: |Shelving Location:

Second Call Mumber: |Sec0nd Call Number: Pickup Location: |Pid0.|p Location:

Item Barcode: |Item Barcode: Mon-Parameterized Shelf Location: |N0n -Parameterized Shelf Loc:

Copy Number: |Cop\,r Mumber: Reguest Date: |Request Date:

Copies: |C0pies: AV Accession Number: |Ah‘ Accession Mumber:

Collection Code: |Collecﬁnn Code: Group Request Indicator: |Gr0up Request Indicator:
{Only named fields will be printed. ) Save ‘ Cancel

View Loan Requests

Click the Loans icon on the Circulation Toolbar or Select Circulation >
Transactions > Loans on the Virtua menu bar. The Loan/Page Access
window appears.

W Loan/Page Access - Customer Support Library

Select Location: |§Headqmrter3 j

O Cancel |

Select the location for which you want to view loan and page requests.

Click the OK button. The Loans/Pages window appears, displaying the
Outstanding tab. Columns can be re-sorted by clicking on the column
headings.
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W/ Loans/Pages - Headquarters

Shelf Location | Collection Code Call Number Author Titie

Headgquarters ER 616841 C (L) Jones, Bill The consumer
Headguarters 83109885 A (L) Asian-Americal
Headgquarters 81165453 (L) Swenson, ...  MNew & selecies
Headquarters CDPOP/ROC... (L) 10,000 Mani.. Love among th
Headguarters ER Das (L) Doss, Jame... The cld gray w
Headgquarters ER Dos (L) Doss, Jame... The old gray w
Headquarters F GOODKIND (L) Goodkind, ...  Confessor/ Te
Headguarters F KING (L) King, Steph... Duma Key /by
Headgquarters F TREWVANIAN (L) Trewvanian The Main : a ng

Satisfy ‘

What's This?
Patron Record
Patron Activity :‘
Patron Account M
Bib Record
Bib Requests
M
M
Copy
Print
Save
Email
Deny ‘ Infa ‘

Refresh |

Close |

Outstanding Tab: Displays outstanding requests (pages) made to the selected
location; items are sorted by shelving location and then by call number. To resort,

click on the column header.

The data in the Collection Code column may be sorted by collection code and then
by call number. The sorted order of the Collection Code data also displays in the

Print/Save/Email output.

Denied Tab: Displays requests that the library has denied.

To print, save, e-mail, or copy selected rows from the Loans/Page window list
box, right-click to access the pop-up menu. In addition, the entire Outstanding
Loans/Pages list may be printed, saved, or emailed.

To access Bib Records and Bib Requests use the pop-up menu to navigate to
the View Bibliographic Record window or View Requests window associated

with a particular loan or page request.

Highlight a line item and then click the Info button to view detailed information
about a particular loan request. The Information - Loans/Pages window

appears.
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Pickup Location:
Patron Name:
Patron Barcode:
Patron Type:
Group Request:
Copies:

7 1
W Information - Loans/Pages E]@

Author: (L) Gillespie, Marda.

Title Mavya Angelou : a glorious celebration [ by Marda Ann
Gillespie, Rosa Johnson Butler, and Richard A. Long ;
foreward by Oprah Winfrey.

Calllumber 218/,5409

Shelf Location: Kowloon (302000000)

Item Barcode: 754

Request Location: Hong Kong Central {(*1000000)

Request Date: 11/15/2011 11:43:32 AM

Expire Date: 11/14/2012 11:42:47 AM

Request Level: Item

Hong Kong Central (*1000000)
O'Connell, Rosie Riviter
vtls529

Adult Patron

YES

1

To view requests for other locations:

152

On the Circulation toolbar, click the Loans icon . The Loan/Page Access

window appears.

Select another library location. Click the OK button.

Satisfy or Deny Loan Request

You can satisfy a loan request as long as the item is requested of the log-in

location. There are two ways to satisfy a loan request.

Satisfy Request via Loans/Pages Window
Display the Loans/Pages window for the login location.

On the Outstanding tab, highlight the desired line item(s).

Click the Satisfy button. The Item Access dialog box appears.

FW Item Access - phoenix @-\

Item Barcode: ||

Cancel |

Type the item number being used to satisfy the outstanding loan. Click the OK

button.
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Satisfy request via Check In Window

Check in the item to be loaned.

The check-in transaction traps the request and satisfies the loan request.

Deny Loan Requests

You can deny a loan request as long as the item is requested of the log-in location.
Display the Loans/Pages window for the log-in location.
On the Outstanding tab, highlight the desired line item(s).
Click the Deny button.

If the request is a bib-level request, the loan request will appear on the
Outstanding tab of the next library location in the queue. If each library in
turn denies the request, the request will appear on the Denied tab at the
requesting location.

If the request is an item-level request, the request will appear on the Denied
tab at the Requesting location.
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View Denied Loan Requests

The Denied tab lists requests made by your patrons that could not be satisfied by
any library.

To view a denied loan request open the Loans/Pages window for the log-in
location.

Click the Denied tab.

Note: The Denied tab window displays the denied requests for the log-in location.
You may either resubmit or delete the denied loan request.

- .
W Loans/Pages - Headquarters g@
Outstanding Denied ]
Denying Location | Call Mumber | Author | Title | Reguest Date |
Headguarters (L) Joya, Moku.  Mock Joya's Things Japanese. 4202010
Headguarters 738.0975 1 (L) James, A. E... North Carolina art pottery : 1900,,. 7/13/2010
Headquarters 746.9T N L) Narth Carolinag quilts / Ellen Ficklin... 7/13/2010
Headguarters 973.931A (L) Ashcroft, 1... Newer again : securing America a...  7f22/2010
Headguarters DvD L L) The lost battalion [DVD videoreco... 77132010
Resubmit to group: |CCPL REQUEST ﬂ Resubmit ‘ Delete ‘ Info ‘
| Refresh | Close |

View Loan Request Information
Highlight the desired line item.

Click the Info button. The Information - Loans/Pages window appears.

- .
W Information - Loans/Pages g@
Author: (L) James, A. Everette (Alton Everette), 1935-
Title Morth Carolina art pottery : 1900-1960 : identification &

value guide : Seagrove, Catawba Valley, Pisgah Forest
and more— [ A, Everette James, with Rodney Leftwich ;
foreword by Charlotte Brown.

CallNumber 738.0975 ]

Shelf Location: Headquarters - Local & State History

BibId 244021

Denying Location: Headguarters

Request Location: Headguarters

Request Date: 7/132010

Expire Date: 7/132011
Request Levek Bib

Pickup Location: Headquarters
Patron Name: Umar, Jamil Ahmad
Patron Barcode: 123458

Patron Type: Adult
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Resubmit Denied Loan Request
Highlight the desired line item.

Click the Resubmit button.

The request will route back through the qualifying locations. If only one item is in
the list box and you resubmit it, the Loans/Pages window closes.

Profiler Tip: When the Process Denied Loans check box is selected, Virtua will
automatically resubmit loan requests that are denied for the location and all of its
sublocations. See Working with Setting Up Locations: Setting the Process Denied
Loans Flag in the Virtua Profiler/Global Settings User’s Guide for more information.

Delete Denied Loan Request
Highlight the desired line item. Click the Delete button.

If only one item is in the list box and you delete it, the Loans/Pages window
closes.

View Page Requests
See View Loans Requests.
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Reserves

Recommended
Outline

Explanation

View Reserves

Archive Reserves

Delete Reserves

Copy Reserves
List

Schedule Reserve
Items

Reserves Due

Summary

Virtua Reserves allows you to create and maintain
course reserve lists and monitor the circulation of items
associated with those lists using a special set of
circulation rules.

Search for an item on reserve

Create a reserve header
Place an item on reserve

Create a bibliographic record using Circ-on-Fly
Add an item record to a bibliographic record

Key Terms

Active Reserve Item
Archived Reserve Item
Begin Date
Circ-on-the-fly

Course ID

Course Section
Current Active

Current Inactive

End date

Instructor Number
Reserve

Reserve Item

Reserve List

Reserve Header
Scheduled Reserve Item
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Circulation Parameters

The parameters listed below affects the processes related
to Reserves.

Global Settings

Location Names: Set default values for items that are
added to a new reserve list. Set begin dates, end
dates, and pull period in number of days.

Circulation
Item Class Definitions: Define reserve items classes.

InfoStation Reports

Reserves Activate list: generates a list of reserve
items that qualify for activation

Reserves Current Active list: generates a list of items
currently on active reserve

Reserves Pull list: generates a list of scheduled
reserve items that need to be pulled from the shelves
and moved to the reserve area

Reserves Remove list: generates a list of active
reserve items that have expired and need to be deleted
or archived
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View Reserves
View Reserves to ensure that the Header does not already exist.
Via Reserves Access Window

On the toolbar, click the Reserves icon or select Circulation > Reserves >
View from the Virtua menu bar. The Reserves Access window opens.

.W Reserves Access - phoenix 1

Access by Select
{* Course Mumber {* Current
(™ Instructor Barcode " Archived

(" Item Barcode

Course Mumber: 100]
OK | Cancel |

Select Course Number, Instructor Barcode, or Item Barcode as the access mode.
Select Current or Archived to view either active or archived reserve lists.
Type in the appropriate search term in the text box.

Click the OK button.

Via the OPAC
On the toolbar, click the Search icon il

On the Browse tab of the Search window, choose Instructor or Course ID as
your search category.
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Obtain Instructor Barcode

You must have the Instructor’s barcode (patron ID number) in order to create the
reserve header.

Search the OPAC for the Patron ID number by hitting the F8 key or by selecting
Search = Patron Name from the Virtua Main menu.

Enter the instructor’'s name and click the search button. The patron record will open
in the Patron Information window. The Patron ID number is the 015 tag,
subfield$ a.

To auto populate the Create Reserve Header window with the patron barcode
number, leave the patron record open and select Options 2> Circulation
Options > Auto Populate Patron Barcode from the Virtua main menu.

When multiple Patron Information windows are open, the Instructor Barcodes
text box will be automatically populated from the last focused open Patron
Information window.

Check-out/Renew Receipt Setup. ..
Check-in Receipt Setup...

Fine Receipt Setup...

In Transit Slip Setup...

Billed Material Slip Setup...
Reguested In Transit Slip Setup...
Requested Slip Setup...

Agency Reguested Slip Setup...
Fatron Address Label Setup...
Loans/Pages Setup...

Auto Populate Patron Barcode
Circulation Assistant Integration
v Smaller Patron Information Resizing
Sort Checkout/Renew Receipt Items by Due Date

Create Reserve Header

You must first create a reserve header for the reserve list and then add the items to
the list.

Select Circulation > Reserves > Create from the Virtua menu bar. The
Create Reserve List dialog box appears.
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W Create Reserve List - phoenix

List Info

Instructor Barcodes: ||

Course Mumber:

Course Section: |

Course Title:

L

Add

Delete

Cancel

Enter the information. Click OK.

160

Only ONE occurrence of a course humber, instructor, and section can be active at

any time.

Place Items on Reserve

Place an Existing Item on Reserve
Open the View Reserve window.

W View Reserves - Course: LIS 110 (Current)

-

==}

Reserve List
Course Number | Course Section | Course Title | Instructor Name
LIS 110 1 Organization of A= e
Libraries What's This?
Ttem Record
Item Reguests
Info
Bibliographic Recard
Save As ‘ Modify Transaction Log Archive
Audit Trail i
Items
Total: 3
Call Number | Title | Location | Status |
025.1M Organizational structure of li... Headguarters On Reserve
025,1M3 How to organize and operate... Headguarters On Reserve
025.1 N8 The organic public library /D... Headquarters On Reserve
Add | Modify ‘ Delete | Archive ‘ Select Al

Below the Items detail box, click the Add button. The Create Reserve Item dialog

box appears.
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-

Create Reserve ltem
Ttem Info
Item Barcode: ’7
Item Class: |2 Hour Reserve j
Active Period: | 1 010 =] to |1z/312010 |
Reserve Location: |Bellef0nte j
Allow Requests: B

| Cancel |

Enter the Item Barcode of the item you are adding to the reserve list.
Select the Item Class from the pull-down list box.

Choose the beginning and ending dates of the Active (Reserve) Period using
the calendars or by accepting the default.

Select the Reserve Location from the pull-down list box.

To allow requests to be placed against this item, click the Allow Requests
check box.

Click OK. The Create Reserve Item dialog box will remain open until you choose
to close it, and allows you to quickly add multiple items to a reserve list without
reopening the window.

An item can be associated with multiple reserve lists, but it can have only ONE
reserve location, ONE item class, and ONE requests designation.

Place a New Item on Reserve

If a bibliographic record does not exist in the OPAC use Circ-on-the-fly to create a
brief MARC record, then add an item.

Circ-on-the-Fly
Select Circulation > Transactions > Circ-on-the-Fly from the Menu Bar.

The MARC Editor appears, displaying the default circ-on-the-fly workform. Type
the necessary data.
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12 MARC Editor - Customer Support Library

[ ] [oos ]
[ J[ozo JL ][

i
=
[=]

HEEEN
HEEEN
HEnnn

[ 120530

00 eng

L=

L=

L=

e

L

L

|[a} Language material

<]~

_= | {m) Monograph,Ttem

MARC 21 Bib: Book

| I Masked
Mew Record Modified

yUntitled /

Save the record by pressing the F11 key or the

toolbar.

By

icon on the cataloging

The saved record reappears and then the View Bibliographic Record window
appears, displaying the brief bibliographic record you created.

Add Item Records

From the View Record window, click the Add Items tab. The Item
Information window appears displaying default values for the mandatory item

elements.

Accept or change the default item values where applicable.

Enter a barcode of up to 50 characters.

Click the Save button.

Click the Refresh button on the View Bibliographic Record window; note that

an Item tab appears.
This is now available to be placed on Reserve.

Delete Item Records

Once a reserve item, which does not belong to the library, is no longer on reserve,
the item may need to be deleted from the database. Do not delete the item if you
intend to archive the reserve list and include the item.
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From the View Bibliographic Record window, highlight the item to be deleted
and press the View Item button. The Item Information window appears.

Press the Delete button. A confirmation window appears prompting a yes or no
to either proceed with or cancel the delete action.

From the View Bibliographic Record window, press the Refresh button to
refresh the window to reflect the deletion.

View, Modify, and Copy Reserves

Perform a Browse Search by Instructor (last name, first name) or Course
number to open the View Reserves window.

" -

W View Reserves - Course: LIS 110 (Current) Q@
Reserve List
Course Number | Course Section | Course Title | Instructor Name |
Organization of Harrill, Michaela E

LIS 110 |1

Libraries

Modify ‘ Delete ‘ Archive |
Items
Total: 3
| Call Number | Tite | Location Status |
025.1M Organizational structure of li... Headguarters On Reserve
025.1M3 Howe to organize and operate... Headguarters On Reserve
025.1N8 The erganic public ibrary /D... Headguarters On Reserve

EN | | | |

From this window you can edit both reserve headers and items on reserve.

Modify Reserves
You may modify the reserve header or items placed on reserve.

Modify Headers

From the View Reserves windows, highlight the course/instructor header and
click the Modify button. The Modify Reserve Header window will appear.
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U View Reserves - Course IS 11 =7 —
Instructor Barcodes: Add
Reserve List E130 =
Courge Mumber | Course Section | Cod
Course Number: LIS 110
Course Serton: 1
Course Titles Organizaton of Libranies
oK I Cancel I
i Saveas |l Modity Delete | Archive |
Items
Total: 3
| calbumber | Titie | Location | status |
025.1M Organizational structure of li... Headquarters On Reserve
025.1M3 Howe to organize and operate.,. Headquarters COn Reserve
025.1M8 The arganic public ibrary fD... Headquarters On Reserve
Add I ‘r'u||i"'.' | [glete Archive I S=lect Al |

Edit the Header and click OK to save. The View Reserves window will be

active.

Modify Items

From the View Reserves windows, highlight the desired item and click the
Modify button. The Modify Reserve Item window will appear.

Course Mumber | Course Section | Course Title Instructor Name
" Item Info
Ttem Barcode:
Ttem Class:
ritems -
Active Periad; EEETTE A T
| call umber | Tite Reserve Location: [He.bdqua'hﬁs EI
025.1M Organizat| | Alew Requests: I
025.1M3 Howi to on
025.1N8 The organ | o | Concel ]
Add I Vn||i"'.' I Delete Erchive | S=lect Al |

Edit the item and click OK to save.
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Note: You cannot modify the Item Barcode. If an incorrect item has been added, it
needs to be deleted.

To modify all items on the reserve list, click the Select All button. All of the items
on the reserve list will be grayed out. Click the Modify button and the Modify
Reserve window appears. Any changes that you make will be reflected on all
reserve items.

Copy Reserve List

To save time, you may want to create a new reserve list by copying much of the
information already associated with a current list.

From the View Reserves windows, highlight the course/instructor header and
click on the Save As button.

Enter in the new information.

Note: Items associated with multiple current lists cannot have different loan
periods or different reserve locations or have the Allow Request Flag set.

Archive Reserves

You can archive a reserve header and all items attached to that header, or a single
reserve item. Currently circulating Reserve items cannot be archived.

Header
From the View Reserves windows, highlight the Course/Instructor header.

Click the Archive button. The Reserve Header and all items attached to the
header will be removed from the View Reserves window and archived.

Item
From the View Reserves windows, highlight the item.

Click the Archive button. The item will be removed from the reserve list and
archived.

Click the Select All button and then the Archive button to archive all reserve
items.

Activate Reserves

To activate archived reserves select Circulation > Reserves > View, from the
Virtua main menu.

Select the Archived radio button.
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- ]

W Reserves Access - phoenix E]
Access by Select
{* Course Mumber " Current
(™ Instructor Barcode o ,ﬂ.rchwed

(" Ttem Barcode

Course Mumber:
| Cancel |

Click the Select All button and then the Modify button to reactivate an entire
list or highlight a single item or multi-select items from the list using the Ctrl
key. The Modify Reserve Item window appears.

Enter the new active period.

PModify Reserve [tem @1
Ttem Info
Item Barcode:
Item Class: 2 Hour Reserve ﬂ
Active Period: | §/22/2010 ﬂ to | 12/31/2010 ﬂ
Reserve Location: |Headquarters j
Allow Requests: I

’Tl Cancel ‘

Delete Reserves
You can delete a reserve header and all items attached to that header, or just
delete a single reserve item. Currently circulating Reserve items cannot be deleted.
Header

From the view reserves windows, highlight the course/instructor header

Click on the Delete button. A Confirm window will appear.

Note: If you delete the header, you will delete both the current and archived
header.

o~

Confirm —

D] Delete the selected reserve list?
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Item
From the view reserves windows, highlight the item.

Click on the Delete button. A confirmation window will appear.

Click the Select All button and then the Delete button to delete all items on the
reserve list.

Schedule Reserve Items

Sometimes you want to put things on reserve before their start date. When you do
this the reserve items will appear on the Scheduled tab.

-

W Reserve Items - Headquarters E]@
Active Scheduled l
Total: 3
Item Barcode | Call Mumber | Course Number | Instructor Name | Begin Date |
EKO2 E READER EMG214 O'Connell, 1/17/2011
SELISS Hannah
O'Connell, Verity
MKP2 J323ROW Eng 510 Hristow, Mechka |1/17/2011
FREMCH 5
RPM1 TEEM MEYER.  |LIS 5201 Morrisette, Rob  [1/17/2011
Marrisette, Jack
Item Barcode: EKD2

The system will automatically move the item from the Scheduled tab to the Active
tab at the appropriate time.

Activate Scheduled Reserve

If you wish an item to be active earlier than it was scheduled from the scheduled
tab, highlight the item to be made active and click the Activate button.

Archive Active Reserve
A list of all items currently on reserve can be seen on the Active tab.
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r -~
¥ Reserve Items - Headquarters g@
Active | schedued |
Total: 27
Item Barcode | Call Mumber Course Mumber | Instructor Name | End Date |
2384973847 |\05.41\2002\03|LIT250 Holm, , Carrie 12/31/2010 | A
Ann, Il
317810140314(011.62D0, 5TH (LIT250 Holm, , Carrie 12312010 | =
ED. Ann,
317810209450i(021.65B LIS 105 Harrill, Michaela E | 12/31/2010
31783103901381(025.1G LIS 120 Harrill, Michaela E | 12/30/2010
Anderson, Eileen
317310019217 (025.1 M LIS 110 Harrill, Michaela E |12/31/2010
100551147887 (025.1 M3 LIS 110 Harrill, Michaela E | 12/31/2010
100045711159.(025. 1 M3 LIS 110 Harrill, Michaela E | 12/31/2010
107 636.7088 B ARCH101 Andrews, Aidan |12/31/2010
317810133424(809 TRACE LITZ250 Holm, , Carrie 12/31/2010
Ann, 4|
AdTaanrae - lnan acrwaanrh Teara [ - [l AN e e L 4
¢ Archive i Delete
Item Barcode: 2334973847 Archive | Delete

If you wish an item to be deactivated earlier that it was scheduled from the active
tab, highlight the item to be made inactive and click the Archive button. This will
archive the item.

Reserves Due

The Reserves Due window allows you to view information on reserves due at your
location.

Select Circulation > Reserves - Reserves Due from the Virtua menu bar.

- -

¥ Reserves Due - phoenix E]@
Search Parameters
Search
Item Barcode: [
™ Time: li_ Cancel
™ Date:

Enter a specific item, date or time.

Click the Find Now button. The Reserves Due list will be appended to the
Reserves Due window.
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W Reserves Due - phoenix

=%

Search Parameters

Search |
Item Barcode: |31?31IJD 1921772
: C |
- Tme: [ = |
[~ Date: I "'I
Item ‘Patrnn |Due Date/Time Calllumber 025.1M
/i Author: Martin, Lowell Arthur, 1912-
31781001921772 vils411 1/7/2011 12:26 PM Title Organizational structure of libraries /
Lowell A, Martin.
BibId 154724
- Check-Out Date/Time:  1/7/2011 12:16:00 PM
What's This? Letter Date: 1/5/2011
Letter Type: Review
Patron Record Renewals: o
Patron Activity Owning Location: Headquarters
Shelf Location: Headguarters
Patron A t
atron Accoun Reserve Location: Headguarters
Item Record
Item Requests
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Item Bookings

Outline Explanation

The Item Booking feature lets you book a particular item
View Item for use by a patron during a specific time period. Once
Bookings an item has been booked, the item cannot be checked

Schedule Item
Bookings

Modify/Delete
Item Bookings

out to another patron if the loan period conflicts with the
scheduled booking date/time.

Summary

View all bookings for an item.
Schedule an item booking.
Modify or delete a scheduled item booking.

Key Terms

Item Bookings

Materials Booking
Bookings Pickup Location
List Overview

Circulation Parameters

Patron Type Settings: Add Patron Type window,
Item Booking Limit

Fine Code Definitions: MB, Materials Booking

Circulation System Options: Bookings take priority
over satisfied requests.

Item Class Definitions: Class Type, bookable.

System Parameters

Bookings Pickup Location: Location Names, Location,
Check box to allow location to be an Item Booking
Pickup location.

InfoStation Reports

Expired Bookings Report: generates a list of
expired bookings that meet the location and patron
type criteria.

Media Booking Pull List: generates a list of items
that need to be prepared for scheduled item
bookings.
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Viewing Item Bookings

View Bookings by Item

171

To view all bookings for an item, from the Items tab of the View Bibliographic
Record window, highlight the item in the list box. You may also access the Item
Bookings window from the Item Information window.

Click the View Record menu on the Virtua main menu or right mouse click and
select Item Bookings.

o View Bibliographic Record - phoenix

<|>|3rm

Title: The poema of Emily Diddnson [ edited by RV, Frank
158N: D746 76245 :

Publicatian Cambridge, Mass, | Beknap Press, 1999,
Description: 69Zp.; X5om,
FormatEdition: Reading ed.

| Cal Mumber | shehving Location

B11 DICKINSON Headquarters

811 DICKINSON East Regional

B11 DICKINSON Morth Regional

|4

Current Selection: 1/ 3

[~ Masked Agency Req Ecit Re

View Bookings by Patron

Itesn Bookings

Item Requests

Higld Ttem(s) for Refink

Request Them
Create Haldings Record

Create Haldings fram Workform

Jo&d

Regquessts:
b1H

L= =] =]

wooe

19213378
19213311
19213253

| o= |

Create Analytic Recard
Creabe Autharity Record(s). ..

Navigate to the Patron Information window, Activity tab, Booked sub-tab.

Select an item in the list box and right mouse click.

Select Item Bookings from the pop-up menu.
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Add an Item Booking
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From the View Bibliographic Record window, display the Items tab for the

item to be booked.

In the list box, right click on the item you want to book.

On the View Bibliographic Record window pop-up menu, select the Item
Bookings option. The Bookings For Item window appears.

W Bookings For ltem 1000008601 - Virtua Library

=%

Details l Lisk Owversiew ]

12:004M  Earliest Prep Prep Time: |3 pays x|
1fgfz011 Awailable 1 » I—
1 Inspect Time: |1 |Da';-'s ﬂ
2 3 4 €CDe 7 o8
9010 11 12 13 14 15 Duration: |12 |H|:|urs ﬂ
16 17 18 19 20 =21 22
23 24 25 26 27 23 29
3m 3 Reset | Recalculate |
o Today: 1/5/2011 Pickup Location;
|Wilson Library ﬂ
" Memorial Archives
‘Wilson Library
Wilzon Library, - Reference %
Card Label Card Text | ‘ilson Library - Reserve Room

Close

The display panel at the left lists the item bookings that have already been

scheduled.

Using the calendar interface, navigate to the desired booking date.

In the display panel at the left, click on an “Available” hour in the list.

Modify the default Prep Time, Start Time, Inspect Time, Duration, and Bookings

Pickup Location setting.

Add a Note if needed.
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Click the Add button.
Enter the barcode of the patron for whom you want to book the item.
Click the OK button.

The new item booking is scheduled, and the Bookings For Item window is
refreshed to display the new booking.

When you have finished scheduling bookings for the item, click the Close button.

Modify/Delete an Item Booking

Go to the Bookings For Item window for the desired item.
Use the calendar to navigate to the date on which the item booking falls.

In the display panel at the left, select the scheduled item booking that you want to
modify or delete.

To modify the item booking, edit the Prep Time, Start Time, Inspect Time,
Duration, Bookings Pickup Location and Notes fields as necessary and click the
Update button.

OR

To delete the selected item booking, click the Delete button.

Your changes are applied and the display panel at the left of the window is
refreshed.

Displaying Bookings for an Item

The List Overview tab displays all upcoming bookings for the item.
The information on this tab can be sorted by clicking on a column header.

A right click menu offers choices for viewing other details about the selected
booking.

Item bookings cannot be modified from this window.
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(W Bookings For Item 1000008601 - Virtua Library

BEX]

Details  Lisk Cuverview l

% What's This?

Patron Record
Creetyiew

Patron | Prep Start Date | Statt Date | End Date | Inspection End Date | Pickup Location
456750 1712011 1fEiz011 1/5/z011 1/5/z011 wilson Library
272750 /132011 1/13f2011 111302011 1/14f2011 wilson Library

Close

Note: When an item is booked, the View Bibliographic Record window now

displays “"Booked” as the item status.
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Floating Collections

Recommended
Workflow Explanation
Floating collections allow libraries to float designated items
Checkout an of their collections to multiple locations. There are various
Itifgcitd?fe options available to libraries for choosing which items
circulate. These options may be configured for entire
l collections, specific item classes, or even individual items.
Checki When a floating item is checked in, the item’s shelving
eckin the . . . . . h
Same Ttem at a location is reset to the check in location, if the check in
Different location accepts floating items. Unlike rotating collections,
Location floating collections are controlled by the actions of the
patron.
Profiler Circulation Parameters
Profiler > Global Settings > Locations > Allow
Floating Items Minimum item count threshold
Profiler > Global Settings > Locations > Accept
Floating Items Maximum item count threshold
Profiler > Location + Item Matrix > Allow Floating
Items Minimum item count threshold
Profiler > Location + Item Matrix > Accept Floating
Items Maximum item count threshold
Circulation
Virtua Client - Item Information > Circulation Rules
- Floats check box
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Potential advantages for using floating collections for your library:

e Supplement inventory of smaller locations with items owned by more robust
locations.

¢ Reach new patrons with materials they would not have seen if they only visit
one location.

e Decrease delivery cost and time materials spend in transit.

e Allows for increased circulation of materials.

e Decrease in staff time spent handling materials.

Floating collections are directed by the actions of the patron. Materials can stay at
the locations to which they are returned, instead of being placed in transit status
and returned to the owning location. The Owning location for the floating item
remains constant, but the Shelving Location reflects the change in location.

For an item to float 3 conditions must be met:

e The item’s float flag must be enabled in the Item Information window.

e The current shelving location must be designated as allowing collections to
float and its minimum thresholds must not be exceeded.

e The check-in location must be designated as accepting floating collections
and its thresholds must not be surpassed.

In the Profiler > Global Settings > Locations there are two parameters that
must be enabled to allow and accept floating collections. Enabling the Allow
Floating Items Minimum item count threshold will permit items shelved at this
location to float to other locations. When the threshold is set to 0 (default setting)
there is no limit to the number of items belonging to this location that will be
allowed to float. By entering a minimum number of items to keep at this location,
the items belonging to this location will only float when the specified minimum
number of items are shelved at this location.

The Accept Floating Items Maximum item threshold parameter enables a
location to accept floating items from other locations. When the Maximum is set to
999,999,999 (default setting) the location will accept an unlimited number of
floating items. When a floating item is checked in at an accepting location the
system will check to determine if the location has met its maximum threshold of
excepted items. If an item cannot float at the check-in location, Virtua attempts to
send the floating item to a location that has a ‘Max floating item count threshold’
value of less than 999,999,999 and that is furthest from reaching the number of
floating items specified in the threshold value. If a location is found, the item will be
placed at in-transit status and sent to the qualifying location. If no such location
can be found, the item will not float and will be returned to its shelf location.
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General Inherited Values |ASR |

[~ Unfitered Location
[~ Process Denied Loans

Default tem Class

Default Status
Default Copy Number

Default PAC Code

Default Loan Period (in days) IEI

[ TEM CLASS 0000: (28 114 day) > |

[~ Use ltem Record Loan Period

INune

|u

INnne

—Reserve Settings
Default Reserve ftem Class

Default Reserve Location
Default Reserve Start Date
Default Reserve End Date

Reserve Pull Period Days

|r-mn Library Owned (.C. 980) |

| AGRICULTURE & APPLED ART: + |

—Check-in Settings:

Check-in Flag 3M INnt Allowed 'l
Check-in Status INune 'l

v Use Check-in Date

| anzzo12

|12:00:00 AM

Check-in Locations

Brenham Campus Library
Bryan Campus Library
Customer Support Library
Guestiportal

Schulenburg Campus Library
Sealy Campus

| em2012

=l

| 83012

-~

|u

Amnesty Flag IFines will be assessel 'l

—[~ Create Received tems

tem Status INone vl

[ |v Allow Floating fems
Min item count threshold

¥ Accept Floating tems
Max item count threshold

|u

|

|9999999:99

Receipt Header

Cancel

Also in the Profiler > Circulation > Location + Item matrix will contain the

177

same two parameters found in the Location configuration to allow control of which
Item Classes are allowed to float and can be accepted. If library does not wish for

specific item classes to float to other locations this is where the library would

disable the floating collection feature.
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b

r(1C.1) (L day) . (e

Lﬁ Customer Support Library + Regular (I.C.
- - —

Calendar | Default

Must Pickup At Shelving Location |Yes
tems Circulating Less Than One |Yes
Day Are Due At Closing

tems Circulating One Day Or More |Yes

Are Due At Closing

Lef Led Lo Lo

Replacement Cost

At Biling Price (tem Elements tab)

L

Default tem Price | §.35
Fines Accrue During Mon-Operating Hours |N|:| ﬂ
Prep Time For Materials ||;| | Hours j
Held Pickup Time |14 |H|:|urs j
Inspection Time For Materials ||;| |H|:|urs j
Default Booking Time For Materials |E| |H|:|urs j
Minimum Booking Time For Materialz |EI |H|:|urs ﬂ

[ Allow Renewal Within Days of Due Date.

Min fleating item count threshold |'3I
Max floating tem count threshold |999999999 i
Apply To | Save Cancel

Last modified at 8122012 2:22:18 PM by Root User

Additional control over specific items can be established in the Virtua Client in the
Item Information window on the Item Elements tab by checking or unchecking
the Floats checkbox in the Circulation Rules section. This may be used if the library
has multiple items of a specific material and would like to allow some of the items
attached to float, but not every item, therefore ensuring that at some items are

always sent back to the owning location.
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Item Elements |Notes | statistics | Status | Acquisitions |

rBibliographic Information
Author: Green, Jen.

Title: Vincent wan Gogh / Jen Green ; [traduccidn:

Edition: Primera edicion en lengua espariola

Miguel Iribarren Berrade].

rItem Information
Item ID:

Barcode:

Barcode Type:

Item Class:
Reserves Item Class:
Ttem URL:

Location:

Shelving Location:

Mumber of Pieces:

Price:

EPM MNumber:

Accession Mumber:

Collection Code:

AV Accession Mumber:

186870
100020257 1]

IRegular ﬂ

IRegular (I.C. 1) (1 day)

=
=
ICustomer Support Library LI
=

ICustomer Suppart Library

1 % [~ Circulate Pieces

| £.00

| =

Call Mumber

Copy: |1

Call #: I?59.9492 Ga23v 2004

2nd Call #: I

Units

™ Free Text

= Enumeration and Chronology
¥ Maone

[ Edit |

1~ Preservation and Conservation

Code: I LI

T Mon-Parameterized Shelf Location

Location: I ﬂ

rCirculation Rules
¢ Lse Matrix
" Use Loan Period: ElE

[v Allow Request IF Floats I
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Circulation Backup

Recommended
Workflow

Explanation

Edit Circback.ini
File

Configure Client

A 4

Record
Transactions

Backup Data

Currently, the Virtua Circulation Backup Client can perform
the following transactions.

Check-ins

Check-outs

Renewals

Accept Payment

Reads a file of blocked patrons

To set up Circulation Backup you will need the following
information

Location code for main locations; these can be found in
the Profiler, Global tab.

Operator ID numbers for any staff recording
transactions in Circulation Backup.

Identifying Operator IDs

1.

Login to Virtua using your user name and
password.

. Do a circulation transaction (check-in, checkout,

renew, etc.) noting the patron or item number in
the transaction.

. Select Circulation > Transaction Log from the

Virtua main menu.

. Enter either the patron or item number to search

the Transaction Log

. Highlight the transaction you just performed; on

the right hand side of the window is information
pertinent to the selected transaction.

. Note the Operator ID number; this is the system

assigned ID number associated with your user
name and password.

. Repeat for all staff using the Circulation Backup

system.
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Edit the circback.ini file

Before using Circulation Backup, the circback.ini file will need to be edited for
each circulation workstation. To change this file you will need to know the location
codes that have been set in the Profiler:

Open the Circback.ini file in a text-editing program such as Notepad or WordPad.
This file should be located under:

C:/Program Files/VTLS/Virtua/circback.ini

The following template will appear.

& Circback.ini - Notepad

Filz. Edt Seach Help

pIMAIN] =

station=1

[LOCATIONS]
100688=Main Library
20000=South Branch
30000=North Branch
7000808=Special Collections

[FINES]
17=0verdue
28=Photocopy
25=Reserves

[PATRONS ]
FC=Faculty
ST=Student

[CURRENCY]
1=USD
2=SFr

|

Edit the station number, giving each Circulation workstation a unique number.

Warning: Failure to assign unique numbers to each workstation will result in
data loss.

Edit the Locations to conform to the settings in the Profiler. Use main location
codes only. You cannot set up sub-locations in Circulation Backup.

TIP: Edit the circback.ini file on one workstation and then copy it to the other
workstations, remembering to change the station number.
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Login to Circulation Backup

Locate Circulation Backup in the Virtua directory and double click or right
mouse click and select open to run the program.

C:/Program Files/VTLS/Virtua/circback.exe

The Login window will appear:

FW Login for Station: 1

Login Information

Uzername: |

Location: |E|FEI'I|1E|IT| Campuz Library ﬂ

Cancel |

Select a location from the Location dropdown menu.
Enter your operator ID.

If a circulation transaction file already exists on your machine (any time after the
first use), you will receive the following message:

‘\c}) Transaction file already exists. Clear the file?

If you answer yes the transaction file will be cleared and all transactions lost.
Only answer yes if you have transferred this file to the server.
If you answer no, the new transactions will be appended to the transaction file.
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The Circulation Backup window will appear:

W Virtua Circulation Backup

BEX]

File Transactions Help

eoBE B

Mumber | Transaction

Date/Time

Location Username | Data

0 Log-in

ANTIEZMZ 1032

Brenham Campusg Libr... | oconnelit

10:32

1/17f2012

Configure the Client

To set the configuration of the Circulation Backup Client, on the Circulation

Backup menu bar, click File > Configuration.

W Virtua Circulation Backup

BEx]

File Transactions Help

LogIn... El _|
SUMMary. .. Iﬁl
DatelTime Location Username | Data
Print Log File TH7/2012 10-32- | Brenham Campus Libr. | oconnelt
Printer Setup...
Configuration...
Exit

Configure backup system

10:35

1/17/2012

The Configuration window will appear:
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W Configuration E]
System Settings
Station ID: i
[ Check-out Sekect Time: | = pate: =
Waork Directory: |C:‘.Prugram Files\WTLSWirtua 2011.2.12%
QK | Cancel |

Note: The unique station ID configured for the Circulation Backup Client and
specified in the circback.ini file can be alphanumeric and of variable length.

If desired, type a new station number in the Station Number field.

Warning: Do NOT assign two PCs the same station number. Doing so could result
in a loss of transaction data.

If you want to save the transaction file to a different directory, type a new path
in the Work Directory field.

If you want to set a default time to appear in the Selected Time field of the
Check-out or Check-in window, check the Checkout Select Time checkbox and
enter a new time and date.

Click the OK button to save your changes and close the window.

Record Transactions

Checking In Items

To check in an item, click the Check-In ﬂ icon or select Transactions >
Check-In from the Circulation Backup main menu, or press the CTRL+I
key. The Check-in Patron Access dialog box appears.

W7 Check In
Info
Usemame: oconnelt
Location: Brenham Campus Library
[~ Use Selected Time: | | Date: | J

If desired, select the Use Selected Time check box and manually select a check-in
time and date.

Wand in the item barcode or type the barcode and press the enter key. The
transaction displays in the Circulation Backup window.
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Backup

I ¥irtua Circulation

185

=10 X

Fils  Trareactione  Halp
[ Checkin g
Inta
Location: Main Library | Data |
DOperator: 23

[ﬂem: 0000344956, Tim...

[ Use Selected Time: | 9:10:05 AM == pate: | 6/ 7/00

tem: 000034563; Time...
ftem: 000023955

B

o

ftem Number:

111 R 6/6/01

To close the Check-In window, click the Xl button in the upper right-hand corner

of the Check-In window.

To print a receipt for the transaction, select a transaction on the Circulation
Backup window list box. Currently you cannot multiple select transactions for

printing.

Click the Print @ icon on the toolbar.

Checking Out Items

To check out an item, click the Check-out @ icon, or select Transactions >

Check-out from the Circulation

Backup main menu, or press the CTRL+O

key. The Checkout Patron Access dialog box appears.

-~

¥ Patron Access - Check-out

A[x]

Patron Barcode:

Cancel |

Enter the patron’s barcode or type the barcode and hit enter or OK. The

Checkout window appears.
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W

@ B @

| 7 Check Out - vits214 e | Data

Check-out Type |

{* Regular

" In-house

(" Selected Time: | = Date:| [

Total: 0

10:41 1/17/2012

Select the Checkout Type you want to use for this transaction.

Note: The default Selected Time is the time and date you chose on the
Configuration Window.

Wand in the item barcode, or type the barcode and the Check-out button or
press the Enter key. The transaction displays on the Circulation Backup
window.

To close the Check-Out window, click the Xl button in the upper right-hand
corner of the window.

To print a receipt for the transaction, select a transaction on the Circulation
Backup window list box. Currently you cannot multiple select transactions for
printing.

Click the Print icon on the toolbar.

Renew Items

To renew an item, click the Renew icon, select Transactions > Renew
from the Circulation Backup main menu, or press the CTRL+R key. The
Renew Patron Access dialog box appears.
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-~

¥ Patron Access - Renewal

Patron Barcode:

038 Cancel

Enter the patron’s barcode. The Renew window appears.

7 Renew - vils214 Bx|

—Renewal Type

* Regular

= In-house

" Selected Time: | = Date: =l

Total: o

ltem Barcode: I Rengw. I

[~ | Batch renesyal

Select the renew type Regular. Type or wand in the item barcode. The
transaction displays in the Circulation Backup window.

+ Vrtua Ciuculation Backup i J ..lDl x]
File  Trangactipns Help
7| [E @‘
MNumber | Transaction | bateMme_— ] Location | Operator | bata I
10 Renew |B/501 13:16:17 |Main Library |23 |Patron: 3425; tem: 000069...
. il
a Renew R Hénen—d42y fd B3 |
7 Checkout  -Renew Type L 000076 ...
& Checkout o bm: 000045 ...
5 Checkout & Regular bm: 000395
4 Login Saie
3 Checkin i iots 56, Time: B/...
2 Checkin & "Sﬂéﬁed Time: I 910:05 AM ﬁ Dﬁl‘le.l SMEN0 vl [3; Time: 6577,
1 Checkin 5
a Login
Total: 1
ttem Mumber:: |pooos4g675] Trmoi
I= (Eatetirenewal
I = 6/6/01

To print a receipt for the transaction, select a transaction on the Circulation
Backup window list box.

Click the Print icon on the toolbar.
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To print a single receipt for multiple transactions on the Circulation Backup
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window the selected transactions must be the same type (Check-out, Check-in,
etc.) in order to enable the Print Receipt menu option.

W Virtua Circulation Backup

=%

File Transactions H

Log In...

SUMMEry...
Print Receipt
Print Log File

Printer Setup...
Configuration...

Exit

Print receipt

elp

B S

DateiTime Location Username | Data
472572014 12.02.... | Headquarters staff tem: 31731049119975
4/25/2014 12:02.. .. |Headquarters etaff tem: 31781049115933
4/25/2014 12:02:. . |Headquarters staff

12:03 4252014

Accept a Payment

To accept a payment for a fee, click the Payment icon, or select

Transactions > Payment from the Circulation Backup main menu, or press
the CTRL+A key. The Account Payment window appears.

W Account Payment
Payment Info
Patron Barcode:
Payment Amount: 0.00
| Close ‘

Enter in the patron’s barcode.

Enter the amount to credit to the patron’s account.

Click the Pay button. The transaction displays on the Circulation Backup

window.

The currency format displayed in the Payment Amount field is determined by your

regional settings in Windows. Selecting a currency in the currency pull-down list

box does NOT change the currency in which the payment is recorded. All payments
are processed by the Virtua server in your home currency.
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W
€ | H =)
Number | Transaction | Date/Time | Location | Username | Data
1 Payment 1M TI2012 10:45:... | Brenham Campus Libr... oconnelt Patron: wtlz214; Amount: 5
0 Log-in 1M TI2012 10:32:...|Brenham Campus Libr... | oconnelt
W

Payment Info

Patron Barcode: |'\.-1I5214

Payment Amount: 5.00

Pay Cloze ‘

10:47 1/17/2012

To print a receipt for the transaction, select a transaction on the Circulation
Backup window list box.

Click the Print icon on the toolbar.

Backup Data

The Circ backup file should be copied each day and saved into another directory
with the date in the filename. This safeguards the data in case someone answers,
“yes” to the overwrite question. If the staff consistently answer “*no” to the
overwrite question, this means that ALL transactions from one PC are stored in the
same transaction file; making data loading easier.

Circulation transactions are saved in the Virtua directory. The file name follows the
convention of: Trans[station number].dat

For example: Transl.dat
Note: The station number is defined in the CIRCBACK.ini file

Create Backups of Your Transaction Files
Within the Virtua directory, create a folder called Circ Backups
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(I =T
J Fil= Edit Wi Fawaorites Tools Help ﬁ
| —Back + = - | @y search GyFolders c#History | BS 0E X< wa | EH-
J Address Ia Wirkua _I' o an
= . e = Marme  # | Size | Type [~
'-D L —a Catalog Wi > File Folder 1,
[ [CIoBETables File Folder 1,
Virtua 0 e A Arranges Icons > File Folder 1,
[Eacesslabe  Line Up Leons E6 KB Microsoft Access Ap... 4,
Select an item to view its description. S CIRCEAC  Refresh 17 KE  Application 4,
= CIRCEAC 1KE Confi ki Sekti =
See also: D Customize This Folder. .. onfiguration Settings 1
1 Documents 8] distributic 1KE UTF File 3
My Documents
My Metwork Places @ EngCogpr FPaste SKE UTF File o,
My Metwork Places
My Cornputer a engcogpr FPaste shorbcuk & KB UTF File &,
DTy tomputsr "
[#]engmonp  Unda Delste Chri+z 6KE UTF File &,

Q Eengserpr Properties
a enaserprinkpo, kb

E erb.rec

labinput . Ext

oclc.rec

r% patkerns.bxk

8] pew.rec

] pevaran.rac

@ printvoucher, utf

8] receipt. tF

A

Creates a new, empty Folder.

(2] enamary [ new dor
e . =
[=] enaprintc I B Foider

= Shortcut

£S5 EBricfrase

H EBitrmap Irnage

B Microsoft ‘Waord Dacument

ﬁ Microsoft OFfice Binder

@ Microsoft PowerPoint Presentation
SideAiCT! Document

Text Docurnent

@ W' Sve Sound

@ Microsoft Excel Worksheet

LI winzip File

Create a copy of the transaction file in the Circ Backup Directory by clicking on
the transaction file, then select Edit > Copy.

il
J File | Edit View Fawvorites Tools  Help ﬁ
J ¢upe  UndoDelete Chrl+2 L Folders @History | ES Eg Mo | -

Chrl+3 j G0
Ckrl4+1C
amne | Size | Type | M[ﬁ
Paste Sharkcut 1 acesslabelsexample mdb 156 KB Microsoft Access Ap...  4f
& CIRCBACK. EXE 617KE  Application 4
Virt Copy ToFolder... CIRCBACK.IND 1KE Configuration Settings 2/
Morve To Folder.... ] distributionprint  utF 1KE UTFFile 3f
Trans  sgject 4l Chl+d ] engcogprintcancelpo.utf SKE UTF File &
DATF Irwert Selection 5 engeogprintpo, ukf 6kKE UTF File &f
Modified: 21262003 1137 BM # | engrnonprintcancelpo. ukf 6 KB UTF File &f
@ engmonprintpo, utf 6KE UTF File 6f
Size: 262 bytes =] engprintclaim.utf SKB UTFFile &
Attributes: (normal) @ engserprintcancelpo,utf 6KE UTF File &/
@ engserprinkpo, ukf 6KE UTF File &f
] erbrec 14KE REC File &}
labinput. Ext 1KE Text Document 4f
acle.rec 14KB REC File &
[% patterns. txt SKE TextDocument 5/
=8| pow, rec 3 KE REC File 6
| prwren.rec 9KE REC File 6
=] printvaucher. utf LKE UTFFile 1
=] receipt.utf 1KE UTFFile 3f
a sampleenglishthankyou. byl 1KE TYLFile & |
'Esearch.pdl’ 87KE Adobe Acrobat Doc...  5f
[S]1rans1.0a7 | LKE DAT File 2
Evirtua.exe 4,61ZKE  Application 12w
< i
Copies the selected items to the Clipboard. Ta put theri in the new lacation, use the Paste command. i

Navigate to the Circ Backup directory and select Edit > Paste. The file will

appear in the Circ Backup directory. This file

will be loaded to the server in the

UNIX environment. UNIX does not allow spaces in file names. Rename the file
to reflect workstation and the date of the backup.

For example: Trans1_01_15_03.
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J File Edit Wiew Favorites Tools Help
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= Back v = - | @Search L4 Folders @History ||:|5f 0O % w3 | Ed-

|
J Address I[:l Circ Backups

H

Circ B’ackups

—

Transl.DAT
DAT File

Modified: 2yZ6/2003 1:37 PM
Size! Z62Z bytes

Atkribukes: (mormal)

=10l x|
| @
| Size | Tvpe | Modified
8 ‘(KB DAT Fil= 2126/2003 1:37 PM
Open With...
3 winZip 3
Send To >
Cuk
Copy
Create Shorkeut
Delete

Rename

Properties

After Circ back-up files are loaded to the server, error messages generated once
the system is back on line are automatically sent to circulation staff.

Process Transactions

The Circ Backup > Process Transactions option on the Circulation menu in the
Virtua client has the options “Login Location” and “All Locations.” These options
allow you to specify whether Virtua should process circulation backup transactions
from the current login location only or transactions from all locations.

-

W Virtua - Headquarters - phoenix

BE]

Patron

Circ Desk
Transactions
Reserves

27 @

Default connec

Agency Requests
Circ Backup

File Search Circulation Acquisitions

k

T v vy v wr

Window

PO B MBE N

Cataloging Options Tools

Current connection: phoenix - staff

= 9 E &

Help

Launch Circ Backup Client
Upload Transactions |

Process Transactions + Login Location
View Warnings All Locations
View Failed Transactions [

A warning message appears when you attempt to process circulation backup
transactions to reflect the fact that ALL transactions for ALL locations will be

processed.
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= =

Warning

": Reminder: To minimize failed transactions, upload droulation backup data from all workstations at your location before processing.

Are you sure you want to process transactions for this location?

Cancel |
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Appendix A: Key Terms

Active Reserve Item: A reserve item entered into the system on a date that falls
between the Begin Date and End Date of the reserve period. An Active Reserve
Item remains on the Active tab of the Reserve Items window until you explicitly
deactivate it.

Alert: a message displayed to the user during a transaction that indicates that an
“alert” condition exists for the patron. Alert messages usually must be
acknowledged or answered before staff can continue the transaction. Example of an
“alert” condition: The patron has an excessive number of overdue items.
Alternate Conversion Factor: configures an alternate set of currency conversion
factors to calculate the replacement cost of lost and long overdue items.

Archived Reserve Item: A reserve item that meets the following criterion: its'
BeginDate and EndDate is before or equal to today’s date.

Audio Signals: Two distinct sounds that can be set to occur during circulation
transactions to alert staff to a successful/unsuccessful transaction.

Audit Trail: A tracking by the system of a sequence of financial events in
Acquisitions and Circulation. Any transaction dealing with patron accounts, fund
allocations, fund expenditures, fund transfers or the exchange of money is logged
as a unique audit trail transaction.

Barcode Label: A printed label containing machine-readable data that is read by
an optical scanning device and transmitted to a computer. In libraries, barcodes are
used to identify books for circulation and inventory and to link a borrower’s library
card to the appropriate patron record in the library's computerized circulation
system.

Barcode Number: A unique number up to 50 characters in length that
corresponds to a barcode label (see above) and is assigned to an item record, a
patron record, or a vendor record. The number is used to access the records or to
identify the records in transactions involving the patron or item.

Begin Date: The date the item goes on reserves, i.e., becomes “active.” Active
reserve items use the item class defined in the reserve record and use reserve rules
in processing circulation transactions for this item.

Bib-ID (Bibliographic Identification Number): A system assigned, unique identifier
for a bibliographic record. Bib-ids can be used to place requests.

Bib-Level Request (Bibliographic Level Request): any qualifying item attached
to the requested bibliographic record will satisfy the request.

Bibliographic Record: A type of record that contains data for cataloging in the
MARC bibliographic format. Bibliographic formats contain the following descriptive
elements: title and statement of responsibility (author, editor etc.), edition,
material type, publisher/distributor, publication date, physical characteristics,
series, notes, standard number (ISBN, ISSN, etc.), and terms of availability,
including price.

Circulation Workflow-Based Reference Guide Last Revised: October 2017
*Updated to 16.1



194

Block: A message displayed to the user that indicates a “block” condition—for
example having an excessive humber of billed items-exists for the patron. This
condition blocks the staff from continuing the transaction for the patron. In a future
release, authorized staff will be able to override the block.

Booked: Status assigned to a booked item in the View Bibliographic Record.
Bookings for Item: window that opens to schedule a booking’s Prep Time, Start
Time, Inspect Time, Duration, and Bookings Pickup Location.

Bookings Pickup Location: location where booking will be picked up.

Check-in: Records the return of a checked-out item to the library or in the case of
an in-house checkout, the return of the item to the Circulation Desk.

Checkout: Records the loan of a book or an item to a library borrower, or patron.
Sometimes called a Charge.

Circ-on-the-fly: retrieves a workform in the MARC Editor for creating a brief
bibliographic record to circulate an item on the spot even though it is not currently
in the database. Often used to create reserve items that are not owned by the
library.

Circulation Matrix: The circulation rules defined in the Virtua Profiler for different
combinations of location, item class, and patron type. The rules include loan
periods, fines, and notices.

Circulation Notes: Notes attached to the item record that can pop-up on check-in
or check-out.

Closed Stacks: Any shelving area in a library that is restricted from public access.
Retrieval of materials is usually by special request. In Virtua these are often
designated as Paging locations.

Control Search Number Types: A patron’s birth certificate number or passport
number.

Course ID: A character string used to identify an academic course (e.g. HISTORY
101). The combination of Course ID and Section Number uniquely identify a course
in the Reserves module.

Course Section: The combination of Course Id and Section Number that uniquely
identify a course in the Reserves module.

Current Active: Refers to an item in the Reserves module where today’s date falls
between the item’s Begin Date and End Date.

Current Inactive: Refers to an item in the Reserves module where the item’s
Begin Date occurs after today’s date.

Damaged Processing: System assigned status of an item that has been marked
damaged.

Database Action: A setting for record loading that allows the user to dictate what
will happen when the record is saved to the database, for example, overwrite an
existing record, merge with an existing record, put any duplicate records in error
state.

Delete Fees: fee is removed from the balance due and from the accounts window,
and subsequently the transaction can only be traced through the Audit trail.
Denied Loan Request: The Denied tab lists those requests made by your patrons
that could not be satisfied by any library. After a request makes one complete
circuit of a defined group of libraries without being satisfied, the request is reported
to the requesting library as a denied loan request.
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Dispute Fee/Item: A check-out or fine that has been contested by a patron but
no decision has been made to charge/not charge the patron for the item. Disputed
fines/items do not count towards alerts and blocks, and fines do not accrue for
disputed items. A disputed fine appears on the Patron Account tab; a disputed
item appears on the Patron Activity tab.

Due Date: The date of the last day of the borrowing, or circulation, period for a
checked-out item. Fines are charged for items returned after the due date unless
the item has been renewed.

Duplicate Tests: The ability to determine whether a record being loaded into the
database is a duplicate of a record that already exists in the system based on
identical information in specified tags.

End Date: The date an item comes off reserves, i.e., becomes “inactive.” At this
point, the software will use the item’s normal item class and regular circulation
rules in processing circulation transactions for this item.

Fee/Fine Category: Virtua includes a set humber of default fee and fine
categories, but your library can define additional in the Profiler. The default fee and
fine categories are: Overdue, Late Renewal, Item Price Fee, Damaged Item, Recall,
Processing Charge, and Dispute.

Fines: Amounts assigned by the library to a patron account for a variety of
delinquencies such as not returning a borrowed item, returning a borrowed item
after the due date, losing an item, or damaging an item.

Fixed Due Date: A location-specific due date for all check-outs made during a set
date range, or period. Generally, this setting is used by academic libraries that
allow faculty or graduate students extended loan periods.

Grace: An amnesty flag setting in the Circulation parameters. If grace is ON, no
overdue fines are assessed to users when the item is checked-in or renewed. The
parameter is location specific.

Grace Period: A Circulation parameter that specifies a period of time following the
expiration of the normal loan period during which no fines are assessed for overdue
materials. Libraries can define the grace period in the Circulation parameters
(location + user + item matrix) of the Virtua Profiler.

Guaranteed Circulation Period: A Circulation parameter that specifies the
number of days that a patron is "guaranteed" an item before it can be recalled. If
the patron has an extended loan period on the item, this parameter specifies the
earliest possible due date (when calculated with the Mail Grace parameter) for the
recall.

Holds: a request placed on a checked-out item or title where no action is taken
until an item is checked in.

In Transit: A temporary status given to an item that is checked-in at a location
other than its shelving location, or that is a satisfied loan or page request where the
requesting library is a different location.

In Transit Requested: System assigned status to an item that is In Transit to fill
a request at another location.

Indicator: Two character positions follow each tag (with the exception of Fields
001 through 009). One or both of these character positions may be used for
indicators, which further define the field. In some fields, only the first or second
position is used; in some fields, both are used; and in some fields, like the 020 and
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300 fields, neither is used. When an indicator is undefined, the character position is
represented by the character #, which stands for “blank space”.

Instructor Number: used in the Reserves module in circulation. It is the Patron
Barcode of the instructor who has items on Reserve.

Item: A unique physical or virtual piece or entity, e.g., a book, volume of a journal,
a roll of microfilm, etc. that is part of a library’s collection.

Item Booking: allows a patron to sign up for an item during a specific time
period. Once an item has been booked, the item cannot be checked out to another
patron if the loan period conflicts with the scheduled booking date/time.

Item Elements tab: Tab on the Item Information window that displays the basic
descriptive information for the item: Item Information, Call Number Information,
and Circulation Rules

Item ID: unique control number assigned by the system to an item record when
the record enters the system. The item ID is stored in the 001 tag. (Not to be
confused with Item Barcode)

Item Level Request: only the item bearing the specified barcode will satisfy the
request.

Item Barcode: unique alphanumeric assigned to the physical item by the library.
The barcode is not required, but an item cannot circulate without a barcode. The
barcode number can be entered manually in the system or scanned using a barcode
reader

Item Record: database record in 2709 MARC Communications format that
describes a physical or virtual piece. The description includes copy and volume,
item class, barcode number, location, circulation rules, circulation statistics, and
status.

List Overview: displays all upcoming bookings for an item.

Loans: placed on an available item at a location other than the log-in location.
Log-in Mode: Data gathered by the Circulation Transaction Log on logins made at
Internet, OPAC, SelfCheck, and Other locations.

Lost Processing: System assigned status of an item that has been marked lost.
Mail Grace Period: A Circulation parameter that specifies the number of days
needed for the delivery of a recall letter. This is used in conjunction with the
Guaranteed Circulation Period to determine a recall due date (see also Guaranteed
Circulation Period).

Main Location: A main location is represented by the first five digits of a library
location code. The associated sublocation code for a main location is always 0000.
Circulation rules are set by main locations, and request groups are formed with
main locations. Main locations usually reflect a building or an organizational unit.
MARC-like format: a 2709 MARC Communications format (defined by VTLS rather
than USMARC). Virtua supports 3 records types that use MARC-like formats:
Patron, item, and vendor.
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MARC Record: a record structured according to the MARC standard. Such a record
contains a Leader, a Directory, tags, indicators, fixed fields, and variable fields (see
also MARC). There are 4 MARC record types: bibliographic, holdings, authority, and
Community information.

MARC Tags: A three-digit, zero left padded tag number in a MARC Record. Some
tags also include two one-digit indicators. The data for a MARC tag is stored in a
field, which may be subdivided into "subfields."

Material Booking: see Item Booking

Notes (Circulation): Notes added from the Item Information window that can
trigger checkout and check-in alerts for circulation staff.

On hold: An item has the status of On Hold when there is a hold or recall request
against the item at check-in or when a loan or page request against the item
originated at the same location, and has been satisfied.

Other Document Number: Patron keyword search type that pulls information
from the 029 tag subfield $a.

Other Name: Patron keyword search type that pulls information from the 111 tag
subfield $a.

Overdue: One of the “reports” produced by the Virtua Reports Client that is sent to
a borrower, or patron, requesting the speedy return of an item, which has been
kept past its due date.

Page: request placed on an available item at a location or sub-location designated
as a paging location, usually closed stacks, storage facilities, or document delivery.
Paging Location: A location from which library users may request materials via a
page. Paging locations are designated in the Global Settings of the Profiler.
Parameters: A choice or setting that the library makes using the VSC that affects
how the software operates either for a specific subsystem or system-wide.
Example: The Circulation subsystem uses the value set in the Library Hours
parameter to calculate hourly loans and fines.

Patron barcode: A unique alphanumeric assigned to a user by the library. 1t is
stored in the 015 tag of the patron record and is the primary key to the patron
record. The barcode can be entered manually in the system or scanned using a
barcode reader.

Patron ID: A unique number sequentially assigned by the system to each patron
record as it enters the database. This number is stored in the 001 tag of the patron
record.

Patron-Initiated, Self-Renewals: Filter found in the Circulation Transaction Log
to search for results of self-renewals.

Patron Keyword Search Types: Search types by a keyword for a patron record.
Patron Limits: Number of items a patron may have checked out at any given time.
The number of check-outs allowed is defined by patron type and item class.
Patron Type: A category of user defined by the library for the purpose of assigning
specific circulation rules. Examples: faculty, graduate student, undergraduate.
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Permissions: Using the Virtua Profiler, the library can set up user permissions, or
profiles, which are then downloaded from the server to the Virtua Client during
initialization at startup. By way of a user name and log-in password, the server
informs the Virtua client of the permissions your library has granted to a specific
user. Based on this information the Virtua client allows or disallows specific actions
or access to specific functions. For example, a guest user would not see the Edit
button on the View Record window if it had been disallowed.

Previous Due Date: Data gather by the Circulation Transaction Log.

Processing Fee: A fee assessed to a patron’s account when an item checked out
to the patron is billed for replacement. The processing fee is generally determined
by the cost in staff time and paperwork in handling the bill and replacing or
withdrawing the item. It is part of the replacement bill.

Reading Program Nominator Code: Patron keyword search type that pulls
information from the 303 tag subfield $b.

Recalls: placed on a checked-out item, which may result in a shortened due date
and a letter to the item’s borrower.

Receipt: A printed confirmation given to the patron-for a check-in, check-out
(including due date), or renewal.

Record States: functionality in Virtua that allows libraries to assign flags or
“states” to records to facilitate the viewing, storing, and editing of the records. The
software supports record states for authority, bibliographic, and patron records.
Record states may be used to review work by novice catalogers, hold records for
overnight processing, or hold records in error state until cataloging problems are
fixed.

Renew: An extension of the due date for a book or other item.

Request: An online request for library material. The request may be defined by
type and level. Currently, Virtua supports hold, loan, recall, and page request
types. Also refers to the system-generated record that records a request by a
patron.

Request Group: Main locations grouped for the purposes of placing and trapping
requests. When used, only items within the location group will qualify for the
request. Libraries can establish these groups in the Circulation System parameters
in the VSC.

Request Level: Determines which records might qualify for the request, based on
the relationship of records in the database. Depending on the request, relevant
levels are bibliographic, holdings, and item.

Request Queue: The display of Hold/Recall/Loan/Page requests for a particular
Bib-ID or Item-ID listed in the order in which they will be satisfied.

Request Type: The request type determines which records might qualify for the
request based on the status and/or location of the materials. Current request types
are Hold, Loan, Recall, and Page.

Request Wizard: A series of interactive dialog boxes for adding both item-level
and bibliographic-level requests to the request queue

Reserves: Also known as course reserves. The body of material that is available for
short-term loan for a specified length of time, usually in a restricted area of an
academic library.
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Reserve Header: The information that appears in the top portion of the View
Reserves window. It consists of the Course Number, Course Section, Course Title
and Instructor Name.

Reserve Item: An item that is on reserves for a particular course. You create a
reserve item from the View Reserves window by entering the item number, item
class, reserve period, and reserve location.

Reserve List: The list of reserve items that are displayed in the View Reserves
window for a given course/instructor.

Resolve Fee/Item: A disputed fee or item can be resolved in one of two ways. It
may be reinstated or waived. It may not be deleted. To delete a fee, waive it first
and then delete the transaction.

Satisfied Loan Request: A request for an item that another library has agreed to
loan.

Scheduled Reserve Item: A reserve item entered into the system on a date that
falls between the item’s Pull Date as calculated from library-defined parameters and
the Begin Date of the reserve period. A Scheduled Reserve Item remains on the
Scheduled tab of the Reserve Items window until you explicitly activate it.
Shelving Location: The current physical location of an item. The shelving location
determines circulation properties for the item; that is to say, it is the location used
in the Circulation matrices. The shelving location is also used in location filtering in
the OPAC.

Section Number: A character string used to distinguish the different sections of an
academic course (e.g. 1a). The combination of Course ID and Section Number
uniquely identify a course in the Reserves module.

Session: Functionality that allows for multiple patrons to renew or pay fines in one
transaction.

Statistics: The Statistics tab on the Item Information window displays statistical
data about the item in read-only format. The tab is visible in both view and edit
mode. The software creates, modifies, and maintains all the data that appears here.
Status: A library-defined code and definition that may be applied to an item record.
The code is used to describe a physical condition or location. Libraries can define
these statuses in the Circulation parameters of the Virtua Profiler. Examples: On
Order, In Process, Missing, Billed for Replacement, At Bindery, Needs Repair. If the
item has acquired a special or system-defined circulation status, such as, lost,
damaged, missing, etc. the Status tab will appear on the Item Information window
in view mode; otherwise, it is visible only in edit mode.

Transaction Log: A transaction history of a particular item or patron. It records all
circulation transactions such as check-outs/renewals, requests, ILLs, and disputes.
Trapped: The condition of a requested item or title when it is checked in at the
location where the requester is to pick it up. The system uses the checked-in
item/title to satisfy the pending request and so “traps” it for the requester.

Unit Request: (WWW implementation only) - request within a paging location. For
holdings, a request specifying which issue is needed. If a page request for a
monograph is started at the bib level it will become a unit level request.
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Views: Values set in the Views parameter in the Virtua Profiler are used to
configure the OPAC window displays and the iPortal window displays. The MARC
View Editor provides the point-and-click interface that lets you set and edit these
values in View records. Virtua View records are designed to address three issues
in regard to Virtua client/iPortal window displays: 1) Customized layouts, 2)
Library-defined labels, and 3) Format of data in a MARC bibliographic or an item
record. For example, the View Record window offers one view of bibliographic
data on the Full tab, another on the MARC tab, and yet another on the Holdings
tab. Similarly, the data on the item record can appear in a variety of tabular
displays on the Items tab.

Virtua Client: the Virtua Windows-based graphical user interface that resides on
each PC and provides access to the Virtua subsystems.

Virtua Profiler: A Virtua client that allows libraries to configure the Virtua software
by setting parameters, views and permissions.

Waive Fee/fines: The fee/fine is removed from balance due so that the patron will
not be charged, but it is kept on waive tab so that circulation staff have quick
access to the transaction history.
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Appendix B: InfoStation Reports
for Circulation

Circulation Report Update | Description

Group

Availability Y List of requested items that are currently available.

Basic Circulation N Circulation Statistics by patron type and item type.

Statistics

Bills Y Lists patrons with and/or generates notices for billable
items.

Blocked Patrons N List of patrons that have a manual block in either the
043 tag or the 007 fixed fields of their patron record
and meet the patron information criteria that you set
for the report configuration.

Circulation by Call # | N Circulation statistics by user defined call number ranges

Range

Circulation Snapshot | N Summary of current circulation statistics

Collected Fines N A list of the fine and fee transactions that exist in the
database at the time you run the report

Delinquent Patron N List of fines and fees that are considered to be

Accounts “delinquent,” according to the information in the patron
account and criteria that you specify in the report
configuration.

E-mail Validation N Checks patron email addresses for valid (not correct)
email structure, e.g. the @ sign is part of the address.

Expired Bookings Y List of expired bookings that meet the location and
patron type criteria that you set in the report
configuration.

Expired Requests Y Lists Available Requests with expired Hold times and
Unavailable Requests with expired Expiration dates.

Excessive Requests N List of title with an “excessive number” of outstanding
patron requests.

Expiring Patrons N List of patrons who meet the specified patron
information criteria and whose patron records are due
to expire within the amount of time specified for the
report configuration.

Items by Status N List of items with the status set in the report
configuration parameters.

Journal Circulation N Circulation statistics for serial titles in the database.

Media Booking Pull N List of items that need to be prepared for scheduled

List
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Overdues

Patron Account
Statement
Patron Barcode List

Patron Lists

Patron Statistics
Recalls

Requested Bills
Requested Overdues
Reserves Activate
List

Reserves Current
Active List

Reserves Pull List

Reserves Remove
List

Review Notices
Shelving Pull List
Transition Disputed

Items

Unique Management

Unsatisfied Requests
Report
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Generate 1) a total count of patrons in the database
and 2) a count of selected patrons based on specified
criteria set in the report configuration parameters

List of overdue items meeting the criteria set in the
report configuration parameters.

Lists all transactions related to fine and fee
assessments for patrons

A list of patrons identified by barcodes that fall within a
barcode range specified in the report configuration

List of patrons meeting criteria set in report
configuration.

Circulation statistics based on patron type

List of items for which recall requests have been placed
List of billable items requested by other patrons

List of overdue items requested by other patrons

List of items that qualify for activation according to the
scheduled Active Period

List of items that are currently on active reserve.

List of item that need to be pulled form the shelves and
moved to reserves.

List of active reserve items that have expired and need
to be deleted or archived

Generate review notices for patrons whose borrowed
items are about to come due.

List of items that need to be removed from their
current shelving location and returned to their owning
location.

Allows you to change items that are at a status of
Disputed to a status of Overdue after a user-defined
number of days.

Generates information about delinquent patron
accounts and sends it to Unique Management Services,
Inc. The Unique Management report generates
information about changes to the account balances of
patrons who have a 27xx block.

Generates a list of unsatisfied requests
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Appendix C: Circulation in a
Consortium Environment

Circulation Parameters Defined at the Institution Level

In the consortium environment, institutions (with their associated locations and
sublocations) have the ability to define their own circulation policies. This is
accomplished by allowing most circulation parameters to be set at the institution
level. The following parameters affecting the Circulation subsystem are defined at
the institution level:

General Circulation Parameters

Circulation Basic Options: defines a number of options including: 3M Error
Message, Delete/Waive Options, Audit Trail, Automation e-mail availability notice,
Use long loans, Minimum circulation question, Allow renewal of requests, Update
request expiration date, Show total requests with request queue position, Each part
of a multi-part is unique circulation, Bookings take priority over satisfied requests,
Prohibit patrons from paying fines for items at a different location from the location
where the fine was assessed, and Global request trapping.

Locations

Location Names: defines library locations and sublocations, which represent the
physical and/or virtual locations of library materials.

Patrons

Patron Types: defines a unique code and description for each type of patron that a
library chooses to identify.

Patron Type Priority: provides a means of automatically selecting a patron type
from the patron record when the patron is from another institution within the
consortium. When your staff performs a circulation transaction for a patron that is
not registered at your institution, Virtua chooses one of the patron types defined in
the patron record based on the priority ordering that your institution defined in the
Profiler.

Block Code Definitions: defines codes that your institution uses to block patrons
from checking out items. These codes are inserted into the patron record.

Items

Item Class Definitions: defines unique identifiers for each type of item that a
library chooses to identify.
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Item Statuses: defines statuses that Virtua uses to prompt you or to block your
action at specific points of activity, such as when you are checking out an item or
placing a request.

Circulation Matrices

Alerts and Blocks Matrix: defines system-calculated alerts and blocks that trigger
system-calculated alerts and blocks when you initiate various circulation
transactions.

Check-out Limits Matrix Type: defines limits on the number of items that a
particular patron type can check out.

Location + Patron + Item Matrix: defines values for particular Location/Patron
Type/Item Class combinations, including: loan rules based on check-out type,
overdue fines for requested and non-requested items, grace periods for overdue
fines, schedules for sending overdue notices, schedules for sending bills for overdue
items, renewal limits, request limits.

Location + Patron Matrix: defines values for each location/patron type
combination in your library including: default date and time for fixed check-outs,
default expiration date for the patron record, values that determine the processing
fee, amount of the item price fee that remains at check-in and whether this fee is
used to calculated blocks.

Location + Item Matrix: defines values for location/item class combinations,
including: loan rules based on check-out type, overdue fines for requested and non-
requested items, grace periods for overdue fines, schedules for sending overdue
notices, schedules for sending bills for overdue items, and renewal limits.

Request Parameters in the Profiler

Request Groups represent the physical and/or virtual grouping of locations used for
processing requests. Different institutions may define different request groups and
the Request Group code and name must be unique. Requests placed in the
consortium environment are prioritized and routed according to parameters set in
the Profiler. The following parameters will affect requests placed in the Virtua client
and in the jPortal.

Request Groups: define the physical and/or virtual grouping of locations used for
processing requests.

Patron Type Values: works in conjunction with the Patron Type Priority parameter
to determine the placement of a patron in a request queue.

Request Location Routing: specifies whether requests are permitted at the
Institution level or the Global level

Location + Patron + Item Matrix, Request tab:

Circulation Parameters Defined at the Consortium Level

Fine Codes: defines codes for fines. All institutions within the consortium can see
and may use any fine code defined in the Profiler.
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Circulation Subsystem in the Virtua Client

Item Records in a Consortium Environment

Item records at locations or sublocations linked to the log-in institution will display
first the list of item records

When a user edits an item record, only those item classes, locations, and shelving
locations defined in the Virtua Profiler for the log-in institution will appear in the
pull-down lists on the Item Information window

A user may view an item belonging to another institution but they will not be able
to edit or delete the item record.

The barcode number of the item must be unique across the database.

Patron Records in a Consortium Environment

Patron Records are shared between institutions. Certain tags, however, contain
information allowing the records to be linked to a specific institution usually via an
institution code in subfield 5. All institutions of a consortium can modify ANY patron
field except tags, which have a \5 (which determines institution's ownership). The
following consortium information can be added to patron records:

Blocks: 007 tag

Patron Barcode: 015 tag.
Alternate Patron Barcode: 016 tag
Patron Type Code: 030 tag
System Control Number: 035 tag
Record Source: 040 tag

Dates: 042 tag

User-Defined Blocks: 043 tag
Patron Type: 245 tag

Patron's jurisdiction or home library: 247 tag
E-mail Address: 271 tag

Note field: 5xx tags

The barcode number and/or the alternate barcode number of the patron must be
unique across the database.

When migrating patron data, if the software detects duplicate patron barcodes (in
the 015 tags) or alternate patron barcodes (in the 016 tags), it will prefix the
barcodes with the institution's code in parentheses, creating a unique barcode.

Barcodes with the institution prefix will be displayed as a list in the iPortal and client
when a barcode with multiple institution prefixes is entered.
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Editing Patron Records

In the consortium environment, the ability to edit patron records will depend on two
factors:

The Allow global editing of patron data by non-owning institutions parameter set on
the Cataloging Basic Options window of the Profiler.

Whether or not a there is an institution code in subfield $5 of those tags that
support the institution code.

Allow global editing of patron data by non-owning institutions:

If the Allow global editing of patron data by non-owning institutions is set to OFF
only staff at the institution that owns a patron record will be able to edit:

Global information, such as name and address.
Information that is specific to that institution, such as the patron barcode.

If the Allow global editing of patron data by non-owning institutions is set to ON,
staff members across the consortium are able to edit:

Global information, such as name and address.
Information that is not specific to an institution (tags not containing an institution
code).

Tags that support the institution code:

Staff at any institution can edit institution-specific information in a patron record as
long as that information is specific to their institution as identified by their
institution code in subfield $5. Staff at other institution will not be able to edit these
tags.

Request Notification

Consortium users can customize notice templates for use by different institutions.
You can do this by creating one or more copies of the availabilityNotice.utf file
and naming the new notice templates according to the naming conventions
described in the Consortium User’s Guide.

Circulation Backup

Circulation backup error logs are generated at the institution level and sent to
designated staff via email.
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Appendix D: Hong Kong Public
Library Specific Information

Virtua Client and MASC Client Communications

The Virtua client communicates with the MASC client, making it possible for HKPL
patrons to use a MASC card as an alternate barcode for circulation transactions. A
patron’s MASC card may be used for circulation transactions when:

The MASC client is running.
AND

The patron has opted in for the use of MASC card as an alternate barcode
(indicated by the value of the 017 tag subfield $o in the patron record). When a
check-out or renewal trans-action is initiated, the Patron Access window appears.

To use the library card number (patron record 015 tag subfield $a), as the barcode,
select the Primary radio button.

OR

To use the HKID (patron record 017 tag subfield $a) from the patron’s MASC card
as the barcode, select the Alternate radio button. There will be a prompt to insert
the patron’s MASC card into the card reader.

W Patron Access - Custom...

Primary Barcode: |

{* Primary (" Alternate (" Both

QK Cancel |

Once the MASC card has been inserted, the HKID is validated:

The HKID (patron record 017 tag subfield $a) must exist in the Virtua database as a
valid patron identification number. There must be no Disabled Reason present in
the HKID field of the patron record (017 tag subfield $x). The opt in setting in the
patron record 017 tag subfield $o0 must indicate that the patron has opted in for the
use of MASC card as an alternate barcode. The date of issue (DOI) from the MASC
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card is checked against the Disabled Status Date (017$d) associated with the HKID
in the patron record to insure that the card is valid.

If the conditions described above are satisfied, Virtua proceeds with the circulation
trans-action. If one or more of the conditions is not satisfied, Virtua displays an
appropriate error message and the circulation transaction is not allowed.

HKPL Patron Editor

e Users are prevented from entering the same HKID for both patron’s HKID and
the guarantor’s HKID.

e The date format in which the patron’s birth date is displayed is the system-
defined date format for the workstation.

e When creating a new patron, if the user attempts to save the record without
entering a password, the Password field is automatically populated with the
last four digits of the patron’s home phone number. The PIN field is also
automatically populated with the same data, if left blank.

e The Library Card Number is now required in order for a patron record to be
saved successfully. (Library Card Number is no longer one of the document
type options in the Required Document Type(s) parameter.)

e The HKID status is now stored in the patron record 017 tag subfield $o (rather
than in the subfield $s, as in earlier versions of the software).

e The Note Content of previously created notes on the Notes tab cannot be
modified; only Note Type, Print Notices, and Display/Alert values can be
modified on previously created notes.

e Patrons created via the HK Patron Editor will have a patron date value added
to the 042 tag, subfield $e.

Item Barcode and Patron Barcode Validation

Item barcodes and patron barcodes are validated whenever an item record or
patron record is saved. Both item barcodes and patron barcodes must be 14 digits
in length, and must adhere to the additional validation requirements described in
the HKPL Item Barcode and Patron Barcode Validation. An error message will be
displayed if a user attempts to save an item record or a patron record with an
invalid barcode.
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Patron E-mail Address Validation

When a patron record is saved in the HKPL Patron Editor, the e-mail address
present in the E-mail Address field will be validated. An error message will be
displayed if the user attempts to save a record containing an invalid e-mail address.

W HKPL Patron Editor - venus88 E]
Mame: Cell Phone:
Address: Email: oconnelle@vtls.com
Home Fhane: Patron Type:
Alternate Phone: Birthdate:
Registering Library: Hong Kong Central (*1000000) Barcode:

PIM:

Mame ] Main Address | Secondary Address | Guarantor  Email/Phone lgates ] Identification/Password ] BAalr

Home Phone:

Alternate Phone:

Cell Phone:

E-mail Address:

|0c0nne||e @vts.com

Commurication Preference:

|Eﬂnaﬂ _:J
Paper

E-mail

Text

Text and E-mail

j

Get MASC Data Next ‘ Close ‘

Note: When a patron's Communication Preference is set to E-mail or Text and
E-mail, the E-mail Address field must be populated before the patron record can
be saved.
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HKID Validation

When a patron record is saved in the HKPL Patron Editor, the HKID present in the
HKID field on the Identification/Password tab will be validated. The guarantor’s
HKID, if one has been entered on the Guarantor tab, will also be validated. The
HKID will be validated according to the validation rules provided by HKPL. An error
message will be displayed if the user attempts to save a record containing an
invalid HKID.

W/ HKPL Patron Editor - venus88 M=
Narme: Cell Phone:
Address: Emait
Home Phone: Patron Type:
ARernate Phone: Eir thdate:
Registering Library: Haong Kong Central {*=1000000]) Barcode:
FIM:

Library Card Number | Disabled Reason | Disabled Date |
Add |
Deleta
HKID: Password:
Disabled Date:
b - 5] N
[~ OptIn =
Mot opted in |
Passport: [Birth Certificate: 1 Other ID:
| | |
Place of Issue: Place of Issue: Place of Issue:
| | |

Get MASC Data | eleke Next | Close
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Support for Additional HKID Opt-in Status Values

Virtua supports expanded opt-in values in the patron record 017 tag subfield $o.
The opt-in value represents the patron’s permission to use the HKID for circulation
and authentication. The following values are supported:

$o Label Description HKID valid for
value authentication?
1 Opted in as | Indicates that the patron Yes

new patron | opted in at the time
his/her patron

record was created. The
Patron Record Creation

Date = the
MASC Opt-in Date.
2 Opted in as | Indicates that an existing Yes
existing patron chose to opt in at a
patron later date.

The Patron Record
Creation Date is before the
MASC Opt-in Date.

3 Replaced Indicates a patron who Yes
registered but
subsequently lost his card,
and whose card has now
been replaced by a new
card. The Date of Issue

=> the
Disabled Date.

0 Not opted in | Indicates a patron who has | No
not opted in.

4 Discontinued | Indicates a patron who No

opted in at one time, but
has since opted out.

5 Lost Indicates a patron who No
opted in at one time, but
subsequently lost his card
and no valid MASC has
been replaced. The Date of
Issue < the Disabled Date.
6 Lost and Indicates a patron who No
discontinued | opted in at one time, but
subsequently lost his card
and decided to opt out
when he reported the card
as lost. The Date of Issue
=> the Disabled Date.
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In addition, the “status” field has been added to the Patron_Barcode_v Ad Hoc
view, allowing you to report on patrons’ opt-in status values.

Storing a History of Changes Made to Patron

Barcode/Library Card Number and HKID

Virtua stores a history of the changes made to the patron barcode (the patron
record 015 tag, known to HKPL users as the library card number) and the HKID
(patron record 017 tag).

When an HKID (017 tag) is created or modified, Virtua stores the following
information:

e HKID number (017 tag subfield $a)

e Disabled Status Date (017 tag subfield $d)

e Opt-in Status (017 tag subfield $0)

e Disabled Reason (017 tag subfield $x)

e Operator ID of the user who made the change (from the 039 tag subfield $a of
the patron record)

e Date/time stamp

When a patron barcode/library card number (015 tag) is added or modified, Virtua
stores the following information:

e Barcode/library card number (015 tag subfield $a)

e Disabled Status Date (015 tag subfield $d)

e Disabled Reason (015 tag subfield $x)

e Operator ID of the user who made the change (from the 039 tag subfield $a of
the patron record)

e Date/time stamp

The new Patron_Barcode_Status_Chnge_v [sic] Ad Hoc view allows reporting
on the stored history of changes to the barcode or the HKID.

Storing the Octopus Receipt Number in the Audit Trail

The Audit Trail stores the Octopus Receipt Number associated with an Octopus
payment.

In addition, the octopus_receipt_number field has been added to the
Patron_Audit_Trail_v Ad Hoc view.
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Ability to Display Chinese Name on Patron Search Results
Window

The Patron Search Results window displays the contents of the 111 tag subfield
$a of the patron record in the Other Name field.

¥, Patron Search Results - vBBp1960 Q@@
The following patrons may be duplicates of the new patron record you wish to save. Please review this information and
then click Save to save the new patron record anyway, or Cancel to abort.
Patron Name | Patron Other Mame ] Address Patron Barcode
Sun Yat Sen P Apt. Zero, §4620110831843
Save l Cancel

Other Elements Tab in Item Information Window

The Other Elements tab shows miscellaneous information about the item,
including binding status and withdrawal list information.

The Bibliographic Information area displays information such as the author and
title from the parent bibliographic record.

The Source textbox is a text-entry field that allows the user to enter a text
description of the original source of the item.

The Lamination area displays the Lamination Type drop- down list that allows
the user to select the lamination type that applies to the item.
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The Withdrawal area displays the Withdrawal Authority text-entry field that
allows the library to store data about items that will be withdrawn from the system
in the future, the Withdrawal Date (the Withdrawal Quarter will be displayed
using the format YYYY QQ), Withdrawal Type, and Withdrawal Location. The
Saved List Name is a read-only display of the name of the saved list (configured
via Chamo) that the item belongs to, if any.

W Item Information - phoenix g
Item Elements | Statistics | Status {Of
Bibliographic Information
Author: Smith, Andrew {Andrew Anselmo), 1959-
Title: Ghost medicine / Andrew Smith.
Edition: 1st ed.
Source: |
Lamination
Lamination Type: | J
Withdrawal
Authority:
Date: 2011 Q3
Type: Missing
Location: Bellefonte
Saved List Mame: Poetry
[~ Masked Delete Edit Refresh Close
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The Adjustment Notes right-click option available on the circulation Audit Trail
displays the entirety of any Adjustment Notes associated with the selected entry.

W Audit Trail - venus88

]f=1%]

Search Criteria  Results

Ttem Barcode: 2010082112

System Generated:

Transaction Reference Mum:

57501
No

Patron | Type | Fee | Date/Time | Amount | Balance Payment Method | Item Barcode Assessment ID
20100819 Modify - Item Price Fee HK$58.00 2/15/2011 11:57:33 ...  -HKS98.00 HKS0.00 2010082112 208
20100819 Assessment - [tem Price Fee HK$58.00 8/27/2010 12:14:14 ... HKS98.00 HK$598.00 2010082112 208
20100819 Modify - Processing Fee HK$100.00 2/15/2011 11:57:33 ...  HKS0.00 HK$100.00 2010082112 209
20100819 Assessment - Processing Fee HK$100.00 8/27/2010 12:14:14 ...  HK$100.00 HK$100.00 2010082112 209
20100819 Assessment - Overdue HK$130.00 2/15/2011 11:57:32 ...  HK$130.00 HK$130.00 2010082112 525
38838168741449 Modify - Item Price Fee HK$11.00 1/5/2012 12:55:52PM  -HKS1.00 HK£10.00 2010082112 2022
38838168741449 Assessment - [tem Price Fee HK$11.00 1/5/2012 12:44:52PM  HKS11.00 HKg11.00 2010082112 2022
38838168741449 Modify - Processing Fee HK$15.00 1/5/2012 12:55:52PM  -HK$10.00 HKS5.00 2010082112 2023
1168741449 A nt - Processing Fee 1/5/2012 12:44:52 _HKs15.00 2023
HEEEERETA144E Disputs - Bverdue £ 116013 110168 s, o Si34
38888168741449 Assessment - Overdue HK5130.00 1/5/2012 12:44:52PM  HK$130.00 HK5130.00 What's This? 2010082112 2024
Display Note
Patron Record
Patron Activity
Patron Account
Ttem Record
Print...
Save...
E-mail...
Save As C5V
<1 @
Operator: User, Staff
Location: Hong Kong Central (*1000000)

Account Adjustment Note: Fee waived due to illness,
Machine Mame: oconnelle, vtls.com
P =
Information

i J Fee waived due to illness.
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The Transaction Log stores information about the addition or deletion of a patron
note via the HKPL Patron Editor. Two new transaction types have been added:
Patron Note Added and Patron Note Deleted. For each transaction, the
following information is also logged: Username, Machine Name, Log-in Location,
and Note Content.

W Transaction Log - venus88

=%

Search Criteria  Results

Patron Barcode: 38388168741456

Machine Name:

oconnelle. vils.com

Date,Time Transaction Patron Barcode Location ‘ Item Barcode
11/18/2011 11:10:50 AM Regular Chedk-in 3858538168741456 Hong Kong Central (*1000000) 2390847309848
11/18/2011 11:10:08 AM Regular CkOut 33888168741456 Hong Kong Central {(*1000000) 2390847309548
11/18/2011 11:07:23 AM Regular CkOut 3858538168741456 Hong Kong Central (*1000000) 2011012501
11/18/2011 11:06:52 AM Regular CkOut 33888168741456 Hong Kong Central {(*1000000) 2010082311
11/18/2011 11:03:59 AM Patron note deleted 3858538168741456 Haong Kong Central (*1000000)

11/18/2011 11:02:18 AM Patron note added 33888168741456 Hong Kong Central (*1000000)

11872011 11:01:40 AM Patron note added 3B8E16E741458 Hong Kong Central (*1500000)

Username: User, Staff

Patron Class: Adult Patron

Transaction Location: Hong Kong Central (*1000000)

MNote Type: General

MNote: Loses card often

Modifying the Request Expiration Date

HKPL users can modify a request's expiration date if the request has a status of
Pickup, Pending, or In Transit. On the Activity tab of the Patron Information
window, Change Expire Date buttons appear on the Pickup subtab, the In Transit
subtab, and the Pending subtab.
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¥ Patron Information - Pandy, Andy

Card Formatl MARC Format  Activity Inccountl

Barcode

| Pasition i... | Req. Expiration Date
—= 120, Txpiration Date

| Reguest |TE1e

Total Items: 2
| Active Status

Loan

Summary  Pending |

Change Expire Date

Change Pickup Loc

From Vienna to Versailles,

Psychiatry [ editor, James H. Sadlly, Ir. Pending

Deactivate | Activate | Delete | Info |

[V Print Receipt

Update | Renew All | Refresh | Close |

Circulation Workflow-Based Reference Guide
*Updated to 16.1

Last Revised: October 2017



218

Appendix E - Changes in this
Guide

Changes for Version 16.1

No changes were made.

Changes for Version 16.0 SP2

“Modifying the Request Expiration Date” — Added this section to describe request
expiration date functionality for HKPL users.

“Open an Existing Item Record” — Updated to describe the new Location filter,
which allows you to filter the list of items shown on the Items tab of the View
Bibliographic Record window by location.

Changes for Version 15.2

“Satisfy or Deny Loan Request” — Updated to note that you can now process
multiple requests at once by multi-selecting lines on the Loans/Pages window and
then clicking the Deny or Satisfy button.
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